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About the Documentation

Purpose Both the User Guide and Online Help describe in non-technical language how software 
administrators, station engineers, and operators can install and operate the HView IP.

Revision History

Obtaining 
User 
Guides

The documentation for your product is included on the Installation CD as an Adobe Acrobat 
PDF file. The Layout Designer Online Help is an electronic document integrated into 
the software.

Product support documents can be viewed or downloaded from our website. Alternatively, 
contact your Customer Service representative to request a document. While working in the 
application, you can open the Online Help and print out individual topics.

Table P-1  Revision History

Edition Date Revision History

Edition A April 2011 Initial release
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Writing Conventions
This documentation adheres to the following writing conventions:

Table P-2  Conventions

Term or Convention Description

Bold Indicates dialog box, property sheet, field, 
button, check box, list box, combo box, 
menu, submenu, window, list, and selection 
names

Italics Indicates email addresses, names of books 
and publications, and first instances of new 
terms and specialized words that need 
emphasis

CAPS Indicates a specific key on the keyboard, 
such as ENTER, TAB, CTRL, ALT, DELETE

Code Indicates variables or command-line entries, 
such as a DOS entry or something you type 
into a field

> Indicates the direction of navigation through 
a hierarchy of menus and windows

hyperlink Indicates a jump to another location in the 
document or elsewhere

Internet address Indicates a jump to a Web site or URL

Indicates important information that helps 
to avoid or troubleshoot problems

[VersionNo.] Placeholder for a software version number
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Safety Guidelines

Safety Symbols On Product 
The following symbols may appear on the product.

DANGER—Indicates a hazard for high voltage, fire, or personal injury 
immediately accessible as one reads the marking.

WARNING—Indicates a personal injury hazard that is not immediately accessible as one 
reads the marking.

CAUTION—Indicates a hazard to property including the product or the need to take 
attention and refer to the manual.

FUSE—Replace with the same type and rating of fuse.

Observe precautions for handling electrostatic-sensitive devices.

Protective ground (earth) terminal. 

Safety Symbols In Manuals 
The following symbols are used in manuals and other documentation. 

CAUTION TEXT—Indicates important information that if not followed could cause system 
problems.

WARNING TEXT—Indicates information that if not followed could prevent system operation 
or cause it damage.

Electrical Safety Guidelines
Adhere to the following Electrical Safety Guidelines to avoid possible damages to the 
system or injury to yourself.

 Be aware of the locations of the power switches on the chassis and in the room, so you 
can disconnect the power supply if an accident occurs.

 Take extra precautionary measures when working with high voltage .. components. It is 
not recommended to work alone.

 Before removing or installing main system components, be sure to disconnect the 
power first. Turn off the system before you disconnect the power supply.

 Use only one hand when working with powered-on electrical equipment to avoid 
possible electrical shock.

 Use rubber mats specifically designed as electrical insulators when working with 
computer systems.
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Check the
Power Cables

To avoid electrical shock, check the power cables properly.

 Use the exact type of power cables as required.

 Be sure to use power cable(s) that came with safety certifications.

 The power cable(s) must be compliant with the AC voltage requirements in your region.

 The power cable plug cap must have an electrical current rating that is at least 125% of 
the electrical current rating of this product.

 The power cable plug cap that plugs into the AC receptacle on the power supply must 
be an IEC 320, sheet C13, type female connector.

 Be sure to disconnect the power supply before accessing the chassis or its components.

 Plug the power cable(s) into a socket that is properly grounded before turning on the 
power.

Electrostatic
Discharge

Guidelines

The following measures are generally sufficient to protect against Electrostratic Discharge 
(ESD). ESD can damage components in the product.

 Use a grounded wrist strap designed to prevent static discharge.

 Keep all components and printed circuit boards (PCBs) in their anti-static bags until 
ready for use.

 Touch a grounded metal object before removing the board from the anti-static bag. 

Preventing
Electrostatic

Discharge

To prevent ESD, observe these precautions when directed:

 Use a ground strap. Wear a grounded wrist strap to discharge the static voltage from 
your body while installing or removing sensitive components.

 Use a safe work area. Do not use any devices capable of generating or holding a static 
charge in the work area where you install or remove sensitive components. Avoid 
handling sensitive components in areas that have a floor or benchtop surface capable 
of generating a static charge.

 Handle components carefully. Do not slide sensitive components over any surface. Do 
not touch exposed connector pins. Handle sensitive components as little as possible.

 Transport and store carefully. Transport and store sensitive components in a 
static-protected bag or container.

Product Damage Precautions
The following are general precautions to prevent product damage.

 Do not use this apparatus near water.

 Clean only with a dry cloth.

 Do not block any ventilation openings.

 Do not block any of the ventilation openings. Install in accordance with the 
manufacturer’s instructions.

 To completely disconnect this equipment from the AC Mains, disconnect the power 
supply cable plug from the AC receptacle. 
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 This unit can have more than one power supply cable. To de-energize the internal 
circuitry, disconnect all power cables before servicing. 

Keep Product Away from Heat Sources
Do not install near any heat sources such as radiators, heat registers, stoves, or other 
apparatus (including amplifiers) that produce heat.

Protect the Power Cable
Protect the power cable from being walked on or pinched, particularly at plugs, 
convenience receptacles, and the point where they exit from the apparatus.

Only use attachments/accessories specified by the manufacturer.

Use with Proper Equipment

Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer or sold 
with the apparatus. When a cart is used, use caution when moving the cart/apparatus 
combination to avoid injury from tip-over.

Unplug During Storms and When Inactive
Unplug this apparatus during lightning storms or when unused for long periods of time.

Do Not Operate With Suspected Failures
Refer all servicing to qualified service personnel. Servicing is required when the apparatus 
has been damaged in any way, such as if the power-supply cable or plug is damaged, liquid 
has been spilled or objects have fallen into the apparatus, or the apparatus has been 
exposed to rain or moisture, does not operate normally, or has been dropped.

Use Proper Power Source
Do not operate this product from a power source that supplies more than the specified 
voltage.

Install Near Socket Outlet
The equipment shall be installed near the socket outlet, and a disconnect device shall be 
easily accessible.

Observe precautions for handling electrostatic-sensitive devices.

Fuse Replacement
For continued protection against the risk of fire, replace only with the same type of fuse.
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Battery Replacement and Disposal
Danger of explosion is the battery is incorrectly replaced. Replace only with the same or 
equivalent battery type recommended by the manufacturer. Dispose of batteries according 
to the manufacturer’s instructions.

Lithium, Lithium Ion, Nickel Metal Hydride, and Zinc Air Batteries—These batteries may be 
safely disposed of in normal household waste. Contact your local government for disposal 
or recycling practices in your area. 

Other Disposal Tips:

 Never dispose of batteries in fire as they could explode.

 Remove worn-out betteries from equipment immediately and dispose of promptly.

 Do not attempt to recharge a battery unless the battery is specifically marked 
recharcheable. Dispose of immediately. 

Injury Precautions
Adhere to the following warnings to avoid possible injury to yourself.

 To reduce the risk of fire or electric shock, do not expose this apparatus to rain or 
moisture.

 Potentially lethal voltages are present within this product’s frame during normal 
operation. The AC power cable must be disconnected from the frame before the top 
panel is removed. (In frames with multiple power supplies, remove ALL power cables.) 
Power should not be applied to the frame while the top is open, unless properly trained 
personnel are servicing the unit.

 To avoid fire hazard, use only the power cable specified for this product.

 Do not defeat the safety purpose of the polarized and grounding-type plugs. A 
polarized plug has two blades with one wider than the other. A grounding-type plug 
has two blades and a third grounding prong. The wide blade or the third prong are 
provided for your safety. When the provided plug does not fit into your outlet, consult 
an electrician for replacement of the obsolete outlet.

 To avoid electrical shock or fire hazard, do not operate this product with covers or 
panels removed.

 CLASS 1 LASER PRODUCT—To avoid damage from laser radiation, do not remove or 
displace any connections or protective panels. 

 To avoid injury or fire hazard, do not operate this product in an explosive atmosphere.

 To avoid injury, remove jewelry such as rings, watches, and other metallic objects. Do 
not touch exposed connections and components when power is present.

 IT power system shall be isolated from earth, except that one point may be connected 
to earth through an impedance or a voltage limiter. The parts of the equipment 
required to be earthed shall be connected to earth electrodes at the user's premises. 
Protective earthing shall be provided either directly to the equipment or into the main 
supply building installation.

 Pluggable equipment type B relies on protective devices in the building installation for 
protection. The building installation circuit breakers or fuses shall have a rating of AT 
LEAST 10A or greater for short-circuit or overcurrent protection or, where necessary, for 
both. The equipment mains fuse is slow blow type fuse rated 3.15A for 250V and 
marked T 3.15 H 250V.
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 Do not expose this equipment to dripping or splashing and ensure that no objects filled 
with liquids, such as vases, are placed on the equipment. 

Technical 
Support

Technial support is available 24 hours a day, 7 days a week. You can contact technical 
support by phone or e-mail.

Phone: 1-888-534-8246 (1-888-LEITCH6)

E-mail: LTIService@harris.com

Compliance and Certifications
Most Harris products have been tested and found to comply with the following standards:

 IEC

 FCC

 UL

 ICES

 CSA

EMC Standards

Table P-3  EMC Standards 

EMC STANDARD DESCRIPTION

EN55014 Limits and methods of measurement of radio disturbance characteristics of 
electric motor-operated and thermal appliances for household and similar 
purposes, electric tools and similar electric apparatus.

EN55022 Limits and methods of measurement of radio disturbance characteristics of 
information technology equipment, Class A.

EN55103-1 Electromagnetic compatibility—Product family standard for audio, video, 
audio-visual and entertainment lighting control apparatus for professional 
use, Part 1: Immunity, Environment E4. 

EN55103-2 Electromagnetic compatibility—Product family standard for audio, video, 
audio-visual and entertainment lighting control apparatus for professional 
use, Part 2: Emission, Environment E4.

EN61000-3-2 Limits for harmonic current emissions (equipment input current less than or 
equal to 16 A per phase).

EN61000-3-3 Limitations of voltage fluctuations and flicker in low voltage supply systems 
for equipment with rated current less than 16 A.

EN61000-4-2 Electrostatic discharge requirements “ESD” 2 kV CD, 4 kV AD.

EN61000-4-3 Radiated radio-frequency electromagnetic field immunity test 1V/m {1 kHz 
80% AM, 80-1000 MHz}.
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Per the provision of the Electromagnetic Compatibility Directive 89/336/EEC of 3 May 1989, 
as amended by 92/31EEC of 28 April 1992 and 93/68/EEC, Article 5 of 22 July 1993, these 
devices are for professional use only and comply with Part 15 of FCC rules. Operation is 
subject to the following two conditions:

 These devices may cause interference to radio and TV receivers in residential areas.

 These devices will accept any interference received, including interference that may 
cause undesired operations.

Changes or modifications not expressly approved by Harris Corporation, the party 
responsible for compliance to the FCC Part 15 Rule, could void the user’s authority to 
operate this equipment legally in the United States. 

These devices do not exceed the class A limits for radio noise emissions from digital 
apparatus as set out in the interference standard entitled “Digital apparatus”, ICES-003 of 
the Canadian Department of Communications.

Additional EMC Information
This device is for professional use in a controlled EMC environment, such as purpose-built 
broadcast studios.

EMC regulations require that the radiation emitted from this unit does not exceed certain 
limits. These limits are only met when the front panel is closed and the two thumb screws 
are secured.

Compliance to the EMC regulations is also dependent on the use of suitably shielded 
(screened) cables. Coax cables should be of the double-shielded (screened) variety. Unused 
BNCs should be fitted with 75terminations.

All audio cables should be screened with the shield (screen) making good contact with the 
metallic parts of the cable connectors. 

D-type connectors used with this unit should always have metallic shells with the shield 
(screen) of the cable mechanically bonded to the metal shell. It is further recommended that 
the D-type cable connectors be of the “dimple” variety. These connectors make a better 
contact and consequently improve EMC performance.

EN61000-4-4 Electrical Fast transient requirements “Burst”, 0.5 kV Sig. & Ctrl. Lines 0.5 
kV a.c. & d.c. Power line, 0.5 kV functional earth.

EN61000-4-5 Surge Immunity test 0.5 kV a.c. Power line.

EN61000-4-6 Immunity to conducted disturbances induced by radio frequency fields 1 V 
rms 0.15-80 MHz Sig. & Ctrl. Lines, 3 V rms 0.15-80 MHz d.c. Power line, 
1V rms 0.15-80 MHz a.c. Power line, 1V rms 0.15-80 MHz functional earth.

EN61000-4-11 Voltage dips, short interruptions and voltage variations-immunity tests.

Table P-3  EMC Standards (Continued)

EMC STANDARD DESCRIPTION
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Safety Standards

Restriction on Hazardous Substances (RoHS) Directive
Directive 2002/95/EC—commonly known as the European Union (EU) Restriction on 
Hazardous Substances (RoHS)—sets limits on the use of certain substances found in 
electrical and electronic equipment. The intent of this legislation is to reduce the amount of 
hazardous chemicals that may leach out of landfill sites or otherwise contaminate the 
environment during end-of-life recycling. The Directive takes effect on July 1, 2006, and it 
refers to the following hazardous substances:

 Lead (Pb)

 Mercury (Hg)

 Cadmium (Cd)

 Hexavalent Chromium (Cr-V1)

 Polybrominated Biphenyls (PBB)

 Polybrominated Diphenyl Ethers (PBDE)

In accordance with this EU Directive, all Harris Corporation products sold in the European 
Union will be fully RoHS-compliant and “lead-free.” (See the Harris Web site, 
www.harris.com, for more information on dates and deadlines for compliance.) Spare parts 
supplied for the repair and upgrade of equipment sold before July 1, 2006 are exempt from 
the legislation. 

Leitch equipment that complies with the EU directive will be marked with a RoHS-compliant 
symbol, as shown in Figure P-1. 

Figure P-1  RoHS Compliance Symbol

Table P-4  Safety Standards 

STANDARD DESCRIPTION

EN60950:2000 IEC 60950:2000, 3rd Edition, Safety of 
Information Technology Equipment.

EN 60825-1:1998 Safety of Laser Products - Part 1: Equipment 
Classification, Requirements and User's 
Guide.

UL 60950:2000 Safety of Information Technology Equipment.

CSA c22.2 No. 60950:2000 Safety of Information Technology Equipment.
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Waste from Electrical and Electronic Equipment (WEEE) Directive
The European Union (EU) Directive 2002/96/EC on Waste from Electrical and Electronic 
Equipment (WEEE) deals with the collection, treatment, recovery, and recycling of electrical 
and electronic waste products. The objective of the WEEE Directive is to assign the 
responsibility for the disposal of associated hazardous waste to either the producers or users 
of these products. Effective August 13, 2005, producers or users will be required to recycle 
electrical and electronic equipment at end of its useful life, and must not dispose of the 
equipment in landfills or by using other unapproved methods. (Some EU member states 
may have different deadlines.)

In accordance with this EU Directive, Harris Corporation and other companies selling electric 
or electronic devices in the EU will affix labels indicating that such products must properly 
recycled. (See the Harris Web site, www.harris.com, for more information on dates and 
deadlines for compliance.) Contact your local Harris sales representative for information on 
returning these products for recycling. Harris equipment that complies with the EU directive 
will be marked with a WEEE-compliant symbol, as shown in Figure P-2.

Figure P-2  WEEE Compliance Symbol WEEE Compliance Symbol
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1 Getting Started 

Product Description
The Harris HView IP multiviewer IP-based video network display and monitoring solution is 
designed to meet the needs of multichannel broadcasters and head ends. It functions in a 
networked environment where the feeds being monitored are primarily compressed video or 
audio. The HView IP supports multiple compression formats and resolutions, from MPEG-4 
(H.264) to MPEG-2 for sources with a range of resolutions. It features support for virtual 
network (VNC) control, allowing you to view and control PC-based devices; RSS display, 
which enables interaction with a broad range of network data providers; and multiformat IP 
stream decoding with built-in visual alarming. 

Layout 
Designer 
Features

Layout Designer software has two primary functions: to create and edit layouts for   HView 
IP, and to configure   HView IP hardware. Using Layout Designer, you can configure your 
multiviewer system settings, and add and configure on-screen input audio and video alarms 
and on-screen digital clocks. 

Figure 1-1 provides a simple illustration of how Layout Designer works with your HView IP 
multiviewer system. 

Figure 1-1  Layout Designer and HView IP Hardware

Layout  Designer for 
Multiviewer

HView IPEthernet switch
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When it is installed on a PC, Layout Designer communicates directly with your multiviewer 
system over Ethernet. Layout Designer is supported with Online Help.

Layouts created with Layout Designer can be recalled on the multiviewer hardware using 
CCS Navigator, NUCLEUS, or on-screen control. For more information, see your NUCLEUS 
or Navigator documentation, or On-Screen Controls on page 189. 

Multiviewer System Configuration and Monitoring
Use Layout Designer’s system configuration, control, and monitoring features to:

 Configure multiviewer hardware and calibrate output display devices 

 Set up three different output display modes:

 Redundant mode

 Independent mode

 Spanning mode

 Set up layouts 

 Configure title markers, V-Chip rating, closed captioning, AFD, WSS, aspect ratio 
markers, teletext data, and VITC, closed captioning, and teletext

 Configure and display input audio and video signal alarms, including audio under and 
over level alarms, and black and frozen video alarms

 Configure system processing rules that respond to specific hardware and alarm 
conditions and events

 Configure audio meters by setting the audio service in the IP source configuration 
database (HView IP)

 Assign inputs to layouts, Picture-in-Pictures (PiPs), and audio meters 

 Monitor input audio and video signals with user-defined alarm conditions 

 Configure processing rules for specific system events and conditions 

Layout
Creation and

Design

Use Layout Designer’s layout creation and design features to

 Create layouts from a blank layout or a preset layout template 

 Select from a variety of layout output resolutions and layout background colors

 Add layout objects, such as PiPs, borders, layout windows, labels, tally indicators, audio 
meters, and alarms to a layout using basic Windows skills 

 Resize and position PiPs and other layout objects with pixel accuracy using direct-entry 
window coordinates

 Create scrolling labels and scrolling regions

 Group layout objects into layout windows

 Create customized layout objects including PiPs, border styles, digital clocks, tally 
indicators, and audio meters

 Store custom layout objects in the Layout Designer object library

 Open and edit layouts/files that are stored on connected multiviewer systems

You can create custom layouts for the multiviewer, or you can edit existing layouts by 
modifying individual PiP layout settings to create custom display layouts. Once a layout is 
generated, you can use Layout Designer to upload (publish) it to your multiviewer, or save it 
to a local or network PC drive.
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Multiviewer Onscreen Controls 
Your Multiviewer hardware can be equipped with a keyboard and mouse. When these are 
hooked up to the hardware, you can control the PiPs and audio content without 
republishing a layout using Layout Designer. 

For instructions on using the Multiviewer onscreen application, see On-Screen Menus on 
page 189. 

Multiviewer Control Panel
If you exit the multiviewer, the Multiviewer Control Panel loads. This panel provides access 
to various hardware settings and alarm logs. 

For instructions on using the Multiviewer control panel, see Using the Multiviewer 
Control Panel on page 193. 
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2 HView IP Hardware 

Hardware Overview 
Your box contains the following items: 

 HView IP (a 1RU rack-mountable PC) 

 Single Display Port -> DVI adapter

 Rack mounts 

 Power cords (2)

 Windows/ Motherboard CDs 

 Harris Infrastructure and Networking Documentation DVD 

Required
Tools and

Equipment

The HView IP is ready to operate out of the box. For some specialized functions, you will 
need the following (user-supplied) equipment: 

 USB or PS/2 Keyboard (see Figure 2-3 for location of connectors) 

 USB or PS/2 mouse (see Figure 2-3 for location of connectors) 

 Network cables 

 Monitors and cables 

Rack 
Mounting 

The mounting rails provided with your HView IP fit a 19” rack between 26” and 33.5” deep. 
The following are installation requirements/recommendations: 

 Equipment—Mount the frame on an appropriate rack using the provided rack 
mounting and support equipment. 

 Power Source—Connect the power inlet to an adequate power source. Using a UPS is 
strongly recommended. Connect each of the two redundant power supply connections 
to a separate electrical circuit for added protection. 

 Adequate airflow—The HView IP requires adequate airflow around the chassis to 
provide sufficient cooling. All components draw air through the front and exhaust 
through the rear of the frame. The surfaces must be clear of obstructions to provide 
proper air circulation and cooling.

 External device connections—Video monitors and all connections to external devices 
should be available and in working order.
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 Cable clearance—Provide at least two inches of clearance in the rear of the rack for 
cabling. 

Insure that the rack is anchored to the floor so that it cannot tip over when the 
HView IP is extended out of the rack.

Refer to the HView IP Safety and Compliance Information in the preface for detailed safety 
and compliance information. Also refer to the installation instructions that came with your 
rack unit.

To rack mount the HView IP
The HView IP package includes two rack rail assemblies in the rack mounting kit. Each 
assembly consists of an inner fixed chassis rail that is pre-attached to the HView IP and an 
outer fixed rack rail that secures directly to the rack itself.

Figure 2-1  Rack Mounting 

1 Place the inner rack extensions on the side of the chassis, aligning the hooks of the chassis 
with the rail extension holes. 

Make sure the extension faces outward just like the pre-attached inner rail. 

2 Slide the extension toward the front of the chassis, and then secure the chassis with two 
screws. 

3 Repeat steps 1-2 for the other inner rail extension.Attach the short bracket to the outside of 
the long bracket. 

You must align the pins with the slides. Both bracket ends must face the same direction.

4 Adjust both the short and long brackets to the proper distance so that the rail fits snugly 
into the rack. 
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5 Secure the long bracket to the front side of the outer rail with two M5 screws and the short 
bracket to the rear side of the outer rail with three M5 screws. 

6 Repeat steps 4-6 for the other outer rail.

7 Line chassis rails with the front of the rack rails. 

8 Slide the chassis rails into the rack rails, keeping the pressure even on both sides. 

You may have to depress the locking tabs when inserting. When the server has been 
pushed completely into the rack, you should hear the locking tabs click into position.

9 (Optional) Insert and tighten the thumbscrews that hold the front of the server to the rack.

To Remove the HView IP From the Rack
1 Stand in front of the HView IP add pull it out as far as it will go.

2 On the left side, press down on the plastic retaining mechanism. 

3 On the right side, pull up on the plastic retaining mechanism. 

Front Panel 

Figure 2-2  HView IP Front Panel

The HView IP front panel features are described in Table 2-1:

USB 2.0 type A 
connectors 

UID Reset Power 
LEDs 

Table 2-1  HView IP Front Panel Features 

Connector Function 

USB connectors Two USB 2.0 type A connectors allow you to transfer data to and from 
the HView IP. 

UID (Unit Identifier) Not used. 
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Making Connections 

Figure 2-3  HView IP Back Panel Connections 

Reset Reboots the HView IP. 

Power Applies or removes power from the HView IP power supply, while 
leaving standby power supplied to the system. 
Note: you must unplug HView IP before servicing.

LEDs There are five LEDs in this area. From left to right, they indicate: 

 Universal Information LED: Not used. 

 NIC2: Flashes to indicate network activity on GLAN2.

 NIC1: Flashes to indicate network activity on GLAN1.

 HDD: Flashes to indicate SAS/SATA drive, SCSI drive, and/or 
DVDROM drive activity.

 Power: Lights to indicate that power is being supplied to the 
system's power supply units. 

Table 2-1  HView IP Front Panel Features (Continued)

Connector Function 

Dual-link 
DVI output

Display port 
1       2

ENET 1    ENET 2
(10/100/1000 Ethernet ports)

Power supply 
connector

P/S2 mouse
Keyboard

USB 2.0 type A 
connectors 

COM 1 VGA port

Not normally 
used

(green) 
2.1 speakers

Table 2-2  HView IP Back Panel Connections 

Connector Function 

Power Supply (2) HView IP has dual-redundant power supplies. Both power 
supplies must be plugged in and functioning or an alarm 
will sound. 

P/S2 mouse Connect a mouse for on-screen control of the HView IP

Keyboard Connect a keyboard for on-screen control of the HView IP

USB 2.0 type A connectors (2) Connect keyboard and mouse, data storage, or a 
serial-to-USB adapter to input data from an external 
protocol (i.e., tally or UMD) 
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Redundant Power Supplies
The HView IP comes with two redundant hot-swappable power supplies located on the 
back panel. Under normal operation both power supplies work in tandem spreading the 
load between them. In the event of a failure, the functional power supply provides all 
power needed by the HView IP. if a power supply fails or if only one power supply is 
connected, an alarm sounds.

Possible reasons for alarm: 

 The power source (strip) has failed.

 The power cord is unconnected. 

 The power supply module has failed. 

Identifying and Replacing a Failed Power Supply

1 Look at the LEDs located on the front panel and the power supply modules on the back of 
the HView IP. 

 An amber LED indicates that the power supply module is off and plugged in.

 A green LED indicates that the power supply module is powered on. 

Figure 2-4  Power Supply Modules 

COM 1 Use this if you will be receiving data from an external 
protocol (i.e., tally or UMD) 

VGA Port Normally only used for diagnostic purposes

10/100/1000 Ethernet ports 
(2)

 ENET 1, when looking at the rear of the HView IP, is 
the port on the left, and is the Streaming port; see 
Adding an IP Source on page 72 and Setting 
Default IP Source Properties on page 52

 ENET 2 (on the right) is generally used for Layout 
Designer and networking; see Configuring IP 
Addresses for your Network on page 13

Dual-link DVI input You can connect to two of the three video connections at 
a time

Display port 1/2

Line out 1 (green) Connector for 2 standard monitoring speakers for stereo 

Table 2-2  HView IP Back Panel Connections (Continued)

Connector Function 

Release tab

Status LED
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2 Ensure that both power cables are firmly inserted into the AC outlets in the rear of the 
HView IP. If seating the power supply cables turns off the alarm and the LED turns green on 
the module that was offline, the problem has been corrected. 

3 If the problem has not been corrected, push the release tab on the power supply to the left. 

4 While holding the release tab to the left, grasp the power supply handle and pull the power 
supply out of the frame. 

5 Slide the replacement power supply into the empty slot.

6 Press firmly so that it clicks in place. if the power supply cord is in place, the module’s status 
LED will illuminate. 

7 If the problem has not been corrected, contact Harris Customer Support for further 
assistance. 

Output Display Modes
You can operate the multiviewer in either Redundant, Independent, or Spanning mode. You 
can select the display mode for your output module using Layout Designer. See the 
Multiviewers Configuration chapter in your Layout Designer Software Application User 
Guide.

 Redundant mode - Displays the same layout on each output. By default, your output 
module is set to Redundant mode.

 Independent mode - Displays a different layout on each output. When using this 
mode, each output can be configured for different format, aspect ratio, and 
orientation.

 Spanning Mode - Displays (or spans) one layout across outputs. When using this 
mode, each output must be configured for the same format, aspect ratio, and 
orientation.

Connecting DVI Display Devices to the Multiviewer 
Depending on your output display device and the type of DVI output you are using, use the 
following DVI cabling guides:

 Standard DVI-I digital/analog cable  - Use this cable when outputting to a PC digital 
(DVI) and analog (VGA) video monitor. This cable has a 29-pin DVI/VGA combined 
receptacle connector.

 Standard DVI-D digital-only cable  - Use this cable when outputting digital (DVI) 
video signals only. This cable has a 19-pin DVI-D digital-only receptacle connector (no 
key slot on left side of connector)

 VGA cable with VGA-DVI adaptor, or DVI-A cable with DVI-VGA adaptor  - Use 
this cable when outputting analog (VGA) video signals only. This cable has a 17-pin 
connector that requires an appropriate adaptor and corresponding cable. 

Optional GPI/Trigger Hardware 
To use GPI triggers, you will need a JLCooper eBOX. The JLCooper eBOX provides access to 
up to 24 GPI inputs and outputs. When HView IP is attached to the same TCP/IP network 
using its own Ethernet connector, it can access the JLCooper eBOX. 
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The multiviewer communicates with eBOX through one of the HView IP’s Ethernet 
connections. To connect the eBOX to an HView IP, both the multiviewer and JLCooper 
eBOX must be on the same network and able to communicate with each other. See 
Configuring Multiviewers in a Local Area Network on page 28 for more information.

Extra serial ports available: 

 4x 9-Pin D Sub Serial Connectors 

 2x 25 Pin D Sub GPI Connectors 

The GPI In connector has 24 TTL/CMOS compatible inputs with internal pull-ups to +5 volts. 
The GPI Out connector has 24 TTL/CMOS compatible outputs. On both connectors, pin 1 is 
the ground reference and pins 2-25 are GPI signals 1-24. The eBOX also has an RJ-45 
Ethernet Connector for LAN, WAN or Internet Control. 

The eBOX must be set as a server only. The master/slave function allows UMD-tally data to 
go through the HView IP hardware without external wiring. 

To configure the eBOX

1 Set SW8 to the ON position, and then re-power to access the Configuration Web Server for 
the eBOX.

2 Set SW1, SW2, and SW3 to the DOWN position, and then re-power.

3 Using an external PC (on the same sub-network), launch a Web Browser and type the IP 
Address of the eBOX. 

Do not use Internet Explorer 7 or Firefox web browser to change the network 
settings on the eBOX. Internet Explorer 6 is the only authorized application for 
getting into the built-in Web Server to change the network settings.

The eBOX’s default IP address is 192.168.254.102. 

Figure 2-5  eBOX Web Interface

4 Make the necessary Network changes and set up Port # 23. 

5 Remove any Password, and then press the SUBMIT button.

6 Set SW1, SW2, SW3, and SW6 to the ON position, and set SW7 and SW8 to the OFF 
position. 
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Figure 2-6  eBOX Dip Switch Settings for Operation

7 Re-power the unit.

8 Ping to confirm the new Network setting.

For information about configuring your e-BOX, see your JLCooper eBOX documentation.

Starting HView IP
After connecting the hardware, monitor, etc., you are ready to start the HView IP. 

1 Press the power button on the right front of the HView IP chassis. 

As the PC operating system loads, a Log in dialog box opens. 

The default ID is Administrator. By default there is no password. 

2 Click Log In. 

The Multiviewer onscreen application loads. If it is the first time you have used your device, 
some configuration is required. 

Otherwise, HView IP loads the layout that was used last time it was closed. 

HView IP can be controlled using a connected mouse and keyboard. For information, see 
On-Screen Menus on page 189. 

You can also control the onscreen application from a PC on the same network that is 
running Layout Designer. See Remote Mouse Control on page 192. 

Exiting
HView IP

When the Multiviewer onscreen application is running, follow these steps to shut down the 
HView IP:

1 With the mouse, right-click on the desktop and select Exit Multiviewer, and then click Yes 
to confirm. 

The current layout closes, and the Multiviewer Control Panel opens, with most of the 
buttons disabled. 

2 Click Enable. 

The rest of the buttons on the Multiviewer Control Panel become available. 

3 Click Shutdown System, and then click OK to confirm. 
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Configuring IP Addresses for your Network 
The default IP addresses for your HView IP are 192.168.100.250 (ENET 1, normally used for 
video streaming) and 192.168.100.251 (ENET 2, normally used for Layout Designer 
configuration and optional network control). Before your HView IP is ready to connect to 
these networks, you must change these IP addresses to suit your network requirements. 

1 On the HView IP, if the multiviewer application is running, right click and select Exit 
Multiviewer from the menu that appears. 

2 From the Start menu, choose Control Panel > Network Connections > ENET 1 > 
Properties > TCP/IP > Properties, and enter an IP address, Subnet Mask, and Gateway 
suitable for receiving streaming data on your network. 

3 Click OK twice to save your changes and return to the Network Connections dialog box. 

4 Select ENET 2 > Properties > TCP/IP > Properties, and enter an IP address, Subnet Mask, 
and Gateway suitable for controlling a device on your network. 

5 Click OK twice to save your changes, and then close the Network Connections dialog 
box.

6 Restart the HView IP for your changes to take effect. 

Each multiviewer on the network must have an unique IP address. 

You can also use CCS Navigator to change the HView IP Ethernet 1 IP address. For more 
information, see Discovering HView IP Using Navigator on page 17.

Initial Configuration for HView IP Multiviewers
To connect your Layout Designer PC to your new HView IP, follow these steps: 

1 Start Layout Designer.

2 From the application menu, select Edit > Multiviewer Configuration.

3 In the Device Manager dialog box that opens, click Add Device. 

A new device appears in the Device list.

Figure 2-7  Entering the Multiviewer’s Default IP Address

4 Under Device Name, you can enter a new name for the HView IP.

5 Under IP Address, type 192.168.100.250, which is the default IP address of the ENET 1 
connection. 

6 Under Display, enter the display number onto which your layouts will be published. 

7 In most configurations, the Display value should be set to 1. It can be set to 1 or 2 for Dual 
DVI. 

8 To connect the HView IP to Layout Designer, click the Test button.

 If the connection is valid, the  icon is displayed under Connected. 
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 If the connection is invalid, the  icon is displayed under Connected.

If your connection is reported as invalid, check the default IP address you entered, the IP 
address of your PC, and your Ethernet connections, and then click Test to test the 
connection again. 

9 After you establish a valid connection, click Save to save the list and connection 
information. 

Adding New
Devices

After you have assigned your HView IP a unique IP address, you can use Layout Designer’s 
Discovery tool to add the HView IPs to the device list. Be aware that when you use the 
Discovery tool, Layout Designer scans the network and reports all devices with an IP 
address. The amount of time required for discovery depends on the number of devices you 
have on your network. Layout Designer may discover devices that you do not want to add 
to the devices list. 

To discover an HView IP device

1 On the Device Manager dialog box, under Device Discovery, click Discover Devices. 

2 When the discovery is complete, do either of the following:

 To add specific devices, select the devices that you want, and then click Add to My 
Devices. 

 To add all of the discovered devices, click Add All to My Devices.

The selected devices are now in the Devices list. 

3 When you finish discovering and adding devices to the Devices list, click Save. 

You can now configure your multiviewer’s outputs. See Configuring Display Mode on 
page 63 for more information. 

Controlling the Multiviewer Through SNMP
If you configure HView IP as an SNMP agent, it can send SNMP traps to an SNMP manager. 
The SNMP manager can walk the device and control and monitor parametric controls to 
change layouts, alarm settings, PiP properties, etc. 

Configuring a Harris Multiviewer as an SNMP Agent
You configure your multiviewer as an SNMP agent from Control Panel > Administrative 
Tools > Services (Local). 

1 Right-click on the display and select Exit Multiviewer to close the Multiviewer application. 

1 On the Multiviewer Control Panel window, click Command Prompt. 

2 Type the following: 

services.msc

The computer management Services dialog box opens. 
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Figure 2-8  Services Dialog Box 

3 Under Services, right-click on the SNMP Service and select Properties. 

4 On the Traps tab, type a community name (usually Public). 

5 Click Add to List. 

6 Click Add, and then type the IP address of the SNMP Manager unit in the Traps 
Destination field. 

7 Click Add, and then click Apply. 

8 Click OK. 

In the Computer Management Services window, the Status field should display SNMP 
Service Started. 

9 Click Start Multiviewer to restart the Multiviewer application. 

10 Click Launch Multiviewer. 

Configuring Third-Party SNMP Software Control
To set up your multiviewer with optional SNMP to communicate with SNMP MIB browsing 
software, follow these steps: 

1 Make the required network connections between the HView IP and your PC with installed 
SNMP browser/control software. 

2 Ensure that HView IP is configured to send traps to the computer that contains your MIB 
browsing software. 

3 For information on configuring SNMP on the HView IP, see Configuring a Harris 
Multiviewer as an SNMP Agent on page 14. 

4 Load the Leitch mibs (downloadable from our website) into your SNMP browser/control 
software: 

 leitch.mib

This MIB sets up the basic structure for product specific MIBs. It can be found under the 
Private > Enterprise branch in your MIB browsing software, and sets up the 
leitchProducts and leitchCommon sub-branches. 

The leitchCommon branch is initially empty. The leitchProducts branch contains three 
initially empty sub-folders: LeitchX75, NEO and fam6800plus.
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 ccsAlarm.mib

This MIB adds a ccsAlarms sub-branch to the leitchCommon folder. When it is 
installed, you will be able to determine what specific module or frame has triggered an 
alarm (trap). 

These general MIB files set up a structure to help define parameters (as SNMP objects, and 
alarms as SNMP traps. 

5 Load the Multiviewer MIBs (downloadable from our website) into your SNMP browser/
control software: 

 IPMULTIVIEWERSYSTEM.mib

Loads the parameters and alarms listed in Multiviewer Display Parameters and 
Alarms on page 19. 

 IPMULTIVIEWERMODULE.mib

Loads the parameters and alarms listed in Module Parameters and Alarms on 
page 23. 

 IPPIP.mib

Loads the parameters and alarms listed in PiP Parameters and Alarms on page 20. 

The Multiviewer MIBs will appear in the MULTIVIEWER folder under the LeitchProject 
folder.

Figure 2-9  Multiviewer MIBs Loaded into NUDesign MIB Browser

6 Configure your MIB browser to connect to the HView IP by entering the IP address, Port (if 
you have changed the Port from its default in the configuration), and other standard 
configuration settings. 

7 Your browser should now connect to the SNMP agent running on the HView IP. 

8 To receive traps, start up the trap receiver in your MIB browser software. 

To verify that your configuration is correct, browse to Private > Enterprises > Leitch on 
the MIB tree, and then right click on the Leitch heading and choose Walk. 

You will see all the parameters and alarms for the device. 
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To facilitate monitoring more than one multiviewer, MIBs index devices by IP address. These 
settings will be available in your SNMP manager. See your SNMP manager’s documentation 
for details of how to customize its configuration. 

Remote Controlling and Monitoring HView IP Using CCS 
HView IP is fully compatible with CCS network control systems such as CCS Navigator and 
NUCLEUS Network Control Panel. With an optional license key upgrade, you can control 
and monitor the multiviewer using third-party SNMP software. You can remotely perform 
the following operations:

 Select and change layouts for display

 Select and change PiP input sources 

 Select audio channels for monitoring on the Hview IP audio monitor output

 Monitor the multiviewer as well as audio and video signal alarms 

 Set audio and video alarm threshold values

 Change the HView IP’s IP Address and Subnet Mask

For detailed information about using NUCLEUS to control and monitor your multiviewer, see 
your NUCLEUS Multiviewer Control Option Configuration and Operation Manual. For 
information on controlling the multiviewer using SNMP software, see Controlling the 
Multiviewer Through SNMP on page 14. 

You can use CCS Navigator and the NUCLEUS Network Control Panel to set CCS 
controllable parameters on your HView IP. CCS parameters allow you to select layouts, 
modify some layout attributes, and monitor feedback from multiviewers. Using CCS 
Navigator, you can also monitor various hardware alarms and the integrity of audio and 
video input signals.

Each PiP has its own set of parameters and alarms. Before you can access these parameters 
and alarms, you must discover the HView IP using CCS Navigator. 

Discovering HView IP Using Navigator
You can use CCS Navigator in Build mode to discover HView IP devices connected to a CCS 
network. The Multiviewer must be running (layout loaded, etc.) in order to discover the 
device. 

Follow these steps: 

1 Make sure Navigator is in Build mode by selecting File > Operational Mode > Build. 

2 If the Discovery Window is not open, click Tools > Discovery in the main menu. 

The Discovery Window appears, most likely in the bottom left corner of the screen. 

3 Click Options, and then click Add.

4 Enter the IP address of the HView IP. 

You must know the IP address of the HView IP to discover it. Navigator cannot discover 
HView IP devices using a MAC address. 

5 Click OK to close the Add Host dialog box, and then OK again to close the Discovery 
Options dialog box. 
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6 Click Start. 

Navigator runs a discovery. 

7 When your discovery is complete, Discovery Completed is displayed in the Discovery 
Window. 

8 Click Save. 

The contents of your discovery populate the Discovery folder of the Navigation Window. 

You can now switch to Control mode by selecting File > Operational Mode > Control 
from the main menu. Depending on which parameter set or alarm group you want to view, 
double-click on the appropriate icon in the Navigation Window to display the system or 
PiP controls.

Parameters
and Alarms

Use CCS Navigator in Control mode or NUCLEUS network control panel to access CCS 
controllable parameters and alarms. You must discover the HView IP before you can access 
CCS parameters and alarms (see Discovering HView IP Using Navigator on page 17).

HView IP alarms function like other CCS device Smart Alarms. For information about how 
CCS Alarms work, see your CCS Navigator documentation. Additional audio and video 
alarms can be viewed on display layouts and with Layout Designer software. See your 
Layout Designer User Guide for more information about configuring and viewing on-screen 
audio and video alarms.

HView IP parameters and alarms are divided into the following Navigator Control Window 
tabs.

Figure 2-10  Multiviewer Devices That Launch Control Windows

Parameter
Table Notes

The parameters are listed in the order that they appear in CCS Navigator.

When viewing the control parameter tables, observe the following:

 Shaded table rows indicate read-only (feedback) parameters. Some Read-only 
parameters can be modified using Layout Designer.

Each PiP has a separate control window. 
The number of PiPs varies depending on 
the layout. The contents are described in 
PiP Parameters and Alarms on 
page 20.

Parameters for the HView IP hardware 
appear in Module Parameters and 
Alarms on page 23. 

Parameters for the multiviewer display as 
a whole appear in Multiviewer 
Display Parameters and Alarms on 
page 19.



HView IP
User Guide

19

Copyright ©2011, Harris Corporation

 Bold parameter options indicate the default settings for the parameter. 

Multiviewer Display Parameters and Alarms
If your multiviewer has been configured for Independent or Spanning mode using Layout 
Designer, two system icons appear in the Discovery folder. Each system has its own set of 
parameters alarms. To access the system parameters and alarms, in the Network view, click 
the multiviewer’s system icon, and select either the Parameters or Alarms tab. 

See the Multiviewers Configuration chapter in your Layout Designer Software Application 
User Guide for information on configuring for Independent mode.

Table 2-3 lists the system parameters, and Table 2-4 on page 20 lists system alarms. 

.

Table 2-3  Multiviewer System Parameters 

Parameter Name Function Options

Parameters

System Name Displays the name assigned to the HView IP in 
Layout Designer 

<string> 

Active Layout Name Drop-down lists all the layouts on the HView IP. 
Choose one to display a different layout on the 
hardware. 

<string> 

Number Displays Indicates how many layouts 

Initial Counter Time Determines the start time of any counters 00.00.00.00

Lock Display Disables on-screen controls  Enable 

 Disable 

Vertical Sync time 
(ms)

Rendering diagnostic parameter

Parameters > Virtual GPI

Virtual GPI (1 - 16) Enables or disables the specified GPI.  Enable 

 Disable 

Parameters > Event Control 

Global Event Name Global events are created in Layout Designer, and 
are like salvos. Choose one from the drop-down 
menu. 

<string>

Enable Event Enables or disables the event selected by the Global 
Event Name parameter

 Enable 

 Disable 

Enable All Events Enables or disables all events  Enable 

 Disable 
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PiP
Parameters
and Alarms

You can access PiP parameters and alarms for each PiP that is associated with a currently 
active layout. 

To access the PiP parameters and alarms 

1 In the Network view, double-click or expand the PiP folder. 

Each PiP associated with the layout is listed in the Network view. If you switch to a different 
layout, different PiPs, and a different number of PiPs, may display. 

2 To access an individual PiP’s parameters, click the PiP icon, and in Control mode, click the 
Parameters tab. 

3 To view a consolidated list of PiP alarms, click the Alarms tab.

Table 2-5 lists the CCS parameters for each PiP.

.

Table 2-4  Multiviewer System Alarms

Alarm Name Description

Major Alarm Summary Active if any alarm condition is reported 
(priority > 7) for the system

Minor Alarm Summary Active if any alarm condition is reported 
(4 < priority < 7) for the system

System Communication 
Failure

Master module has lost connection to a slaved 
module

System LTC Failure Not supported

System GPIO Failure System lost connection to external GPIO device, 
if configured

Table 2-5  PiP Parameters 

Parameter Name Function Options

Parameters

Name Displays the PiP name String (always shows PiP) 

Static Displays the label text on the selected PiP String (displayed label text)

Display Identifies which output display device is currently 
displaying the selected PiP

String (display name)

Dynamic Displays the source ID for the UMD source String (UMD source ID)

Source Name Selects the input source name for the PiP Drop-down list with all sources 
listed 

Source Number Displays the source number for the selected PiP Slider (1 to maximum source 
number) 

Full Screen Enable Activates/deactivates full-screen view of the selected 
PiP

 Enable

 Disable 

Video Present Status Displays the presence of a video input signal on the 
PiP’s input source

(displays Absent or Present)

Video Standard Status Displays the detected video standard of the PiP’s 
input source

(displays input standard status)
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Aspect Ratio Displays the detected video aspect ratio of the PiP’s 
input source

(displays aspect ratio)

Parameters >Test and Measurement

Color Source Sets the default color display to From Video (color) 
or Monochrome (black and white)

 From Video 

 Monochrome 

Display Scope Determines what type of scope is displayed  None 

 Waveform 

 Waveform Parade 

 Line 

 Line Parade 

 Vector 

 Quad Display 

Video Line Determines what type of scope is displayed  None 

 Waveform 

 Waveform Parade 

 Line 

 Line Parade 

 Vector 

 Quad Display 

Zoom Range X Min Select which line of the active video to evaluate (varies depending on input 
resolution) 

Zoom Range X Max Determines the start of the display, if you only want 
to view a portion of the video line

(varies depending on input 
resolution) 

Field Select Determines the end of the display, if you only want 
to view a portion of the video line 

 (varies depending on input 
resolution) 

Parameters > Audio Monitoring

AUD Output Selects the audio output to configure for monitoring  AUD 1 

Channel 1 Selects which audio you want to output for audio 
monitoring in channel 1

1 to 16

Channel 2 Selects which audio you want to output for audio 
monitoring in channel 2 

1 to 16 

Stereo Pair Selects which audio pair from the selected audio 
channel you want to output for audio monitoring 
(this control will set channel 1 and channel 2 
appropriately) 

 Channel 1 & 2 

 Channel 3 & 4 

 Channel 5 & 6 

 Channel 7 & 8 

 Channel 9 & 10 

 Channel 11 & 12 

 Channel 13 & 14 

 Channel 15 & 16 

Table 2-5  PiP Parameters (Continued)

Parameter Name Function Options
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Monitor Enables or disables audio monitoring  Disable 

 Enable 

Parameters > PiP Location

X Offset Displays the offset value of the PiP’s horizontal (x) 
position in the layout

(offset value) 

Y Offset Displays the offset value of the PiP’s vertical (Y) 
position in the layout.

(offset value)

X Size Displays the value of the PiP’s horizontal (X) position 
in the layout.

 (value)

Y Size Displays the value of the PiP’s vertical (Y) position in 
the layout.

(value)

PiP State Indicates if the PiP is active in the layout  Disabled 

 Enabled 

Table 2-5  PiP Parameters (Continued)

Parameter Name Function Options

Table 2-6  PiP Alarms

Alarm Name Description

Global Video Summary Active if any video alarm is reported

Global Audio Summary Active if any audio alarm is reported

Global Tally Summary Active if any tally alarm is reported

PiP Audio Ch (1-16) Missing An audio signal is not present on the PiP audio channel 
indicated (Ch1–Ch16).

PiP Audio Ch (1-16) Peak The audio level on the PiP audio channel indicated (Ch1–
Ch16) is over the set peak threshold value.

PiP Audio Ch (1-16) Low The audio level on the PiP audio channel indicated (Ch1–
Ch16) is under the set low threshold value.

PiP Audio Ch (1-16) Silence The audio level on the PiP audio channel indicated (Ch1–
Ch16) is under the set silence threshold value.

Audio Group (1-4) Missing

Not used with HView IP
Format Change 

SD EDH Error

HD CRC Error 

Loss of Video Indicates that the multiviewer hardware can no longer 
detect a video signal from the video channel

CC Missing Indicates that closed captioning (can be HD or SD) is not 
present in the incoming video stream

CC Not Updating Indicates that closed captioning is not updating correctly 
in the incoming video stream 

WSS Missing Indicates that WSS is not present in the incoming video 
(should be present in SD625 only) 
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Module
Parameters
and Alarms

The Module folder provides access to the parameters and alarms relating to the HView IP 
hardware. 

To access the Module parameters and alarms 

1 In the Network view, double-click or expand the Module folder. 

HView IP devices have a single hardware device. 

2 Click the module icon, and in Control mode, click the Parameters tab. 

3 To view a consolidated list of module alarms, click the Alarms tab.

Video Freeze Indicates that the input video image is frozen (static) 
according to user-defined frozen picture delay (duration), 
percent of frozen video in the frame, and amount 
difference between pixels percent tolerance 

Video Black Indicates that the input video image is considered a black 
picture according to user-defined percentage non-black 
picture, delay (duration), and black level threshold values

VChip Data Missing Indicates that there is no V-chip data in the incoming 
video stream

VITC Missing Indicates that there is no VITC in the incoming video 
stream 

CC Not Valid Indicates that the closed captioning data in the incoming 
video stream is not usable

Teletext Missing Indicates that there is no teletext in the incoming video 
stream

Teletext Not Updating Indicates that the teletext data in the incoming video 
stream is frozen

Teletext Not Valid Indicates that the teletext data in the incoming video 
stream is not usable

AFD Missing Indicates that AFD data is not present in the incoming 
video

AFD Format Change Indicates that the AFD information has changed from its 
previous format

Audio Format Change
Not used with HView IP

Dolby E Program Change

VChip Mismatch Indicates that the V-chip data in the incoming video 
stream does not match the expected rating 

WSS Format Change Indicates that the WSS information has changed from its 
previous format 

Table 2-6  PiP Alarms

Alarm Name Description



Chapter 2
HView IP Hardware

24

Copyright ©2011, Harris Corporation

Table 2-7 lists the CCS parameters for the HView IP hardware.

Table 2-7. Module Parameters 

Parameter Name Function Options

Parameters

Module Type Displays the module type (displayed Master) 

System Name Displays the name of the 
current HView IP

(displayed system name)

Table 2-8. Module Alarms 

Alarm Name Description

Major Alarm Summary Active if any alarm condition is reported 
(priority > 7) for the module. 

Minor Alarm Summary Active if any alarm condition is reported 
(4 < priority < 7) for the module. 
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3 Software Installation

HView IP Software Upgrade
HView IP comes with all the software and firmware already installed. However, you may 
occasionally need to update some or all software or firmware components. 

Checking the
Software
Version

To check software versions to determine if updates are necessary, optional, or even available, 
or to ensure that updates were executed complete and correctly. Follow these steps: 

1 In Layout Designer, with the HView IP connected, choose Edit > Multiviewer 
Configuration from the main menu, and then select Advanced Configuration. 

2 Click the Version tab. 

3 Review the Multiviewer and Bios Version data against what is available from Harris. 

Updating the Multiviewer Core Application
You must uninstall the Multiviewer Core Application before installing an updated version. If 
you cancel the uninstall process, you will not be able to install an updated version of the 
software. 

1 Browse to the location of the Multiviewer Core Application *.exe file, and then double-click 
the file. 

An Application Maintenance dialog box opens. 

2 Choose Remove, and then click Next. 

3 On the Multiviewer 3.x Uninstall dialog box, click Next to continue the uninstall process. 

A progress bar appears on the screen. 

4 When the uninstall process is done, click Finish. 

5 Return to the location of the Multiviewer Core Application *.msi file (if using Windows XP) 
or *.exe file (if using Windows Vista), and then double-click the file again. 

A Welcome to the Harris Multiviewer 3.0 Installation Wizard dialog box appears. 

6 Click Next, and then follow the instructions that appear on the screen to install the 
updated version of the Multiviewer Core Application. 
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Creating a Backup Settings Folder
The purpose of a Backup Settings folder on a multiviewer is to store a copy of the three key 
XML files as a backup. If the Multiviewer application detects any corruption in an XML file, 
it will copy the backup file from the Backup Settings folder to replace the main file. If the 
file does not exist in the BackupS et ti ng folder, then the Multiviewer application will create 
a new file with the default settings.

The three XML files are in the C:\Program Files\Harris\Harris Multiviewer folder:

 Settings.xml

 Configuration.xml

 Persistence.xml

1 Create a Backup Settings folder in the Multiviewer folder. The path name will look like:

C:\Program Files\Harris\Harris Multiviewer\BackupSettings

2 Once you have completed configuring your multiviewer completely, copy the three XML 
files to the Backup Settings folder. 

Operating System Recovery
In the rare situation where you must recover the operating system, follow these steps: 

1 Insert the HV-IP-MV USB Flash Drive into available USB Port.

2 Turn on computer and press the F11 key multiple times until prompted with a “boot menu” 
This will allow you to select the USB: Flash Drive XXXX.

If the USB drive does not show up, press CTRL+ALT+DEL to reboot and press DEL to enter 
BIOS. Navigate to Boot Menu, select Hard Disk Drives, Select USB drive as 1st drive. Press 
ESC and Press F10 to save configuration setting and exit setup.

3 System will boot to the HV-IP-MV USB drive and prompts you as follows:

Press 1 and ENTER to Reimage the HV-IP-MV system

4 Press 1 and ENTER to recover the system. 

This removes all data from the hard drive and it restores factory software.

5    Press any key to reboot the system and then remove the HV-IP-MV USB drive.

Once system restored the image, system will boot into Windows and ask for the OS to be 
activated prior to logging into the OS.

6 Click yes to activate now.

7 Select Yes, I want to telephone a customer service representative to activate 
Windows and click Next. 

8 Using an outside telephone line, dial 1-888-571-2048. 

A voice asks: 

Are you calling to Activate Windows XP?

9 Say Yes. 

A voice asks: 
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Do you have the activation window open? 

10 Say Yes, and then say or Enter in the digits for each group using the keypad on the phone.

A voice responds with a new ID. 

11 Enter in the ID provided in the boxes on the computer. 

12 Click Next, and verify that the system has activated. 

 If the system has activated, hang up the phone. 

 If the system has not activated, follow the phone prompts to repeat the process. 

13 Once the windows OS is activated, three normal deployment applications run. 

 App1- copying the run once information to the OS. 

 App2- applying the .net update to the OS. 

 App3- run SIDchanger and reboot the system. 

When deployment of these applications is complete, the system boots up and loads 
Windows. 

A sysprep cleanup runs, and the PC reboots again, loading Windows. You are now ready to 
reconnect to the HView IP using Layout Designer, load layouts, etc. 

Layout 
Designer 

You must use Layout Designer to create and modify layouts, and can remotely control a 
layout on the   HView IP. 

Layout Designer is installed on a separate PC that is on the same network as your   HView IP 
hardware. 

Minimum System Requirements
The PC where Layout Designer is installed should meet the following requirements: 

 Intel™ dual-core processor or higher 

 2.0 GB or more of physical memory (RAM) 

 Microsoft™ Windows® XP, Windows Vista, or Windows 7 (32- or 64-bit) 

 Monitor with SXGA (1280 x 1024) or higher resolution 

For best results, set the display font size to Normal (Control Panel > Display > Appearance > 
Font Size). 

Installing Layout Designer
Install Layout Designer on a PC that meets the recommended system requirements. Your PC 
does not need to be connected to an   HView IP multiviewer system to install Layout 
Designer. 

You will need Microsoft .NET Framework 3.5. If this application has not already been 
installed on your system, download it or install it from the supplied CD. 
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If you have another version of Layout Designer installed on your system, remove it before 
installing the upgraded version. Do this by clicking Explorer on the Multiviewer Control 
Panel, and then using the Add/Remove Programs feature in the Windows Control Panel.

To install the Layout Designer software 

1 Close all other applications running on the PC, and then insert the Documentation and 
Product Resources DVD into the PC DVD-ROM drive.

2 Click Software Applications > Layout Designer x.x (where x.x is the release version of 
the software) > Layout Designer-v.x.x setup.exe. 

3 Follow the on-screen instructions to install the software.

Figure 3-1  Installing Layout Designer

If the installation does not start automatically, double-click the Layout 
Designer-V*-Setup.exe file on the DVD (where “*” is the version number).
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4 Layout Designer Workspace

Layout Designer Workspace
When you start Layout Designer, the workspace appears similar to Figure 4-1. 

Figure 4-1  Layout Designer Workspace

The Layout Designer workspace is the area from which you open, publish, create, and 
modify multiviewer display layouts. The workspace has quick-access menus and palettes to 
help you create and modify layouts and PiPs, as well as to configure audio meters, alarms, 
and metadata. You can customize the Layout Designer workspace to suit the tasks you are 
performing. 

1
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Each workspace element is described below: 

Application
Menus

In some cases, the application menus duplicate commands and options that are accessible 
from the application toolbar shortcuts (see Layout Designer Application Toolbar on 
page 36). Some advanced configuration options are only available using the menus.

Note the following menu information:

 Shortcut keystrokes are listed to the right of the menu item.

 Commands that are not relevant to the selected mode are unavailable.

 The Layout Designer context menu can be accessed by right-clicking items in the layout 
window.

The following tables describe each Layout Designer menu item and its options. 

Application menu - Provides access to Layout Designer’s main commands 
and options. In addition, the menu provides access to the software preference 
settings. See Application Menus on page 30.

Application toolbar - Provides quick access to commonly-used commands 
and options. Some of these options also appear in the Application menu. See 
Application Menus on page 30 and Layout Designer Application 
Toolbar on page 36. 

Tools palette - Provides tools for adding and editing layout objects such as 
PiPs, labels, clocks, tally indicators, info panels, counters, and audio meters to 
the layout canvas. See Tools Palette on page 38.

Layout canvas - Displays the layout that is being created or edited when a 
Layout Designer tab is open. More than one layout can be open at one time, 
but only one layout is visible in the layout canvas. Each layout can be viewed 
using the layout tab at the top of the canvas. See Layout Canvas on 
page 39.

Multiviewers panel - Displays the multiviewer systems that are currently and 
previously connected to the Layout Designer. All systems that are displayed in 
the Multiviewers panel (connected and disconnected) have been configured 
by Layout Designer. For more information, see Multiviewers Panel on 
page 40. 

Library panel - Provides access to stored layout objects (PiPs, windows, info 
panels). Where applicable, each library tab lists the specific name of the object 
and provides a preview of how the object will appear in a layout. For more 
information, see Using the Layout Designer Library Panel on page 60. 

Properties pane - Provides access to user-configurable properties for the 
layout and layout objects currently displayed in the canvas. You can use the 
Properties pane to modify layout, window, and layout object properties. For 
information, see Layout Properties on page 96 and Layout Object 
Properties on page 103.

Application status bar - Displays the current status of the Layout Designer 
application and other operation information. 
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Table 4-1  File Menu Items and Options 

Menu Item/Shortcut Key Icon Description

New Layout Using the Layout Creation Wizard - Opens the 
Layout Creation Wizard dialog box, from which you can 
create a customized layout. See Creating a New Layout Using 
the Layout Creation Wizard on page 83.

Blank Layout - Opens a blank layout. See Creating a New 
Layout from a Blank Layout on page 89.

Open
Ctrl+O

Opens the Open dialog box, from which you can open a layout 
file that is stored on a local or network drive. See Viewing 
Layouts on page 92. 

Close Closes the layout that is currently open. 

Save
Ctrl+S

Saves the layout as a .lay file to a previously specified file name 
and location. See Saving Layouts on page 91.

Save As Opens the Save As dialog box, from which you can specify a file 
name (.lay file) and location for the layout file. See Saving 
Layouts on page 91.

Save All
Ctrl+Shift+S

Saves all open layouts. See Saving Layouts on page 91. 

Page Margin Setup Opens the Page Margin Setup dialog box where you specify 
the margin widths for the print out of the layout when you click 
Print Layout on the toolbar.

Print
Ctrl+P 

Opens a Print dialog where you can choose a printer and print 
the selected layout. 

Publish
F12

Sends the currently displayed layout and any new changes to 
the selected multiviewer. See Displaying and Publishing 
Layouts on page 94.

Exit Closes the Layout Designer application.

Table 4-2  Edit Menu Items and Options 

Menu Item/Shortcut Key Icon Description

Undo
Ctrl+Z

Cancels the last operation performed on the current layout. 
Layout Designer supports multiple levels of the Undo command.

Redo
Ctrl+Y

Reinstates the last operation performed on the currently open 
layout when the Undo command has been used.

Delete Deletes the selected layout object.

Copy
Ctrl+C

Copies the selected layout object and places it on the clipboard, 
from which the object can be pasted to another location.
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Cut
Ctrl+X

Cuts the selected layout object from the current location and 
places it on the clipboard, from which the object can be pasted 
to another location.

Paste
Ctrl+V

Pastes the last layout object placed on the clipboard by either a 
Cut or Copy command.

Select All
Ctrl+A

Selects all objects in the layout.

Deselect
Ctrl+D

Cancels the selection of objects in the layout.

Break Window Breaks apart the objects contained in a window.

Create a Window Creates a window from two or more selected layout objects. 

Lock Window Prevents accessing the properties of individual layout objects 
within a window.

Bring to Front Brings the selected window to the top of the layout; also 
available as a right click option on objects (Order > Bring to 
Front). 

Send to Back Sends the selected window to the bottom of the layout; also 
available as a right click option (Order > Send to Back). 

Multiviewer Configuration Opens the Multiviewer Configuration dialog box that you use 
to modify your multiviewer configuration. See Chapter 5, 
Configuring Display Mode on page 63.

IP Configuration Manager Opens a table that you use to define IP sources. See IP 
Configuration Manager on page 70. 

Preferences Opens the Layout Designer Preferences dialog box, from 
which you can set your application preferences. See Setting 
Your Layout Designer Preferences on page 47.

Table 4-2  Edit Menu Items and Options (Continued)

Menu Item/Shortcut Key Icon Description

Table 4-3  View Menu Items and Options 

Menu Item Icon Description

Properties Shows the Properties pane. 

Multiviewers Shows the Multiviewers panel.

Library Shows the Layout Designer Library panel.

Restore All Panel Default 
States

Resets the Properties, Multiviewers, and Library panels to 
their default positions. You must restart Layout Designer for the 
change to take effect. 
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Zoom In
Ctrl+Up

Magnifies the current display of the layout. Depending on the 
current view, each time you select Zoom In, the layout display is 
magnified by increments of 50% or 25%. 

Zoom Out
Ctrl+Down 

Reduces the current display of the layout. Depending on the 
current view, each time you select Zoom Out, the layout display 
is reduced by increments of 50% or 25%. 

Fit on Screen Resizes the layout so that entire layout is displayed in the 
available screen space. The display size is limited by the size of 
the Properties pane.

Table 4-3  View Menu Items and Options (Continued)

Menu Item Icon Description

Table 4-4  Insert Menu Items and Options 

Menu Item Icon Description

PiP Inserts a PiP into the current layout. Inserted PiPs have default 
properties (width, height, and aspect ratio) that can be modified 
using the Properties pane. See About Picture-In-Pictures 
(PiPs) on page 123.

Label Inserts a new label into the current layout. Inserted labels have 
default properties that can be modified using the Properties 
pane. See About Labels on page 144. 

Analog Clock Inserts an analog clock into the current layout. Inserted clocks 
have a default properties that can be modified using the 
Properties pane. See About Layout Clocks on page 148.

Digital Clock Inserts a default digital clock into the current layout. Clocks 
have a default size and style that can be modified using the 
Properties pane. See About Layout Clocks on page 148.

Tally Inserts a default tally indicator into the current layout. Inserted 
tally indicators have default properties that can be modified 
using the Properties pane. See Creating Tally Indicators on 
page 141.

Audio Meter Inserts a default audio meter into the current layout. Inserted 
audio meters have default properties which can be modified 
using the Properties pane. See Creating Audio Meters on 
page 138.

5.1 Audio Meter Inserts a 5.1 stereo surround sound type audio meter into the 
current layout. Inserted audio meters have default properties 
which can be modified using the Properties pane. See Creating 
Audio Meters on page 138.
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Info Panel Inserts an overlay that provides data from a source or PiP on the 
display. See Creating Info Panels on page 177. 

Up/Down Counter Inserts a counter that can be the target or trigger for alarms, 
and can count up or down. See About Up/Down Counters on 
page 152. 

Add Object to Library  PiP - Adds the selected PiP to the PiPs section of the Library 
panel

 Window - Adds the selected window to the Windows 
section of the Library panel

 Info Panel - Adds the selected info panel to the Info Panels 
section of the Library panel

Table 4-4  Insert Menu Items and Options (Continued)

Menu Item Icon Description

Table 4-5  Format Menu Items and Options 

Menu Item Icon Description

Copy Properties Copies the properties from the selected object so that they can be 
pasted to other objects. See Copying and Pasting Layout Object 
Properties on page 105.

Paste Properties Pastes all of the copied properties to the selected object. See 
Copying and Pasting Layout Object Properties on page 105.

Paste Selected Properties Opens the Paste Category dialog box, from which you can select 
the properties you want to paste to the selected object. See 
Copying and Pasting Layout Object Properties on page 105. 

Align Opens a drop-down menu, from which you can select the following 
alignment commands:

 Left - Aligns the selected layout objects along the left axis of the 
first object selected 

 Right - Aligns the selected layout objects along the right axis of 
the first object selected 

 Top - Aligns the selected layout objects along the top axis of the 
first objects selected 

 Bottom - Aligns the selected layout objects along the bottom 
axis of the first object selected

 Center Vertical - Aligns the selected layout objects along a 
vertical axis that runs through the center of the layout window

 Middle Horizontal - Aligns the selected layout objects along a 
horizontal axis that runs through the middle of the layout 
window

See Aligning and Distributing Objects in a Layout on page 107.
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Distribute Opens a drop-down menu, from which you can select the following 
distribute commands:

 Widths - Distributes the distance between the selected layout 
objects by width

 Heights - Distributes the distance between the selected layout 
objects by height

See Aligning and Distributing Objects in a Layout on page 107.

Table 4-5  Format Menu Items and Options (Continued)

Menu Item Icon Description

Table 4-6  Tools Menu Items and Options 

Menu Item/
Shortcut Key Icon Description

Connect to Device Connects Layout Designer to the selected multiviewer.

Disconnect From Device Disconnects Layout Designer from the currently connected 
multiviewer.

Edit Device Opens the Device Manager dialog box, from which you can edit 
the configuration of the selected multiviewer. See Adding Output 
Displays to the Device List on page 63.

Delete Device Deletes the selected multiviewer configuration from the folder.

Start Multiviewer Triggers the selected multiviewer to load its layout. 

Exit Multiviewer Triggers the selected multiviewer to revert to its desktop. 

Restart Multiviewer Restarts the currently connected multiviewer.

Reboot Multiviewer Reboots the currently connected multiviewer.

Shutdown Multiviewer Powers down the selected multiviewer.

Shutdown all Multiviewers Powers down all multiviewers simultaneously.

Advanced Configuration Opens the Advanced Configuration dialog box, from which you 
can determine various hardware settings. See Advanced 
Configuration on page 66. 

View System Logs Provides access to logs by opening a web browser, and then 
connecting to the Logging Server.

Save Configuration Files Opens a browse dialog box where you can save files to a specified 
location. See Saving and Loading Configuration Files on page 47 
for more information. 

Load Configuration Files Opens a browse dialog box, so you can load configuration files to 
Layout Designer See Saving and Loading Configuration Files on 
page 47 for more information. 
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Layout Designer Application Toolbar
You can use the Layout Designer toolbar to access frequently-used commands and options. 
Some of these functions are also accessible using the Layout Designer application menu 
(descriptions of their functions are located in Application Menus on page 30).

Some options are only available from the Layout Designer application toolbar. The following 
table describes these application toolbar options: 

Table 4-7  Layout Menu items and Options 

Menu Item Icon Description

<Layouts> There is an item in this menu for each layout that is open. 

Table 4-8  Help Menu Items and Options

Menu Item/Shortcut Key Description

Help
F1

Opens the online help. 

About Layout Designer Opens the About Layout Designer dialog box, which displays the version of the 
software. 

Table 4-9  Application Toolbar Options 

Option Name Icon Description

New Layout Layout Using the Layout Creation Wizard  - Opens 
the Layout Creation Wizard dialog box, from which 
you can create a customized layout. See Creating a 
New Layout Using the Layout Creation Wizard on 
page 83.

Blank Layout - Opens a blank layout. See Creating a 
New Layout from a Blank Layout on page 89.

Configuration - Opens the Device Manager dialog 
box, which you can use to create a new multiviewer 
configuration or modify an existing configuration. See 
Chapter 5, Configuring Display Mode on page 63.

Open Layout
Ctrl+O

Opens the Open dialog box, from which you can open 
a layout file that is stored on a local or network drive. 
See Viewing Layouts on page 92. 

Save Layout
Ctrl+S

Saves the layout as a .lay file to a previously specified 
file name and location. See Saving Layouts on 
page 91.

Print Layout
Ctrl+P 

Opens a Print dialog where you can choose a printer 
and print the selected layout. 

Publish Layout Saves the layout to the multiviewer hardware. 
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Cut
Ctrl+X

Cuts the selected layout object from the current 
location and places it on the clipboard, from which the 
object can be pasted to another location.

Copy
Ctrl+C

Copies the selected layout object and places it on the 
clipboard, from which the object can be pasted to 
another location.

Paste
Ctrl+V

Pastes the last layout object placed on the clipboard by 
either a Cut or Copy command.

Delete Deletes the selected layout object.

Clone a Component Creates a control similar to the currently selected 
control, with the differences being unique number and 
name, video source, and dynamic source PiP number, 
and which are all incremented 

Centralize Layout 
Components Horizontally 
and Vertically

Moves all objects within the layout so that they are 
aligned to the center of the layout. This tool does not 
alter the positional relationships between various items 
in the layout, but changes all items’ position with 
respect to the canvas 

Undo
Ctrl+Z

Cancels the last operation performed on the current 
layout. Layout Designer supports multiple levels of the 
Undo command.

Redo
Ctrl+Y

Reinstates the last operation performed on the currently 
open layout when the Undo command has been used.

Zoom Increases or reduces the size of the current display of 
the layout. You can choose from zoom options ranging 
from 15% to 125% (in 1% increments), or you can fit 
the display on the screen.

Rules Provides access to tools for creating and managing 
alarms and events through a drop-down menu. See 
Using the Rules Menu on page 158 for a list. 
For a complete explanation of events and alarms, see 
Alarms and Info Panels on page 157. 

Open/Close PiP Info Window Opens or closes the PiP Info windows on all PiPs in the 
layout. 

Table 4-9  Application Toolbar Options (Continued)

Option Name Icon Description
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Tools Palette Use the Tools palette to insert, select, move, and resize layout objects that are in the 
currently-displayed layout. Objects that are inserted into layouts using the palette’s insert 
tools have default property settings. See Layout Objects on page 101.

The following table describes each Tools palette option:

Layout Designer Panels Highlights the selected panel (either Properties, 
Multiviewers, or Library). 

Enable Control Activates mouse control on the multiviewer from the 
Layout Designer PC. To deactivate the mouse control, 
press ALT + F7 on your keyboard. For more information, 
see Remote Mouse Control on page 192.

Lock/Unlock Layout This button has two states: Unlock Layout and Lock 
Layout. When the layout is unlocked, you can drag and 
drop items in the layout, in addition to adjusting the 
attributes of objects in the Properties panel. When a 
layout is locked, you can still use the Properties panel to 
adjust attributes of objects in the layout, but you 
cannot add, delete, or move objects in the layout. 
Context menus do not appear when you right click on a 
locked layout.

Table 4-9  Application Toolbar Options (Continued)

Option Name Icon Description

Table 4-10  Layout Editing Palette 

Icon Tool Description

Select Allows you to select, move, or resize individual or groups of objects in the layout. 
See Copying and Pasting Layout Object Properties on page 105.

Pan Pans across the layout when the layout display is magnified.

Insert PiP Inserts a single default PiP into the current layout. 
See About Picture-In-Pictures (PiPs) on page 123.

Insert Label Inserts a label into the current layout. See About Labels on page 144.

Insert Analog 
Clock 

Inserts an analog clock into the current layout. See About Layout Clocks on 
page 148.

Insert Digital Clock Insert a digital clock into the current layout. See About Layout Clocks on 
page 148.

Insert Audio Meter Inserts a multi-channel audio meter into the current layout. See Defining 
Alarms for a Layout Object on page 161.

Insert Tally Inserts a tally into the current layout. See Creating Tally Indicators on 
page 141.
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Layout
Canvas

The layout canvas is the design space used to create and edit layouts.

Figure 4-2  Layout Canvas

When multiple layouts are open in Layout Designer, the layouts’ names are listed on 
multiple tabs across the top of the canvas. Each tab also indicates the layout’s locked or 
unlocked status. 

You can use Layout Designer’s editing tools to manipulate and modify PiPs and other layout 
objects. You can add objects to your layout by clicking them in the Tools palette, or by 
dragging the objects from the Library pane and dropping them onto the layout canvas.

Insert 5.1 Audio 
Meter

Using this tool, you can choose to insert a six-channel audio meter for 
monitoring 5.1 channel surround sound audio. See Defining Alarms for a 
Layout Object on page 161.

Insert Info Panel Using this tool, you can insert an overlay that provides data from a source or PiP 
on the display. See Creating Info Panels on page 177. 

Insert Up/Down 
Counter

Using this tool, you can insert a unidirectional counter. See About Up/Down 
Counters on page 152. 

Zoom Slides up and down to increase and decrease the size of the current display of 
the layout. As you drag the slider, the zoom indicator displays the current size. 

Table 4-10  Layout Editing Palette (Continued)

Icon Tool Description

Layout tabs
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Multiviewers
Panel

The Multiviewers panel lists the multiviewer systems that are currently configured using 
Layout Designer. In most cases, the multiviewers listed in the panel have been previously 
configured with Layout Designer. This means that a unique configuration exists for the 
multiviewers listed in this Multiviewers panel. 

Figure 4-3 shows the Multiviewers panel and its components.

Figure 4-3  Multiviewers Panel

Expand the multiviewer system icon to display layouts that are currently stored on the 
multiviewer’s hardware. 

Use the Multiviewers panel menu or toolbar to connect to and disconnect from 
multiviewers, open the Device Manager dialog box to edit or create a new configuration, 
and delete a multiviewer from the Multiviewers panel. 

If Layout Designer cannot detect a multiviewer that was previously connected to the 
software, Disconnected is displayed in the Multiviewers pane.

Double-click on any layout to open that layout in Layout Designer. 

Using the Preferences dialog box, you can choose to have Layout Designer automatically 
connect to the last multiviewer that was connected to the software at startup, as well as 
automatically attempt to reconnect to a multiviewer when the previously established 
connection is lost. For more information, see Setting Your Layout Designer 
Preferences on page 47.

Multiviewers Panel Context Menu and Toolbar
Toolbar icons may not be available depending on the item that is selected. When you 
right-click on a multiviewer, a context menu appears. 

Table 4-11 describes each Multiviewers panel menu item.

Multiviewer system 

Layouts stored/
published on 
multiviewer

Multiviewers panel 
toolbar

Click + to expand 
and view the 
layouts stored on 
the multiviewer’s 
hardware. 
Click - to contract 
(hide) the list.
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When you click a layout in the Multiviewers panel, different menu items appear. Table 4-12 
describes each layout menu item in the Multiviewers panel. 

Table 4-11  Multiviewers Panel Context Menu

Menu Item Icon Description

Connect to Device Connects/disconnects Layout Designer to the selected 
multiviewer.

Disconnect Device

Edit Device Opens the Device Manager dialog box, from which you can 
edit the configuration of the selected multiviewer. See Adding 
Output Displays to the Device List on page 63.

(New)
No menu item available

Opens the Device Manager dialog box, from which you can 
create a new multiviewer configuration. See Adding Output 
Displays to the Device List on page 63.

Delete Device Deletes the selected multiviewer configuration from the library.

(Sort)
No menu item available

Lists multiviewers from A–Z or Z–A, or logically by IP address and 
display number. Roll the mouse over the button to find out how 
the devices are currently sorted. 

Lock Device

Unlock Device

Locks or unlocks the selected multiviewer display. 

Start Multiviewer Triggers the selected multiviewer to load a layout. 

Exit Multiviewer Triggers the selected multiviewer to revert to its desktop (only 
available when the device is connected). 

Restart Multiviewer Restarts the currently connected multiviewer (only available 
when the device is connected).

Reboot Multiviewer Reboots the currently connected multiviewer.

Shutdown Multiviewer Powers down the selected multiviewer (only available when the 
device is connected).

Advanced Configuration Opens the Advanced Configuration dialog box, from which 
you can determine various hardware settings. See Advanced 
Configuration on page 66. 

View System Logs Provides access to logs by opening a web browser, and then 
connecting to the Logging Server.

Shutdown All Multiviewers Powers down all multiviewers simultaneously.
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Library Panel The Library panel has the following sections: Windows, PiPs, and Info Panels. Objects in 
these sections can be dragged from the Library panel and dropped onto the currently 
displayed layout. 

For information about using the Library panel toolbar to create, edit, or delete new library 
objects, see Using the Layout Designer Library Panel on page 60.

The Library panel has a display option menu that you can use to customize how the panel is 
displayed in the layout workspace. For more information about customizing the Library 
panel, see Customizing the Layout Designer Workspace on page 45.

The Library panel items include the following:

 Windows - You can select windows from the Library panel, and then drag and drop 
them onto the currently-open layout. If required, you can then use the Properties pane 
to modify how a window and its layout objects are displayed in the layout. The window 
must be ungrouped or “broken” if you want to modify any object. To ungroup objects 
inside a window, right-click on the window and select Break Window. For information 
about windows, see Creating Layout Windows on page 109. 

 PiPs - PiPs in the Library panel are organized according to their aspect ratio. You can 
select PiPs from the Library panel, and then drag and drop them onto the currently 
open layout. If required, you can then use the Properties pane to modify how the PiPs 
are displayed in the layout. For information about modifying PiP properties, see Layout 
Objects on page 101.

 Info Panels - You can drag info panels from the Info Panels section and drop them 
onto PiPs that are displayed in the layout window, or drop them onto the layout 
background as standalone info panels. You can use the Properties pane to modify the 
contents of an info panel. For information about modifying info panel properties, see 
Modifying Info Panel Properties on page 178. 

Properties
Pane

The Properties pane is located below the Layout canvas. 

1 If the Properties pane is not currently displayed, select View > Properties from the 
application menu.

Table 4-12  Multiviewers panel Menu When You Click on a Layout

Menu Item Description

Display this layout on 
Multiviewer

Displays the selected layout on the selected multiviewer

Recall this layout to Layout 
Designer

Loads the selected layout in Layout Designer

Delete this layout on 
Multiviewer

Deletes the selected layout on the multiviewer (Note: 
this option is not available when the current layout 
displayed on the multiviewer is selected) 
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The Properties pane changes based on the object that is selected on the canvas. 

Figure 4-4  Properties Pane

You can modify properties that affect the way layout objects are displayed in the layout. 
Each group of layout objects has a tab with controls that allow you to adjust the layout 
object’s properties, such as changing the layout output resolution or PiP label text color. You 
can also add elements (such as audio meters and audio and video alarms) to your layout.

Depending on what object is selected in the layout canvas, different tabs appear in the 
Properties pane. To access the Properties pane for a specific layout object, select the 
object in the layout canvas, and then click the appropriate property tab. The number of tabs 
that will appear on the Properties pane will vary depending on the selected object. 

You can resize the Properties pane by dragging its sides with the cursor. Use the scroll bars 
to view the entire pane. The Properties pane is always on top of other panes in the Layout 
Designer interface. If a portion of the pane is obscured by the size of the pane, use the scroll 
bars to view the content. 

Layout Designer Context Menu
The Layout Designer context menu provides quick access to some commands and options 
that are also available from the application menu. 

To access the Layout Designer context menu, in the canvas, select a layout object, and then 
right-click. The context menu appears.The options available on the context menu depend 
on the layout object that is currently selected in the layout.

Context menus do not appear when you right click on a locked layout.

Figure 4-5  Layout Designer Context Menu
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Table 4-13 describes each Layout Designer context menu item.

Table 4-13   Layout Designer Context Menu 

Option Name Description

Delete Deletes the selected layout object from the layout 
currently displayed on the canvas. 

Copy Copies the selected layout object and places it on the 
clipboard, from which the object can be pasted to 
another location.

Cut Cuts the selected layout object from the current 
location and places it on the clipboard, from which 
the object can be pasted to another location.

Copy Properties Copies the properties from the selected layout object 
so that they can be pasted to another layout object 
(same type). For information about copying PiP 
properties, see Formatting Layout Objects in the 
Canvas on page 105.

Paste Pastes the last layout object that was placed on the 
clipboard by either a Cut or Copy command.

Paste Properties Pastes all of the copied properties to the selected 
object. For information about pasting properties, see 
Copying and Pasting Layout Object 
Properties on page 105

Paste Selected Properties Pastes selected categories of properties to the 
selected object. 

Add/Edit Window Alarm Opens the Rules editor for the window, so you can 
alter the alarm configuration for that window. 

Clear Window all Alarms Resets all alarms in the window.

Set Properties This option is available when multiple windows are 
selected. A submenu offers all types of controls for 
all window controls within the selection. When you 
change the settings, all items of that type are altered 
to match. 

Break Window Breaks apart the objects contained in a window.

Remove Window 
Component

This option is available when multiple windows are 
selected. A submenu offers all types of controls for 
all window controls within the selection. The 
selected item is deleted. 

Create a Window Groups objects together to create a window.

Lock Window Prevents accessing the properties of individual layout 
objects within a window.

Consolidate Window(s) Adjusts the background size of the current window 
so that it is the minimum size to contain all the 
objects within the window. 

Create a Scrolling Region Converts the selected window to display a series of 
sources that move in a rolling or crawling motion. 

Lock Scrolling Region Prevents accessing the properties of individual layout 
objects within a scrolling region. 
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Customizing the Layout Designer Workspace
Layout Designer provides a number of different ways that you can customize the workspace 
to best suit your changing working environment. When you use Layout Designer to create 
new layouts and design custom layout objects, you can set up the workspace so that the 
Properties pane and the Library panel are easily accessible. When you are publishing layouts 
for display, you can hide (or auto hide) panels and the Properties pane to maximize your 
view of the canvas area on your computer’s screen. 

Add Scrolling Region to 
Library

Adds the selected scrolling region to the Windows 
section of the Library panel.

Add Window to Library Adds the selected window to the Windows section 
of the Library panel.

Add PiP to Library Adds the selected PiP to the PiPs section of the 
Library panel.

Order Opens a drop-down menu, from which you can 
select the following order commands:

 Bring to Front - Brings the selected layout object 
to the top of the object stacking order

 Send to Back - Sends the selected layout object 
to the back of the object stacking order

For information about ordering layout objects, see 
Formatting Layout Objects in the Canvas on 
page 105.

Info Panel Opens a drop-down menu, from which you can 
select the following commands:

 Remove - Removes the info panel from a PiP

 Unlock Info Panel Items - Unlocks individual 
items from the Info Panel

 Move Out - Allows info panel to move out of PiP

 Add to Library - Adds the info panel to the 
library

 Enable Resizing Info Panel - Allows you to drag 
the edges of the info panel to change its shape 
and size; this can ensure that the indicators do not 
fall on top of a PiP’s video (you can move the info 
panel off the PiP, for example). 

 Disable Resizing Info Panel - Turns off Enable 
Resizing Info Panel 

Add Info Panel to Library Adds the selected info panel to the Info Panels 
section of the library 

Borders Opens a drop-down menu, from which you can 
select from a list of all borders associated with an 
object (normally a window) 

Table 4-13   Layout Designer Context Menu (Continued)

Option Name Description
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When you close Layout Designer, and then reopen it, any previous changes to the pane 
states are retained. To return Layout designer to its default state, select View > Restore All 
Panel Default States from the main menu. 

You can also set default layout and PiP property options.

Setting Panels and Panes Viewing Options
Layout Designer has view options for the Properties pane and Multiviewers and Library 
panels that you can use to customize the Layout Designer workspace. For example, you can 
move these items to different locations in the workspace, or you can hide the items from 
the workspace view. 

To access the Properties pane and the Multiviewers and Library panel view options, click the 
down-arrow icon located at the end of the item’s title bar. The drop-down menu displays 
the view options.

Figure 4-6  Panel and Pane View Options Menu

Each menu option is described below:

 Hide Select this option to remove the panel or pane from the Layout Designer 
workspace. After the item has been hidden, select one of the following options to add 
the item back to the workspace:

 View > Properties 

 View > Multiviewers 

 View > Library

 Floating - Select this option to undock the panel or pane from its stationary location in 
the Layout Designer workspace (bottom of the workspace for the Properties pane and 
the right side of the workspace for the Multiviewers and Library panels). You can then 
use the mouse to move the item to different locations in the workspace. Double-click 
the item to redock it. 

When a workspace item is undocked, you can resize it by clicking then dragging the 
item’s outer edge while holding down your mouse button. The mouse pointer will turn 
to a double-headed arrow to indicate that you have selected the workspace item’s 
outer edge.

 Auto Hide - Select this option to collapse (temporarily hide) the menu item. When the 
Auto-Hide option is enabled, the collapsed items are stored either at the bottom 
(Properties pane) or to the right (Multiviewers library and Layout Designer Library) 
of the Layout Designer workspace. An auto-hidden workspace item is identified by a 
vertical or horizontal tab. To access the workspace item library, hold the pointer over 
the item’s tab. 

You can also activate or deactivate the Auto Hide option by clicking 

the  icon from the workspace item title bar. 

Click here to access the 
panel and pane View 
Options menu
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Panning and Zooming in the Canvas Workspace
To view more or less of the canvas workspace, use one of the following tools: 

 Choose a display percentage from the Zoom drop-down menu on the application 
toolbar at the top of the screen. 

You can also type a number between 15 and 125 in this field. 

 Click To Fit on the application toolbar at the top of the screen to size the canvas so that 
its entire area is visible on the screen. 

 Use the slider to the left of the canvas to increase or decrease the percentage of the 
display that is visible. 

When you click the pointer, the current display percentage appears. 

If you are zoomed in close on an area of the canvas, you can pan the canvas by selecting the 
Pan tool. 

Saving and Loading Configuration Files

To save configuration files 

1 From the main menu, choose Tools > Save Configuration files. 

A Browse dialog box opens. 

2 Choose a location to save the files. 

To load configuration files 

1 From the main menu choose Tools > Load Configuration Files. 

A Browse dialog box opens. 

2 Choose a location to load the files from. 

Files that are loaded and saved during this process include: 

 Configuration.xml for the device and multi-viewer configuration

 Preference.dat for the Layout Designer application preference.

 dockManager.xml for the states of Multi-viewer panel, library panel and the property 
panel.

 Alarms.dat for the alarm template

 WindowCustomLibrary.xml for the customer-defined window library

 PiP16by9Library.xml for the customer-defined PiP library

 BorderStyles.xml for the custom-defined border style library 

Note: You can select multiple files at one time by holding down the CTRL key. 

Setting Your Layout Designer Preferences
Using the Layout Designer Preferences dialog box, you can set the application’s global 
preferences, including default settings for new layouts, windows, labels, and PiPs. You can 
also recall Layout Designer factory default settings. 
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To access the Layout Designer Preferences dialog box, from the Layout Designer 
application menu, select Edit > Preferences. There are five tabs on the Layout Designer 
Preferences dialog box. See the following topics: 

 Setting General Preferences on page 48

 Setting Default Layout Properties on page 50

 Setting Default IP Source Properties on page 52

 Setting Default Window Properties on page 55

 Setting Default PiP Properties on page 57

 Setting Default Label Properties on page 59

After you finish setting your preferences, click OK to apply them. Your preference settings 
are automatically saved each time you exit Layout Designer. 

Setting
General

Preferences

Use the General tab of the Layout Designer Preferences dialog box to set the number of 
levels for Undo and Redo commands, set auto connection options, and return to factory 
defaults.

Setting Undo and Redo Levels
You can set the number of undo and redo levels that can be applied to when the Undo and 
Redo commands are used after an editing operation. 

To set the number of undo and redo levels:

 Under Undo/Redo, type a value in the Undo/Redo field.

Figure 4-7  Setting Undo and Redo Levels

Setting Multiviewer Connection Preferences
You can set up Layout Designer to automatically connect to the last connected multiviewer 
when a connection between the Layout Designer and the multiviewer is lost. 

To select Layout Designer’s auto connect option:

1 Under Autoconnect, select Auto connect to multiviewer if connection is lost check 
box. If you clear this check box and a connection is lost, you can manually reconnect to the 
multiviewer using the Multiviewers panel menu.

Figure 4-8  Autoconnect Option in General Preferences Dialog Box
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Setting Factory Default Recall Preferences

To set factory recall preferences and recall factory defaults:

1 Under Recall Layout Designer Defaults, select which options you want reset to factory 
default settings.

Figure 4-9  Recalling Factory Default Settings in General Preferences Dialog Box

You can select from the following options:

 LD Preferences - Resets all Layout Designer preferences that you can set using the 
Layout Designer Preferences dialog box (General and Default Properties tabs)

 Libraries - Resets the Library panel to the default state.  

 Border Styles - Resets all the available border styles available from the Border tab of 
the Properties pane factory default selection. This means that any created new borders 
added to the Border Styles selection are removed.

2 To recall the factory default options that you selected in step 1, click Recall Factory 
Defaults.

Overwriting Layouts

Figure 4-10  Overwrite Option in General Preferences Dialog Box

If you want to be prompted before overwriting layouts on multiviewers, check this option. 
Otherwise, leave it blank. 

Setting the Default View

Figure 4-11  Default View Settings in General Preferences Dialog Box

Choose one of the following: 

 Zoom Level - When a new layout is created, it is displayed at the percentage defined in 
the field to the right of the radio button. The range is from 15% to 125% in 1% 
increments.

 Fit to Screen - When a new layout is created, the entire layout is displayed in the 
available screen space. The display size is limited by the size of the Properties pane.
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Determining Auto Placement

Figure 4-12  Auto Placement Settings in General Preferences Dialog Box

When you add items to the layout using the Clone a Component button on the toolbar, 
they are spaced from one another using the Auto Placement settings. Use the Horizontal 
Spaces and Vertical Spaces fields to increase or decrease this padding. The available range is 
from 0 to 200. 

Setting Default Layout Properties
You can use the Layout tab of the Layout Designer Preferences dialog box to define the 
default properties for layouts and layout objects, and to configure email settings. 

Configuring General Layout Properties
Layout default properties are used when Layouts are created from a blank layout (File > 
New > Blank Layout) or when using the Layout Creation Wizard (File > New > Layout 
Using Layout Creation Wizard). For more information, see Using a Blank Layout on 
page 90. 

To access these settings, from the Layout Designer application menu, select Edit > 
Preferences, and then click the Layout tab. After you finish setting your preferences, click 
OK to apply them.

To set default layout properties:

1 On the Layout Designer Preferences dialog box, select the Default Properties tab. 
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Figure 4-13  Setting Default Layout Properties

2 Under Layout, select a resolution from the Output Resolution drop-down list. 

3 If you selected Custom from the Output Resolution list, type pixel values for the layout’s 
width and height in the field provided (width first and height second).

4 Under Margins, enter the amount of padding you would like between the edge of the 
layout and where objects, including the background, appear in the layout. 

Layout margins determine the boundary of the layout area where objects, including the 
background, can be placed. The overall layout size is maintained, not cropped. The 
maximum size for margins varies depending on the resolution of the layout. 

5 Beside Background, select either Color or a background image 
(Background 1 to Background 10) from the drop-down list. 

6 If you selected Color as your default background, click the  button to access the 
Select a Color dialog box, and then use the slider to select a color, and click OK.

For more information about using the Select a Color dialog box, see Setting Default 
Window Properties on page 55. 

7 Under Orientation, select either Landscape (wider than tall) or Portrait (taller than wide). 

8 Under UMD Address, if you want fixed UMDs to start at a number other than 0, enter a 
number beside Starting at. 

For information on changing a layout’s properties, see Modifying Layout Properties on 
page 96

When selected, layouts are editable 
when they are opened. Otherwise, 
they open in a locked state. 
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Configuring E-Mail Settings 
The email settings determine the SMTP server for sending email and SMS text message 
alarm actions. See Setting Alarm Actions on page 166 for more information.

Setting Default IP Source Properties
You can use the IP Source tab of the Layout Designer Preferences dialog box to define 
the default properties for IP sources.

Table 4-14  Email Settings in General Preferences 

Parameter Content

SMTP Server Enter the address of the mail server. 

User Name Enter the account name. 

Password Enter the password, if required, to send mail from that 
address. 

Security Type Choose None or SSL. 

Port Number Enter the SSL service port for the sending email 
address. This is only required for SSL-type security 
settings. 

Email Address Enter the user email address on the server, not 
necessarily the target email address of the alarm 
action. 
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Figure 4-14  Default IP Source Preferences 

On this screen, you can choose from various presets in the table at the right of the screen.
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Modifying a Preset 
Click on any preset in the Preset Names table to modify its settings. Preset options are 
listed in Table 4-15

Creating a New Preset 
To create a new preset on the Default IP Presets Preferences dialogue box, follow these 
steps: 

1 Click Add New.

A new preset appears in the Preset Names table. 

2 Click the name, enter new text, and then press Enter to give the preset a relevant name. 

3 Make changes to the preset configuration. 

4 Changes to the preset are stored immediately. 

Table 4-15  Options for Configuring Default IP Sources

Item Description and Options 

Protocol The multiviewer hardware supports the following protocols: 

 RTP (Real Time Protocol or Real-time Transport Protocol) is a data transport 
protocol specifically designed for transporting real-time signals such as streaming 
video and audio. RTP is often used in conjunction with UDP and provides packet 
sequence numbering and packet time stamping. RTP is used in conjunction with 
RTCP (Real Time Control Protocol), a data transport control protocol for 
transporting real-time media streams and including functions to support 
synchronization between different media types (eg. audio and video)  and 
providing information to streaming applications about network quality, number 
of viewers, identity of viewers, etc.

 RTSP (Real Time Streaming Protocol) is a protocol used to set up and control 
real-time streams. It is commonly used to create links on Web sites that point to 
streaming media files.

 UDP-(User Datagram Protocol) is a data transfer protocol used on IP networks 
that offers connectionless, stateless data transport. It is often used in video 
transport applications (along with RTP) because it offers low overhead and does 
not provide automatic rate reductions and packet retransmissions (supplied by 
TCP) that can interfere with video transport.

IP Address Enter the IP address of the source.

Port Enter the port. 

Additional Additional arguments; for example the QSEE requires ‘streaming’. 

Program Number Enter the program within the video stream to be decoded.

Audio Service Enter the audio service within the stream to decode. 

Alias Enter an alternate name for the source. 

Use port as part of alias Adds the port number to the alias name. 

Network Interface From the rear, ENET 1, on the left, is the Streaming port, and ENET 2, on the right, 
is generally used for Layout Designer and networking. 
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Setting Default Window Properties
You can set the default properties for windows that are created using the Create Window 
command from the Layout Designer context menu. For more information about windows, 
see Creating Layout Windows on page 109.

To set default window properties:

1 From the Layout Designer Preferences dialog box, select the Window tab.

2 Under Background, select either Color or a background image (Background 1 to 
Background 10) from the drop-down list.

Figure 4-15  Setting Default Window Properties

3 If you selected Color as your default background, click the  button to open the 
Select a Color dialog box. 

To select a color, do either of the following:

 Use the slider to select a color. 

 Enter the color values you want to use in one of the ScRGB, sRGB, or Hexadecimal 
Notation fields.

Your selected color is previewed below Selected Color.

4 Under Border, if you want a uniform border width around layout objects, select the 
Uniform check box.

If you do not want a uniform border width, clear the Uniform check box, and then type or 
select the values for the Top, Bottom, Left, and Right border widths. 

To select the default border color, beside Border Color, click the  to open the 
Selector a Color dialog box.
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In the Select a Color dialog box, use the slider to select a color, and then click OK.

If required, use the Opacity slider to adjust the color’s opacity value, and then click OK.

5 Select Auto Lock window contents, if you want the Lock Objects in Window to be 
enabled when a window is created. 

When a window is locked, you cannot move or modify the layout objects contained in the 
window until Lock Window is cleared. For more information, see Modifying Window 
Properties Using the Properties Pane on page 112.

Setting IP
Source

Properties

You can create default IP Source properties, and also create presets so a series of properties 
can be reused. 

Table 4-16  IP Source Settings Options

Item Description and Options 

Preset Names Click a name to update the contents of the Settings portion of the screen with the 
definitions for that preset. 

Add New Adds a row to the Preset Names list. Click the new row and type a new label to 
rename the preset. 

IP Address Enter the IP address of the source. 

Protocol The multiviewer hardware supports the following protocols: 

 RTP (Real Time Protocol or Real-time Transport Protocol) is a data transport 
protocol specifically designed for transporting real-time signals such as streaming 
video and audio. RTP is often used in conjunction with UDP and provides packet 
sequence numbering and packet time stamping. RTP is used in conjunction with 
RTCP (Real Time Control Protocol), a data transport control protocol for 
transporting real-time media streams and including functions to support 
synchronization between different media types (eg. audio and video)  and 
providing information to streaming applications about network quality, number 
of viewers, identity of viewers, etc.

 RTSP (Real Time Streaming Protocol) is a protocol used to set up and control 
real-time streams. It is commonly used to create links on Web sites that point to 
streaming media files.

 UDP-(User Datagram Protocol) is a data transfer protocol used on IP networks 
that offers connectionless, stateless data transport. It is often used in video 
transport applications (along with RTP) because it offers low overhead and does 
not provide automatic rate reductions and packet retransmissions (supplied by 
TCP) that can interfere with video transport. 

Port Enter the port the URL communicates over. 

Additional  Streaming

Alias Enter an alternate (unique) name for the source. 

Use port as part of alias When selected, this option appends the port number to the alias name.
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Setting
Default PiP
Properties

You can set the default properties for PiPs that are created using Layout Designer’s Insert PiP 
commands. Default PiP properties are applied to PiPs that are created using Insert > PiP 
from the application window, and the Insert PiP tool from the Tool palette. For more 
information, see Adding PiPs to a Layout on page 125.

To define default PiP values:

1 From the Layout Designer Preferences dialog box, select the PiP tab.

Figure 4-16  Setting Default PiP Video Dimensions

2 Type the values you want to use for the default PiP width and height in the Width and 
Height boxes.

3 Beside Aspect Ratio, select an aspect ratio from the drop-down list.

4 In the Source section of the screen, choose IPor VNC. 

If you choose  IP, the CCS-P Dynamic Name Reference section of the screen is available. 
Choose the source from which your PiPs will derive their names. See Modifying PiPs Using 
the Properties Pane on page 125 for more information. 

5 Beside Borders, if you want a uniform border width around layout objects, select the 
Uniform check box.

If you do not want a uniform border width, clear the Uniform check box, and then type or 
select the values for the Top, Bottom, Left, and Right border widths. 

To select the default border color, beside Border Color, click the  to open the 
Selector a Color dialog box. In the Select a Color dialog box, use the slider to select a 
color, and then click OK.
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6 (Optional) Under Cropping & Markers, select Cropping, and then do either of the 
following:

 If you want a uniform cropping area around the PiP, select the Uniform check box, and 
then select a value. 

 If you do not want a uniform cropping area, clear the Uniform check box, and then 
type or select the values for the Top, Bottom, Left, and Right cropping. 

Cropping rescales the video on the Multiviewer; the lines will not show when you publish 
the layout. 

7 (Optional) Add markers to your PiP. 

Figure 4-17  Markers on a PiP in Layout Designer

Under Cropping & Markers, you can choose the following options: 

 Aspect Ratio Markers—An indicator of correct aspect ratio on the PiP to let you 
know whether the video is properly scaled when a source that is one aspect ratio is 
put on a PiP that has a different aspect ratio. The aspect ratio markers displays the 
area of an image with a 16:9 aspect ratio within a 4:3 coded frame, or an image 
with a 4:3 aspect ratio within a 16:9 coded frame. 

Click Enable to activate a marker on the PiP. To determine the color of the marker, 
click Color, make a selection, and then click OK.

 Safe Area—adds a Title Marker indicator on the PiP to indicate the safe area for 
titles to be displayed (80% of the picture area). 

Click Title Marker to activate a marker on the PiP. To determine the color of the 
marker, click Color, make a selection, and then click OK. 

 Active Format Description—adds an indicator that displays the AFD description 
present on the incoming video. There are two options: 

 AFD - HD and SD video 

 WSS - SD 625 video only

Click Enable to activate a marker on the PiP. To determine the color of the marker, 
click Color, make a selection, and then click OK. 

From the drop-down menu, there are two options: 

 Display mode—(note, this option is always selected) markers on the 
multiviewer PiP indicate the active picture area indicated by the AFD or WSS 
code on the input.

 Convert mode—scales the video on the input source as indicated by the AFD 
or WSS code on the input. 

8 If you want PiPs to have a default scope assigned to them (and you have the Test and 
Measurement option), under Scope, choose the scope to assign. 

Click Configure to further define the scope. 

Cropping marker: 
Image will be cropped 
to within this area and 
rescaled on the 
multiviewer

Marker indicators: 
Display which markers 
will appear on the PiP 
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9 Beside Max Sources, type the maximum number of inputs. 

10 Check Use Cached Sources if you want the multiviewer to use the source names from the 
last time it connected, when the multiviewer is disconnected at Layout Designer start-up. 

For information about altering an individual PiP’s properties, see Modifying PiPs Using the 
Properties Pane on page 125. 

Setting Default Label Properties
You can set the default properties for labels that are created using Layout Designer’s Insert 
Label commands. Default PiP properties are applied to labels that are created using Insert > 
Label from the application window, and the Insert Label tool from the Tool palette. For 
more information, see About Labels on page 144.

To define default Label values:

1 From the Layout Designer Preferences dialog box, select the Label tab.

Figure 4-18  Setting Default Label Preferences 

2 Beside Borders, if you want a uniform border width around layout objects, select the 
Uniform check box.

If you do not want a uniform border width, clear the Uniform check box, and then type or 
select the values for the Top, Bottom, Left, and Right border widths. 
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To select the default border color, beside Border Color, click the  to open the 
Selector a Color dialog box. In the Select a Color dialog box, use the slider to select a 
color, and then click OK.

3 Under Text Source, choose an option. 

All the options are described in Setting the Label Text Source on page 145. 

For information about altering an individual label’s properties, see About Labels on 
page 144. 

Closing
Layout

Designer

When you close Layout Designer, the following dialog box appears: 

Figure 4-19  Exit Modes Dialog Box 

Choose one of the following options: 

 Exit without saving - closes all layouts, discarding changes or updates, and exits 
Layout Designer. 

 Exit with Saving All Layouts - saves all changes to all open layouts, and then exits 
Layout Designer. 

 Exit With Saving One by One - for each layout that has changes, asks if you do or do 
not want to save changes, or if you want to cancel out of closing the multiviewer. If you 
do not click Cancel at any time, Layout Designer closes. 

 Cancel - does not save any layouts, does not close Layout Designer. 

Layouts that have been changed since they were last saved have an asterisk (*) in the layout 
tab. 

Using the Layout Designer Library Panel
The Layout Designer Library panel stores a collection of default and custom layout objects 
that can be dragged from the Library and dropped onto the currently-displayed layout. In 
the Library panel, layout objects are listed by name (which is indicated on each library tab) 
and a preview of the layout object. For information about adding new layout objects to the 
Library, see Adding Objects to the Library Panel on page 61.

The Library panel has view options that customize the way the panel is displayed in the 
Layout Designer workspace. For example, you can undock Library panel items and move 
them to different locations in the workspace, or you can hide the items from the workspace 
view. For more information about the Library view options, see Setting Panels and Panes 
Viewing Options on page 46. 
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Your layout must be in an unlocked state to use the Library panel. 
See Locking and Unlocking Layouts on page 90. 

Adding Objects to the Library Panel
You can design custom layout objects and add them to the appropriate tab in the Library 
panel by right-clicking on the object. 

You can delete any new object using Delete on the Library panel menu. You cannot delete 
the default items from a Library panel. 

If you delete a Library object, you cannot use the Undo command 
to restore the object to the Library.

Adding Layout Objects to the Library Panel
To add a PiP, info panel, or window from a layout to the Library panel, from the layout, 
select the object you want to add to the Library panel and do one of the following:

 From the application menu, select Insert > Add Object to Library, and then, 
depending on the object you want to add, select PiP, Info Panel, or Window. 

If no object is selected, you will be instructed to select the type of object you specified. 

 Right-click, and then depending on the object you want add, select Add PiP to 
Library, Add Info Panel to Library, or Add Window to Library. 

You will only have the option to add an info panel to the Library panel if the info panel is 
not attached to a PiP or a window. However, if a window or PiP contains an info panel, the 
info panel will be added to the Library panel as part of that object. 

When you add a PiP to the Library panel, it is automatically added to the tab for the 
corresponding aspect ratio. 

Using Objects from the Library Panel
You can use objects from the library panel as long as the currently selected layout is not 
locked. If the layout is locked, unlock it by clicking Layout in the main toolbar. 

Adding Layout Objects from the Library Panel to a Layout
To add a PiP, Info Panel, or Window to a layout, select the object with the mouse and while 
holding down the mouse button, drag the object and drop it on the layout. You can 
readjust the position of the object once it has sized itself in proportion with the rest of the 
layout. 

Searching a Library
When you have a large number of objects in a library, it can be difficult to find an object by 
scrolling. You can search a library for an item with a string of text in its title. 

1 Select a library to search. 

The active library is indicated by a green button next to its name. 



Chapter 4
Layout Designer Workspace

62

Copyright ©2011, Harris Corporation

Figure 4-20  Searching a Library

2 Enter your search criteria in the Search field, and then press Enter. 

The library display updates to show all items in the selected library that meet your search 
criteria. 

Green indicates active library

Search criteria

Items in the active library 
that match the search criteria
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5 Configuring Display Mode

Overview Once configured using Layout Designer, your multiviewer is automatically added to the 
Layout Designer Multiviewers panel.

Before you can create a multiviewer system with Layout Designer, you must add the 
multiviewer that you want to set up to the Devices list. Layout Designer software then scans 
the multiviewer hardware to detect specific hardware settings. You may need to enter 
additional information to complete the set up. 

The chapter contains the following sections:

 Adding Output Displays to the Device List on page 63

 Configuring Output Display Devices on page 66

For information about your multiviewer system hardware, see HView IP Hardware on 
page 5. 

When No Multiviewers are Connected 
When a computer running Layout Designer cannot discover any multiviewers on the 
network, the following functionality will not be available in Layout Designer: 

 Enable Control button on toolbar

 Global Alarms and Global Events options in the Rules menu

 Start, Exit, Connect, Disconnect, Edit, Delete, Restart, Reboot, and Shutdown 
Multiviewer options in Tools menu

 On Screen Messages Reset and Preview Margins on Layout properties pane 

 Publish option in File menu 

 Download and Upload tools in the IP Configuration Manager (See IP Configuration 
Manager on page 70) 

You can enable these features by connecting to a multiviewer. See Device Manager 
Dialog Box on page 64 for more information. 

Adding Output Displays to the Device List
The first step in configuring your multiviewer is adding it to the Device list. Then you can 
configure the connected output display. 

There are two ways to add a multiviewer to the Devices list. Both methods are performed 
using the Device Manager dialog box. 

 Use the Discovery tool to scan the network for devices. 
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 Manually enter the IP address of the device that you want to set up. 

To open the Device Manager dialog box: 

1 Select Edit > Multiviewer Configuration from the application menu. 

Device
Manager

Dialog Box

Figure 5-1  Device Manager Dialog Box

Lists by name the devices that have been added to the Devices list. You can 
add or edit the name of a multiviewer at any time.

Lists the IP address of devices in the Devices list. You can add devices to the 
list manually by typing the IP address of a multiviewer in the IP Address 
field.

Displays the number of multiviewer systems or independent displays. The 
number of displays depends on the display mode; for example, Spanned 
mode has one. 

Tests the validity of the device connection by pinging the IP address. 
Invalid connections are indicated by the X icon.

The Multiviewer application must be running to pass this test.

Discovers devices on the network and displays discovered devices by name 
and IP address. 

Adds detected devices to the Devices list.

When Connect to selected device is checked, Layout Designer connects to 
the specified multiviewer immediately once you click Save on the Device 
Manager dialog box. 

1 2 3

5 6

4
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Adding Devices by Scanning the Network
When you use the Discovery tool to add multiviewers to the Device list, Layout Designer 
scans the network and reports all devices with an IP address. The amount of time that a 
discovery takes depends on the number of devices you have on your network. Layout 
Designer may discover devices that you do not want to add to the devices list.

To discover devices:

1 Open the Device Manager dialog box.

2 Under Device Discovery, click Discover Devices.

3 When the discovery is complete, do either of the following:

 Select the devices that you want to add to the Devices list, and then click Add to My 
Devices. 

 To add all of the discovered devices, click Add All to My Devices.

The selected devices appear in the Devices list. 

4 Click Save to save the list and connection information. 

You can now set up your multiviewer using Layout Designer’s Layout Creation Wizard. 

Adding Devices Manually
To add a multiviewer manually, it must have a valid IP address and reside on the same 
subnet as the PC that is running Layout Designer. 

To add a device manually:

1 Open the Device Manager dialog box.

2 Click Add Device. 

A new device appears in the Device list.

Figure 5-2  Adding Devices

3 Under Device Name, enter a new name for the multiviewer hardware.

4 Under IP Address, type the IP address of the multiviewer. 

5 Under Display, type the number of the display on the multiviewer. 

6 To test the validity of the module’s connection, click Test.

One of the following appears in the Connection column.

The connection has not been tested.

The connection is valid.

The connection is invalid.
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7 Click Save to save the list and connection information. 

If your connection is reported as invalid, check the IP address of the device that you want to 
add, and then test the connection again. The Multiviewer application must be running for 
this test to pass. 

Advanced Configuration
The Advanced Configuration dialog box allows you to define different aspects of your 
device, including its IP, communication options, and output display format. 

To open the Advanced Configuration dialog box:

1 Do either of the following: 

 Click Advanced Configuration on the Device Manager dialog box.

 Right-click on a multiviewer in the Multiviewers panel and select Advanced 
Configuration.

Configuring Output Display Devices
On the Display tab of the Advanced Configuration dialog box, you can output to a single 
or dual configuration. For information about connecting monitors and other devices, see 
HView IP Hardware on page 5. 

For the Video Output options, the following terminology is used: 

 Redundant options display the same content on each screen.

 Spanned options display a single layout across multiple screens. 

 Dual options display two different layouts on two screens. 

To configure your output display devices:

1 Open the Advanced Configuration dialog box.

2 Choose the appropriate display format.

Figure 5-3  DVI Display Options (Redundant DVI Selected)
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3 Choose an output resolution from the DVIResolution drop-down list, and set the frame 
rate, if necessary. 

4 To change the orientation of the output from landscape to portrait, select portrait in the 
Display # Orientation drop-down list. 

5 Click Done. 

Viewing IP
Address
Settings

Your multiviewer ships with the default IP address 192.168.100.250. You can use this IP 
address to connect your multiviewer directly to Layout Designer or add the multiviewer to 
your network. 

To change the IP address, your PC must be on the same subnet as the multiviewer 
(192.168.100.xxx).

To view the IP address settings for the multiviewer in the Advanced Configuration dialog 
box, click the IP Settings tab. 

 Setting Up
External
Devices

External devices for use with HView IP   multiviewers include the JLCooper Electronics 
eBOX™ Quad Serial to Ethernet Interface for GPI control and monitoring, and UMD 
devices. 

Adding External Devices
1 Open the Advanced Configuration dialog box.

2 Select the External Devices tab. 

3 In the Device Name list, select the multiviewer that the external device is going to 
communicate with. 

4 Beside Name, enter a descriptive title for your device. 

5 Select the appropriate option from the Type list. 

6 Beside Port, select the communication port that the device is using. 

Devices can communicate through either COM Port 1 or TCP/IP. 

Table 5-1  Supported External Devices  

External Device Function Specific Settings 

TSL Protocol Provides tally and UMD data

N/A for HView IP

JL Cooper E-Box Provides GPI control and monitoring 

Image Video Tally Provides tally and UMD data

Kalypso Tally Provides tally data

Ross Tally Provides tally data

D-Series UMD Provides UMD data

Sony Tally Provides tally data 

Dak RTD Provides scoreboard data to an info panel or label. 
See Using the Scoreboard Option on page 183 
for more information.
Supports only one device, and only over serial. 

Port: COM port 1 
Data Bits: 8
Baud rate: 9600
Parity: None
Stop: 1
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7 Do either of the following:

 If the device is communicating through TCP/IP, enter the device’s IP address and port.

The default IP address of the JL Cooper eBOX is 192.168.254.102, and its default port 
is 23. 

 If the device is communicating through COM Port, enter values for Data Bits, Baud 
Rate, Parity, and Stop.

These settings should match those of the unit to be communicated with. 

8 Click Add. 

A row is added to the list at the bottom of the dialog box. 

9 Repeat steps 4 to 8 for each external device that you want to add.

Removing External Devices
If you are no longer using an external device to communicate with your multiviewer, remove 
it so that the multiviewer no longer accepts inputs from that source. 

1 Open the Advanced Configuration dialog box.

2 Select the External Devices tab.

3 Select an item in the list near the bottom of the dialog box. 

4 Click Remove. 

The row is removed from the list. 

Binding UMD Addresses to Input Sources 
Source UMD functionality is not available for HView IP. 

Getting
Version

Information

Select the Version tab to see version information about the hardware and software 
components and keys, which is for informational purposes only. 

Configuring Network Time Protocol (NTP)
Use the Network Time Protocol (NTP) synchronizes the clocks of computer systems over 
internet connections. 

1 Open the Advanced Configuration dialog box.

2 Select the NTP tab.

Figure 5-4  NTP Settings in the Advanced Configuration Dialog Box

3 Click Enable. 
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4 Enter the IP Address or URL of your NTP source. 

5 Beside Update Interval, select the frequency with which the multiviewer will check for 
updates. 

6 Click OK. 

Enabling
Alarm

Logging

When alarm logging is enabled, alarms are added to the system log, when the Log Message 
alarm action is set for a particular alarm. See Setting Alarm Actions on page 166.

1 Open the Advanced Configuration dialog box.

2 Select the Miscellaneous tab.

3 Click Enable Alarm Logging. 

IP Source 
Update

The first time you connect to amultiviewer device, it has no database. Subsequently, if you 
switch to a different, already configured multiviewer, the following screen appears: 

Figure 5-5  IP Sources Update Dialog Box 

Layout Designer can refer to only one database of IP sources at a time, so you must choose 
whether to use the current database or switch to the database used by the new (different) 
multiviewer. 

To complete the window 

1 (Optional) To view the different databases, click the down arrows beside A and B. 
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Figure 5-6  IP Sources Update Dialog Box, with Lists Expanded 

You can now sort and compare the two lists. 

2 Choose one of the following:

 Do Nothing—Both devices retain their own sources lists. This can create problems 
where dissimilarities occur. 

 Replace local IP sources list (A) with the list from the connected device (B)—
Both HView IP   and Layout Designer use the list stored on the multiviewer. (You can 
perform this function later using the IP Configuration Manager. See Downloading 
IP Sources on page 76)

 Upload the local IP sources list (A) to the connected device—Both HView IP   and 
Layout Designer use the list stored on Layout Designer. (You can perform this function 
later using the IP Configuration Manager. See Uploading IP Sources on page 75)

3 Click OK to close the window.

IP Configuration Manager
IP sources are configured using the IP Configuration Manager. You can open the IP 
Configuration Manager as long as Layout Designer is physically connected to a multiviewer. 

The IP Configuration Manager can be accessed from the following locations: 
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 PiP properties pane

 Info Panel properties pane

 Audio Meter properties pane

 5.1 Audio Meter property pane 

 Scrolling Regions property pane (click the Add button) 

 Main menu under Edit > IP Configuration Manager 

 Third page of the Layout Creation Wizard 

 Change PiP Source action (alarms and rules) 

The top portion of the IP Configuration Manager displays a list of all the sources currently 
configured for the specified Multiviewer. 

A new multiviewer starts with no list of sources. 

Each row in the table represents a single source. Information defined for each source is 
explained in Table 5-2. 

To monitor more than one audio service from an IP source that contains more than one, 
create a separate entry for each service in the IP source database for each service.

You can monitor a Dolby audio service on the audio meters only, and not through the audio 
monitor output.

You can modify the contents of a row by selecting the row and then clicking Edit. See 
Editing an IP Source on page 75. 

Table 5-2  Sources List 

Item Description

Index System-generated number that you can select 
this IP address by. 

IP Source The specific address at which the IP source is 
derived. 

Program Number Displays the program within the video stream 
that is decoded. When set to DF (default), the 
first program in the IP source is displayed. 

Audio Service Displays the audio pair (channel) to decode. 
When set to DF (default), the first audio service 
in the IP source is displayed.

Network Interface Displays the type of interface used for this IP 
source. 

Alias User-defined name for the IP address. 
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The bottom portion of the dialog box opens with different options depending on the 
function you are performing. 

Figure 5-7  IP Configuration Manager Dialog Box with Add Source Selected 

Adding an
IP Source

To add an IP source for a multiviewer, follow these steps: 

1 In the IP Configuration Manager dialog box, click Add. 

The lower half of the dialog box opens or updates to appear similar to Figure 5-7. 

2 Complete the following fields:

This section of the 
screen is closed by 
default, and 
displays 
differently 
depending on the 
option selected. 
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3 Once the Alias has been designated, the Append, Insert, and Replace options become 
available. Choose one of these options to add the IP source to the Sources List. 

 Append to List—Adds the IP source at the end of the Sources list. 

 Insert to List—Adds the IP source above the currently selected item in the sources list. 
All following indexes below this point are increased by one. 

 Replace Selected—Places the IP source instead of the currently selected item in the 
sources list. Items below this item in the list retain their index identifications. 

Table 5-3  Options for Adding Sources in the IP Source Manager Dialog Box 

Item Description and Options 

Protocol The multiviewer supports the following protocols: 

 RTP (Real Time Protocol or Real-time Transport Protocol) is a 
data transport protocol specifically designed for transporting 
real-time signals such as streaming video and audio. RTP is 
often used in conjunction with UDP and provides packet 
sequence numbering and packet time stamping. RTP is used in 
conjunction with RTCP (Real Time Control Protocol), a data 
transport control protocol for transporting real-time media 
streams and including functions to support synchronization 
between different media types (eg. audio and video)  and 
providing information to streaming applications about 
network quality, number of viewers, identity of viewers, etc.

 RTSP (Real Time Streaming Protocol) is a protocol used to set 
up and control real-time streams. It is commonly used to 
create links on Web sites that point to streaming media files.

 UDP (User Datagram Protocol) is a data transfer protocol used 
on IP networks that offers connectionless, stateless data 
transport. It is often used in video transport applications 
(along with RTP) because it offers low overhead and does not 
provide automatic rate reductions and packet retransmissions 
(supplied by TCP) that can interfere with video transport.

IP Address Enter the IP address of the source

Port Enter the port 

Program Number Enter the program within the video stream to be decoded

Audio Service Enter the audio pair (channel) to decode 

Additional  Streaming

URL This field is automatically filled in while entering data in the 
Protocol, IP address, Port, and Additional fields. 

Alias Enter an alternate name for the source (optional) 

Network Interface When looking at the back of the frame: 

 ENET 1 is the port on the left (default), and is normally used 
for streaming video. 

 ENET 2 is the port on the right, and is normally used for 
Layout Designer and networking. 
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Adding a
Range of IP

Sources

To add a range of IP sources for a multiviewer, follow these steps: 

1 In the IP Configuration Manager dialog box, click Add Range. 

The lower half of the dialog box opens or updates to appear similar to Figure 5-8. 

Figure 5-8  Adding a Range in the IP Configuration Manager

2 Complete the fields in the Add Source Range section of the screen, as described in 
Table 5-3. 

For a range of IP addresses, add the low end of the final octet in the field with the rest of 
the IP address, and the high end of the range of the final octet in the field to the right. 

3 Once the Alias has been designated, the Append to List and Insert to List options 
become available. Choose one of these options to add the IP source to the Sources List. 

 Append to List—Adds the IP source range at the end of the Sources list. 

 Insert to List—Adds the IP source range above the currently selected item in the 
sources list. All following indexes below this point are increased by one. 

Bottom end of IP 
address range

Top end of IP 
address range
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Editing an
IP Source

You can edit an IP source, changing only some of the data associated with that source 
without deleting the source from the sources list. Follow these steps: 

1 In the IP Configuration Manager dialog box, select a row in the Sources List table, and 
then click Edit. 

The lower half of the dialog box opens or updates to appear similar to Figure 5-9. 

Figure 5-9  IP Configuration Manager Dialog Box with Edit Source Selected 

2 Make changes to the settings, as described in Table 5-3. 

Changes appear in the SOURCES table as you make them. 

You can make edits to other sources by clicking a different row in the SOURCES table. Once 
a row in the table is selected, use your keyboard’s arrow keys to move up and down the list. 

3 Click Apply & No Exit to save the changes on the Layout Designer PC only, or Apply and 
Exit to save the changes locally and close the window. 

4 To save the changes to the multiviewer, see Uploading IP Sources on page 75. 

Uploading
IP Sources

To upload sources to the multiviewer, follow these steps: 

1 In the IP Configuration Manager dialog box, click Upload. 

Indicates the index 
of the IP source 
being updated
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The lower half of the dialog box opens or updates to appear similar to Figure 5-10. 

Figure 5-10  Upload Sources Portion of IP Configuration Manager Dialog Box

2 Do either of the following: 

 To upload the same IP sources to more than one multiviewer in this session, place a 
check beside Select all or multi-select devices for uploading. 

 Place a check beside each device you want to upload the same IP sources to. 

3 Click Upload, and then click OK to confirm. 

The IP settings are done on a per-multiviewer basis, so IP sources are replaced on all layouts 
on that multiviewer. 

The Status column in the Upload table of the IP Sources Update dialog box indicates 
whether your upload was successful. 

Downloading
IP Sources

To download the IP Sources database from a multiviewer, follow these steps: 

1 In the IP Configuration Manager dialog box, click Download. 

The lower half of the dialog box opens or updates to appear similar to Figure 5-11. 
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Figure 5-11  Download Sources Portion of IP Configuration Manager Dialog Box

2 Select the device you want to download the same IP sources from. 

3 Click Download, and then click OK to confirm. 

Messages appear at the bottom of the dialog box, indicating the stage of the activity. When 
downloading is complete, the Status column of the Download table updates to indicate 
the success or failure of the procedure. 

Saving
IP Sources

When you click Save on the IP Configuration Manager, a dialog box opens. To save the 
table contents as an XML file, select a location and file name and then click OK. 

Opening a Saved IP Sources File 
To open an XML file containing a previously-saved list of IP sources, follow these steps: 

1 On the IP Configuration Manager dialog box, click Open. 

A dialog box opens. 

2 Browse to the location of the saved file, click on the saved file, and then click Open. 

Deleting
IP Sources

To delete a source from an IP source table, follow these steps: 

1 In the IP Source Manager dialog box, select the row that contains the IP source targeted for 
deletion. 

2 Click Delete. 

The row disappears from the table. 
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3 Click Apply & No Exit to save the changes on the Layout Designer PC only, or Apply and 
Exit to save the changes locally and close the window. 

To ensure your change is saved, upload the file to the multiviewer, and save the file as an 
XML file. See the following topics: 

 Uploading IP Sources on page 75

 Saving IP Sources on page 77 

Using IP
Source

Profiles

Use an IP source profile to add similar devices with similar settings to the IP Configuration 
Manager. 

Creating an IP Source Profile 
With the IP Configuration Manager dialog box open, follow these steps: 

1 If the Add Source portion of the screen is not open, click Add.

2 Beside Preset, click Add/Edit. 

The Layout Designer Preferences dialog box opens. 

Figure 5-12  IP Source Preferences 

3 Click Add New. 

A new row appears in the Preset Names list. 

4 Click the new row and enter an unique name for the preset. 

5 Complete the rest of the screen. 
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The contents of the IP Sources screen are described in Table 5-3. 

6 Check Use port as part of alias if you want the port number appended to the alias name. 

7 Click OK. 

Modifying an IP Source Profile 
With the IP Configuration Manager dialog box open, follow these steps: 

1 If the Add Source portion of the screen is not open, click Add.

2 Choose a preset from the Preset menu, and then click Add/Edit to open the Layout 
Designer Preferences dialog box to the IP Source tab. 

3 Update the settings in any field, and then click OK. 

Using an IP Source Profile
In the IP Configuration Manager dialog box, follow these steps: 

1 If the Add Source portion of the screen is not open, click Add.

2 Choose a preset from the Preset menu. 

The Add Source portion of the screen updates to display the default settings in that preset. 

3 Update the settings in any field. 

4 Change the content of the Alias field. 

The Append, Insert, and Replace options become available. 

5 Choose an option to add the IP source to the Sources List. 



Chapter 5
Configuring Display Mode

80

Copyright ©2011, Harris Corporation



81

Copyright ©2011, Harris Corporation

6 Working with Layouts 

About 
Layouts

Layouts are made from an arrangement of windows, PiPs and other layout objects, including 
windows, PiPs, labels, tally indicators, clocks, up/down counters, and on-screen alarms. The 
largest single unit of a layout is a window. Windows are containers that are used to store a 
compilation or arrangement of layout objects, such as PiPs, audio meters, and tally 
indicators. PiPs, the main component of layouts, display video from the multiviewer’s various 
input sources. 

Layout Designer provides a number of different ways to create new layouts for display on 
your multiviewer system. After layouts are created, you can use the editing options to define 
how you want the layout to appear in output display devices.

Use the Layout Designer to modify the default assignment of video before displaying the 
layout in the output display devices.

Layout objects do not need to be part of a window to be displayed in a layout. 
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The following figure illustrates a layout comprised of windows and layout objects.

Figure 6-1  Layout, Windows, and Layout Objects 

Windows are similar to grouped layout objects with the exception that windows have a set 
of distinct properties associated with them. You can apply properties, such as scrolling 
properties, to affect how the window looks and behaves in a layout. Grouped layout objects 
are defined by the individual object properties. For information about creating and editing 
windows, see Creating Layout Windows on page 109.

The display characteristics of a layout are determined by layout objects including PiPs, 
alarms, and audio meters. In additional to these objects, PiPs are associated with attributes: 
borders and labels. In layouts, the position and appearance of layout objects and PiP 
attributes are determined by properties.

Creating 
New 
Layouts

It is important to know the native resolution of the display monitor before you create an 
optimized layout. The native resolution varies from manufacturer to manufacturer. Please 
refer to your display monitor’s manual to find the native resolution. 

Layout

Window

Layout objects

PiP

Border

5.1 and standard 
audio meters

Digital clock

Analog clock

Tally

Info panel
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Figure 6-2  Sample Monitor Resolutions and Layout Designer Resolutions

There are two ways of creating layouts: online and offline. 

New layouts can be created “online,” which means you can take a published layout, edit it 
in Layout Designer, and then re-publish it. 

New layouts can be created “offline,” which means that you can use Layout Designer to 
create a layout, save it to a network or local drive, and then publish it to a connected 
multiviewer at a later time. You do not need to be connected to a multiviewer to create and 
save new layouts. (You must be connected to an multiviewer to publish layouts to it.) 

After you create your layout, save it to a layout (.lay) file. For information about saving 
layouts, see Saving Layouts on page 91. 

Layout
Creation

Workflows

There are a number of different ways or workflows that you can follow to create or edit 
existing layouts. These workflows depend on the level of customization and complexity that 
your new layout requires. You can modify layouts at any time by adding layout objects, such 
as audio meters, on-screen video alarms, or rules.

You can also drag layout objects from the Library panel and drop them on the layout that is 
currently in the canvas.

There are two main workflows that you can use to start creating your new layouts: using 
the Layout Creation Wizard, and using a blank layout. 

Creating a New Layout Using the Layout Creation Wizard
Using the Layout Creation Wizard, you can create customized layouts by defining the 
layout’s basic building blocks, including layout output resolution, the arrangement of PiPs 
(the number of PiPs across and the number of PiPs down) in the layout, as well as the style 
of the PiPs in the layout. The selection of PiP styles that you can choose are defined by the 
PiP styles listed in the PiP tab of the Layout Designer Library. The Layout Creation Wizard 
dialog box has a preview window that displays how your layout will appear in the Layout 
window.

1600 x 1200 Layout resolution = 1600 x 1200

Monitor

SDI 1080i Layout resolution = 1920 x 1080

Monitor
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After you have created the layout, you can add layout objects such as audio meters, tally 
indicators, and alarms. You can then save your custom layout to a layout (.lay) file.

The following figure illustrates the different options available when you create a new layout 
from the Layout Creation Wizard. 

Figure 6-3  Creating a New Layout Using the Layout Creation Wizard

Clicking on any layout object in the Tools palette creates that object on the design canvas. 
You cannot drag and drop objects to the canvas. 

For more information about customized layouts, see Using the Layout Creation 
Wizard on page 84.

Using the Layout Creation Wizard 
Use the Layout Creation Wizard to create custom layouts that you can save, and then 
publish to your multiviewer for display. 

Initial settings for many portions of the Layout Creation Wizard are derived from user 
preferences (File > Edit > Preferences > Default Properties). 

1 To access the Layout Creation Wizard, select File > New > Layout Using Layout 
Creation Wizard.

The Layout Creation Wizard dialog box opens.

2 In the Layout Name field, enter a name for your new layout.

The layout name is used to identify the layout on the Properties pane and when the layout 
is published to your multiviewer hardware. 

New Layout Using the Layout Creation Wizard

Properties

Layout Window PiP Labels Border Tally Audio Meters Alarms

New Layout Using the Layout Creation Wizard

New Blank Layout

Save Crtl+S

Save As      Crtl+Shift+S

Publish

Step1
Start the Layout Creation Wizard Step 4

Save the new layout
  to a local or network drive

Step 2
Add layout objects

Step 5
Publish new layout
to multiviewer

Step 3
Modify layout, PiP, and
layout object properties

Info Panels
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3 Click Next. 

Figure 6-4  Wizard Page 2—Resolution and Margins

4 To select an output resolution, under Resolution, do either of the following: 

 For a standard output resolution, select Predefined, choose either Landscape or 
Portrait, and then make a selection from the Output Resolution list. 

 For a custom output resolution, select Custom Defined, and then type or select values 
for width and height. 

For best results, select an output display resolution that matches the native resolution of 
your output display device.

5 Under Margins, enter the amount of the layout area you would like to have reserved, so 
that objects, including the background, cannot be placed there. 

The margin setting does not affect the size or resolution of the layout as a whole. The 
maximum size for margins will vary depending on the resolution of the layout. 

6 Click Next. 
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Figure 6-5  Wizard Page 3—Component Type

7 Under Component, select either PiP or Window. 

The component type you choose here will be the basic item that will fill your layout. 

If you choose PiP, select the an aspect ratio. 

The aspect ratio you select determines the PiPs that are available when you select a style 
from the Select PiP tab. For example, if you want to select a style from the 16:9 tab of the 
PiP Library, select 16:9 from the Aspect Ratio list. 

8 Below Source, choose one of the following: 

 IP Sources (See Selecting an IP Source on page 129) 

 VNC Sources (See Selecting a VNC Source on page 128) 

9 Select a select a starting source for your PiPs.

The Source PiP property of the first PiP will be set to the value of Starting Source, and 
following PiPs will use the next sources in sequential order. 

To find the index number for the first source of the layout, you can click IP Sources 
Manager, and then use cancel to return to the wizard.

10 Beside UMD Address, enter the first number as output by your UMD device when using 
layouts with a fixed UMD address. 

11 Under Padding, choose the amount of padding to add to the top, bottom, left, and right 
of components in the layout. 

Padding is the distance between the components. 

12 Click Next.
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Figure 6-6  Wizard Page 4—Choose PiP or Window Format

13 Depending on whether you chose to populate your layout with PiPs or windows, do either 
of the following:

 If you chose PiPs on the previous page of the wizard, select the PiP style you want to 
use for your new layout. 

Click Default PiP, in which case the PiP will match the settings as configured in the 
Default Properties tab of the Preferences window, or click A PiP from Library, and 
then choose a PiP from the PiP Library field. Only the page of the PiP library which has 
the aspect ratio you chose on the previous page will be available. 

 If you chose windows (which includes PiPs and other layout objects) on the previous 
page of the wizard, select the window style you want to use for your new layout from 
the Window Library. 

If the window you choose has alarms, you can select Keep Alarms, and the alarm 
settings, except those that point to controls outside the window, are retained and will 
appear in the new layout. When a window has no alarms, this option is unavailable. 

14 Click Next. 
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Figure 6-7  Wizard—Choosing a Layout Style 

15 Use the tools on this page to assign a number of rows and columns of PiPs or windows on 
your layout. 

Drag the slider to the left of the preview to change the number of rows of displays, and 
drag the slider below the preview to change the number of columns. The range these 
sliders can be dragged through depends on settings you made in previous pages of the 
wizard. 

16 (Optional) To choose a non-uniform style of layout (where PiPs or windows may vary in size), 
click Open to Select More Styles, and then click on a style in the pane that appears. The 
additional styles will update as you move the sliders on the preview pane. 

If you choose a previously stored layout for your layout style, click the Browse button, and 
then choose any *.lay file, and then Click OK. 

When you click Next, if you have chosen a custom layout, these options appear: 

Use selected PiP or Window (contains PiP) to: 

 Replace all windows that contain PiPs—replaces all windows with the default 
window or PiP selected in the wizard. 

 Replace all PiPs that are not in the windows—replaces all PiPs with the default 
window or PiP selected in the wizard. 

If both options are selected, then all windows and PiPs are replaced with the default PiP or 
window. 

If neither option is selected, then no PiPs or windows are replaced with the default PiP or 
window.

17 (Optional) Click Display Layout Preview Image.

18 Click Next.

The final screen of the wizard displays a preview of your layout, if you chose Display 
Layout Preview Image on the previous screen. 

19 To complete the layout and exit the Layout Creation Wizard, click Finish. 
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Before you make changes to the layout or publish your new layout, save it as a layout file on 
a local or network drive. See Saving Layouts on page 91.

You can add layout objects (such as clocks and tally indicators, audio meters, and on-screen 
alarms) to your layout before publishing the layout to your multiviewer. You can also modify 
layout and layout object properties such as re-assigning input channels to PiPs. See the 
following sections for more information:

 Layout Properties on page 96

 Layout Object Properties on page 103

 Formatting Layout Objects in the Canvas on page 105

 About Monitoring Tools on page 157

Creating a New Layout from a Blank Layout 
When you select a blank layout as the starting point, there is no pre-arrangement of PiPs or 
other layout objects in the layout canvas. You must add all of the layout objects, including 
PiPs, to your new layout by either dragging them from the Library panel or by inserting the 
objects using the Tool palette. You can also add layout objects by using the application 
menu’s insert commands. 

Layout Designer does not restrict you from positioning PiPs so that they overlap one 
another. 

After you add PiPs and objects to your new layout, you can use Layout Designer’s 
formatting tools, such as Align and Distribute, to create custom PiP arrangements. You can 
also use the Properties pane to modify the layout, PiP, and object properties, as well as add 
audio meters and alarms. You can then save your custom layout to a layout (.lay) file. 
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The following figure illustrates the different options you can use to create a new layout 
from a blank layout.

Figure 6-8  Creating a New Layout from a Blank Layout

Using a Blank Layout 
You can create a layout by dragging layout objects from the Layout Designer Library onto a 
blank layout. 

To create a layout from a blank layout:

1 Select File > New > Blank Layout.

The Layout window opens and displays a blank layout. 

2 Set the layout properties using the Properties pane.

For information about viewing and setting layout properties, see Viewing Layout 
Properties and Modifying Layout Properties on page 96. 

Locking and
Unlocking

Layouts

When a layout is locked, it displays a closed padlock icon in the top left corner of the layout 
tab. When it is unlocked, the padlock icon is open. 

The Lock/Unlock Layout button is on the button bar at the top of the Layout Designer 
screen. 

New Layout Using the Layout Creation Wizard

New Blank Layout

Save Crtl+S

Save As      Crtl+Shift+S

Step 1
Select New Blank Layout Step 4

Save the new layout
to a local or network drive

Step 2
Add layout objects

Publish

Step 5
Publish new
layout to multiviewer

Step 3
Modify layout, PiP, and
layout object properties

Library

Windows

PiPs

Borders

Info  Panels

Step 2
Drag layout objects from
the Library panel and drop
them onto the canvasProperties

Layout Window PiP Labels Border Tally Audio Meters Alarms Info Panels
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To lock a layout: 
1. Click Lock Layout. 

You can use the Properties panel to adjust attributes of objects in the layout, but you cannot 
add, delete, or move objects in the layout. Context menus do not appear when you right 
click on a locked layout.

To unlock a layout: 
1. Click Unlock Layout. 

You can drag and drop items in the layout, in addition to adjusting the attributes of objects 
in the Properties panel.

Saving
Layouts

After creating a new layout using the Layout Creation Wizard or a blank layout, you can 
save your layout. Layouts saved as layout files are opened using Layout Designer’s Open 
Layout command.

You can save your layout as layout (.lay) files to a local or network drive so that you can 
open the layout in Layout Designer at any time. Layouts that have been changed since they 
were last saved have an asterisk (*) in the layout tab. 

To save your new layout as a layout file:

1 Select File > Save As.

2 Type a name for your new layout in the Save As dialog box, and then click OK.

When you close Layout Designer, you are offered the opportunity to save layouts. For more 
information, see Closing Layout Designer on page 60. 

To save all open layouts, select File > Save All. 

To overwrite the layout when you have already saved it, select File > Save. 

Opening
Layouts

If you have closed a layout, depending on where it was saved, you can open it in the 
following ways: 

 If the layout was published to a multiviewer and you are connected to that multiviewer, 
double-click the layout in the Multiviewers pane. 

 If the layout was saved to a hard drive, USB key, or other backup storage system, from 
the main menu select File > Open and then browse to the location where the layout 
was saved. Select the layout and click Open. 

The layout opens in a locked state. 
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Viewing 
Layouts

To display a layout on the layout canvas, you must connect Layout Designer to the HView IP 
multiviewer, and then select the layout you want to display. You can open multiple layouts 
in the layout canvas; however, you can only view one layout at a time. You can toggle 
between the different layouts that are currently open in the layout canvas by clicking the 
tabs located at the top of the layout canvas (see Figure 6-9). When a layout is displayed in 
the canvas, you can modify its appearance and add new layout objects. You can create new 
layouts, edit existing layouts, and define audio and video alarms and rules. 

If you want to modify a layout, you may need to unlock it. See Locking and Unlocking 
Layouts on page 90. 

For information about how to connect Layout Designer to a HView IP multiviewer and select 
layouts for display on the layout canvas, see Connecting Layout Designer to an HView 
IP Multiviewer on page 93 and Displaying and Publishing Layouts on page 94. 

Figure 6-9 illustrates an overview of Layout view options and controls.

Figure 6-9  Using Layout Designer Controls and Options

Publish layouts to the selected multiviewer. For information, see Displaying and 
Publishing Layouts on page 94.

Create new layouts from a blank layout, or by using the Layout Creation 
wizard. For more information, see Creating New Layouts on page 82.

Select a layout stored on a multiviewer for display or for editing. See Displaying 
and Opening Layouts Stored on the Multiviewer on page 94.

2
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Modify layout properties, such as display output resolution and background 
color, using the Layout Properties pane. See Modifying Layout Properties on 
page 96.

Connecting Layout Designer to an  HView IP Multiviewer 
If Layout Designer is not currently connected to a   HView IP multiviewer, or if you want to 
connect to any of the multiviewers that are displayed in the Multiviewers library, use the 
Connect command. If Layout Designer cannot find a configuration for the selected 
multiviewer, you must create one using the Configuration Wizard. For information about 
configuring multiviewers, see Chapter 5, Configuring Display Mode on page 63.

To connect the multiviewer to Layout Designer:

1 From the Multiviewers panel, select the multiviewer to which you want to connect.

2 Right-click the selected multiviewer, and then select Connect to Device from the context 
menu. 

It may take up to three seconds for Layout Designer to connect with the multiviewer. When 
connected, Layout Designer displays (Connected) after the multiviewer name. The layouts 
stored in the connected hardware are listed below the multiviewer name.

Figure 6-10  Connected Multiviewers

Disconnecting Layout Designer from an  HView IP Multiviewer
1 Right-click the selected multiviewer, and then select Disconnect Device from the context 

menu. 

Rebooting and Restarting a Connected  HView IP Multiviewer 
After you have connected to a multiviewer system, you can use the Multiviewers panel 
context menu to perform various hardware-related operations. In the Multiviewers panel, 
right-click the connected multiviewer, and then, from the context menu that appears, select 
from the following options:

 Start Multiviewer - Select this option to trigger the selected multiviewer to load a 
layout. 

 Exit Multiviewer - Select this option to trigger the multiviewer to revert to its desktop. 

4

Connected multiviewers

Layouts stored on the 
multiviewer hardware

Connect, disconnect, lock/
unlock, or configure a 
multiviewer using the 
Multiviewers panel toolbar
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 Shut Down Multiviewer - Turns off the selected multiviewer without restarting. 

 Restart Multiviewer - Select this option to restart the multiviewer’s On-Screen 
application. Restarting the multiviewer will disrupt the displays connected to the 
multiviewer.

 Reboot Multiviewer - Select this option to reboot the multiviewer hardware, 
including its central processing unit (CPU). Rebooting the multiviewer will disrupt the 
displays connected to the multiviewer.

Displaying and Publishing Layouts
After you have connected Layout Designer to a multiviewer, you can select layouts and 
display them on the multiviewer’s output display devices. Using Layout Designer, you can 
choose to display layouts that are currently stored on the multiviewer or you can open 
layouts that are saved as layout files. You can then use the Publish command to display the 
layouts on the multiviewer’s output display devices. 

The following sections describe how to display layouts. For information about displaying 
new layouts, see Viewing Layouts on page 92.

Displaying and Opening Layouts Stored on the Multiviewer
When Layout Designer is connected to a multiviewer, the layouts currently stored on the 
multiviewer hardware are shown in the Multiviewers panel. To view the layouts that are 
stored on a multiviewer, in the Multiviewers panel, click or expand the multiviewer’s icon. 

Figure 6-11  Multiviewers Panel

If you do not want to view or modify the layout, you can display the layout without opening 
it in Layout Designer. If you want to view, modify, or save the layout to a local or network 
drive, you must open it in Layout Designer. You can then use the Publish command to 
display the modified layout. For more information, see Publishing Modified Layouts on 
page 95.

If Layout Designer is not connected to a multiviewer, see Connecting Layout Designer to 
an HView IP Multiviewer on page 93. 

If you want to modify the layout, you may need to unlock it. See Locking and Unlocking 
Layouts on page 90. 

Click the + to 
view all the 
layouts on the 
multiviewer 
system.
Click - to hide 
them. 
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To display a layout:

1 On the Multiviewers panel, right-click the layout that you want to display on the 
multiviewer(s), and then select Display this Layout on Multiviewer from the context menu 
that appears. 

The selected layout is now displayed in the output display device(s).

To open a layout in Layout Designer: 

1 Do either of the following:

 From the Multiviewers panel, select the layout that you want to open in Layout 
Designer, right-click, and then select Recall this Layout to Layout Designer from the 
context menu.

 In the Multiviewers panel, double-click the layout that you want to open in Layout 
Designer. 

You can use tools to modify the layout and objects as well as add objects to the layout, and 
then use the Publish command to display the layout on the multiviewer. For more 
information, see Modifying Layout Properties on page 96 and Layout Object 
Properties on page 103. For information about publishing a layout, see Publishing 
Modified Layouts on page 95. You can also save the layout as a layout (.lay) file. For more 
information, see Saving Layouts on page 91. 

Publishing
Modified
Layouts

You can open a layout in Layout Designer, modify it by adding objects, such as audio meters 
or alarms, and then use the Publish command to display the modified layout on the output 
display devices. When the layout is published, the multiviewer is automatically updated with 
the modified layout.

The following section describes how to open a layout in Layout Designer, and then publish 
the layout to the multiviewer. For information about modifying layouts and adding layout 
objects, see Modifying Layout Properties on page 96.

To publish a modified layout:

1 From the Multiviewers library, double-click the layout you want to modify.

The selected layout opens in the layout window. 

2 Make the required modifications to the layout. For information about modifying a layout, 
see Modifying Layout Properties on page 96. 

3 To publish your modified layout to the mulitiviewer, click Publish on the Layout Designer 
application toolbar.

Publishing
Layouts From
Layout Files

You can select a layout file from a local or network drive, and then publish it to your 
multiviewer display. There is no limit to the number of layouts that you can store on your 
multiviewer hardware, as long as there is enough disk space. 

To ensure that you do not lose any of the layouts currently stored on the multiviewer 
hardware, open them in Layout Designer, and then save them to a local or network drive.

To publish a layout that is stored on a local or network drive:

1 To open a layout (.lay) file, select File > Open.

2 In the Open dialog box, browse to the location of the layout file you want to open, and 
then click OK.
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The layout file opens in the layout window. You can make modifications to the layout 
before you publish it to the multiviewer display. For information about modifying a layout, 
see Modifying Layout Properties on page 96.

3 To publish the layout, click Publish from the Layout Designer application toolbar.

Layout 
Properties

Layout property settings define how the area of the layout window is displayed in the 
output display device(s) that are connected to the multiviewer. When you create new 
layouts, you need to select options for your layout properties. Layout properties can be 
modified any time layouts are open in the Layout Designer canvas. You can view and 
change layout properties using the Layout tab in the Properties pane. 

For best results, ensure that the Output Resolution and frequency settings match the 
resolution and refresh rate of the output display device(s) connected to your multiviewer.

Viewing
Layout

Properties

You can view and change layout properties using the Properties pane. 

To access the Properties pane:

1 Select View > Properties.

The Layout Properties pane appears similar to the following: 

Figure 6-12  Layout Properties Pane

Modifying
Layout

Properties

You can modify the properties of a layout that is currently open in the Layout Designer 
canvas. This includes layouts that have been created using a blank layout or the Layout 
Creation Wizard. See the following sections: 

 Modifying the Resolution on page 97

 Modifying the Background on page 97

Naming Layouts
A Layout’s name identifies it in various Layout Designer workspace dialog boxes and tabs 
including the following tabs:

 Multiviewers panel

 Properties pane
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To modify the layout’s name:

1 Under Properties, type a name for your layout in the Layout Name field.

Modifying the Resolution
Layout Designer supports a number of standard predefined output resolutions. You can also 
define custom output resolutions. When selecting the orientation and resolution for your 
layout, ensure that your output display devices support your selections. 

Your layout must be in an unlocked state to change its resolution. 
See Locking and Unlocking Layouts on page 90. 

To modify the resolution:

1 Under Resolution, do one of the following:

 To select a standard output resolution, click Predefined, and then select a resolution 
from the drop-down list. 

 To select a custom output resolution, click Custom, and then type or select values for 
output width and height.

2 Click Apply.

Modifying the Background
You can select either a solid color or a predefined background image as your layout’s 
background. There are 10 pre-defined background images.

To modify the background:

1 Under Background, from the Set Background list, select either Color or a background 
image (Background 1 to Background 10) from the drop-down list. 

2 If you selected Color as your default background, click the  button to access the 
Select a Color dialog box.

3 To select a color, do one of the following:

 Use the slider to select a color. 

 Enter the color values you want to use in one of the ScRGB, sRGB, or Hexadecimal 
Notation fields.

Your selected color is previewed below Selected Color.

4 If required, use the Opacity slider to adjust the color’s opacity value, and then click OK.

5 Click OK.

Making Layout-Specific Settings
There are three layout-specific buttons, which control settings on a per-layout basis. 

Under Layout Alarms, click Clear to clear all the component alarms on the active layout 
opened in LD. 

This does not affect the alarms on the display. To clear alarms on the display, republish the 
layout. 
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This function coincides with the Reset Alarms on-screen option as described in Table 11-1 
on page 190.

Under Layout Events, click Configure to open the Layout Event Configuration dialog 
box. This option is also available from the toolbar by clicking Rules and selecting Layout 
Events from the menu that appears. For complete information about setting and using 
triggers, see Configuring Layout Events and Global Events on page 175. 

Under On Screen Messages, click Reset to acknowledge all messages displayed by alarm 
rule message box. This function coincides with the Clear Messages on-screen option as 
described in Table 11-1 on page 190. 

Margins
You can adjust the margins on the layout by entering numbers in the four Margins fields. 
The margin limits the size of the entire layout. The background is resized to fit the new area. 

The available range for margins varies depending on the resolution of the layout, with an 
absolute maximum of 200 pixels on the higher resolutions. 

Your layout must be in an unlocked state to adjust the margins. 
See Locking and Unlocking Layouts on page 90. 

Drawing Grid
On the Layout Properties pane, you can activate a grid for the layout canvas. This grid is for 
layout purposes, and will not appear on the published layout. 

IconMaster Mode 
(Not applicable to HView IP)  

Table 6-1  Drawing Grid Options

Option Function

Show Grid Displays a grid on the layout canvas 

Snap to Grid Whether the grid is displayed or not, when this is checked, 
items will snap to grid positions when dragged around the 
layout 

Grid Color Click the button to choose a color for the lines in the grid

Horizontal Spacing Determines the distance (in pixels) of the lines that run 
from top to bottom on the grid; lines can be spaced from 
5 to 40 pixels apart

Vertical Spacing Determines the distance (in pixels) of the lines that run 
from left to right on the grid; lines can be spaced from 5 to 
40 pixels apart
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OverRide PiP Number
When this option is disabled, each PiP is automatically assigned a PiP number, which is 
greyed out (but still displayed, for informational purposes) on the PiP’s Properties pane. 
When this option is enabled, you can alter the PiP number. 

Within a layout, each PiP must have a unique number. If you attempt to assign a number to 
a PiP, and that number is already in use, the PiP number will automatically jump to the next 
available PiP number. 
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7 Working with Layout Objects

Layout 
Objects

Layout objects are the building blocks that provide the look and feel of a layout. Layout 
Designer includes a variety of layout objects that perform different types of functions, such 
as bordering a PiP and metering input audio signals. Layout objects include PiPs, labels, 
clocks, tally indicators, audio meters, and info panels. 

New layouts created using the Layout Creation Wizard contain PiPs and windows, which can 
contain any layout objects. Ideally, when creating a layout you will use pre-defined windows 
which contain such objects as audio meters, tallies, labels, and info panels, so the input 
source for all the objects in the window will track together. 

Additional layout objects, such as audio meters and tally indicators, can be added to a layout 
after the layout has been created. You can add objects to layouts by dragging them from the 
Library panel onto the layout canvas, or by using the insert commands from the Tool palette 
and application menu.

You can group Layout objects together so that they can be simultaneously moved and/or 
formatted in the layout canvas. You can also create an arrangement of layout objects, and 
then add them to a window. As part of a window, this group of layout objects can be 
manipulated as a single layout object that has a distinct set of window properties.Window 
properties include a background (which is different from the layout background color). 
Scrolling properties can be applied to a window. Windows and the arrangement of layout 
objects contained in the window can then be added to the Windows tab of the Library 
panel. The window can be added to other layouts in a single drag-and-drop action.

The display characteristics of layout objects are determined by their individual property 
settings. Layout object properties are modified in the same way, regardless of how they were 
added to the layout. For example, a PiP in layout created from the toolbar is modified in the 
same way as a PiP added to a layout from the Library panel. For information about layout 
object properties, see Layout Object Properties on page 103.

The following figure illustrates a typical layout displaying layout objects.
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Figure 7-1  Typical Layout

Each layout object is described below: 

PiP - Displays the input video/graphics from a single input channel. An 
individual PiP’s properties determine how it appears in the layout. Each PiP in a 
layout can have its own set of properties. For more information, see About 
Picture-In-Pictures (PiPs) on page 123.

Digital Clock - Displays time from NTP or internal reference source. The digital 
clock can be resized. For information, see Setting Digital Clock Format on 
page 150.

Analog Clock - Displays the time from NTP or internal reference source. There 
are various styles of analog clocks. For more information, see Setting Analog 
Clock Format on page 149. 

Label -Three types of labels display text information, static, dynamic and alarm/
rules. A Static label displays manually entered text. A Dynamic label can have an 
UMD source from external UMD protocol. A alarm/rule label can be configured 
using the rules editor to display text information upon an event. For more 
information, see About Labels on page 144. 

Tally - Displays monitoring status from external UMD protocol, GPI inputs, or 
an alarm/rule event. For more information, see Creating Tally Indicators on 
page 141.

Audio Meter - Displays audio ballistics from the selected audio service for the 
IP source. Audio meters can be added to individual PiPs in a layout. You can 
display up to 16 channels from an audio input on a PiP. For more information, 
see Defining Alarms for a Layout Object on page 161. 

1

3

2

4 5

8

6

7

9

1

2

3

4

5

6



HView IP
User Guide

103

Copyright ©2011, Harris Corporation

Border - Displays a user-defined graphic area around a PiP. Individual border 
properties determine how borders appear around the PiPs. Borders can display 
status from external UMD protocol, GPI inputs, or an alarm/rule event. For more 
information, see Modifying Border Properties on page 117

Info Panel—Provides such data as alarms, closed captioning, VITC, and teletext 
data. Info panels can be standalone or overlaid on a PiP. For more information, 
see Creating Info Panels on page 177.

Up/Down Counter—Provides either a count up or count down timer that can 
be configured to be triggered by alarm rules, GPI, or SNMP, and can target 
alarm actions. For more information, see About Up/Down Counters on 
page 152.

Using the Layout Designer Properties panel, you can modify layouts and PiP properties, and 
add audio meters and info panels to create customized layouts that can be displayed in the 
multiviewer’s output display device. Customized PiP attributes such as borders and labels, 
are stored as part of the PiP in the Library panel. 

Layout
Object

Properties

Each layout object has a number of unique properties that determine and define how it is 
displayed and how it behaves in the layout. These properties are independently set; each 
layout object can have a different set of properties. These settings can be modified at any 
time. You can use the various tabs of the Properties pane to modify individual layout object 
properties. PiPs, windows, label text, clocks, and audio meters each have separate property 
tabs.

To access the Properties pane:

1 Select View > Properties.

Adding Layout Objects to a Layout
You can add objects by using the Library panel, the Tools palette, or the Insert menu. 

 Drag selected layout objects from the Windows, PiPs, or Info Panel Library panel tab, 
and then drop them onto the layout canvas. When you use this method of adding 
layout objects, you can select from standard as well as any customized objects that 
have been previously created and added to the Library panel. 

 Click an object on the Tools palette. The object appears on the layout canvas.

 Choose an object item from the Insert menu. 

Your layout must be in an unlocked state to add, move, or delete objects.
See Locking and Unlocking Layouts on page 90. 

Objects inserted into layouts using the Tools palette or the Insert menu have default object 
properties. New items are automatically added “on top” of other items. To change the 
order of items in the layout, use the Order > Bring to Front and Order > Send to Back 
options in the context menu. Items are positioned on the canvas based on your auto 
placement preferences setting. See Determining Auto Placement on page 50 for more 
information. 

After you have inserted the objects into a layout, you can use the Properties pane to modify 
their properties.

7

8

9
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To add layout objects using the Library panel:

1 If the Library panel is not currently visible in the Layout Designer workspace, select View > 
Library.

2 From the Library panel, click the tab of the layout objects that you want to add to your 
layout. 

Figure 7-2  Adding Layout Objects Using the Library Panel

3 Select the layout object that you want to add, drag it to the canvas, and then drop it on to 
your layout. 

To add layout objects using the Tools palette:

1 Click the icon of the layout object to insert. 

For information about the options on the Tools palette, see Tools Palette on page 38.

After you add objects to your layout, you can:

 Use your mouse to move the objects in the layout canvas

 Use Layout Designer’s formatting tools to accurately align and distribute the objects in 
the layout, as well as copy and paste PiP properties

 Modify layout objects using the Properties pane. 

Before publishing your new layout, you can save it as a layout file on a local or network 
drive. For information about saving layouts, see Saving Layouts on page 91. 

See the following sections for information about modifying and formatting layout objects:

 Layout Properties on page 96

 Layout Object Properties on page 103

 Formatting Layout Objects in the Canvas on page 105

 About Monitoring Tools on page 157
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Formatting Layout Objects in the Canvas
Layout Designer has a number of layout object formatting options that you can use to 
arrange and resize objects in a layout, as well as cut, copy, and paste properties. These 
options are especially useful for quickly formatting objects for layouts that are created using 
a blank layout. For example, if you have dragged a number of objects from the Library panel 
onto your layout, you can use Align and Distribute commands to position each object 
accurately in the layout.

To modify the properties of more than one like object, you can change the property setting 
on one object, use the Copy Properties to copy the modified object’s properties, and then 
use the Paste Properties option to paste those modified properties to each like object in 
the layout.

You can use the formatting options to arrange and format objects in all types of layouts.

Your layout must be in an unlocked state to use the formatting options. 
See Locking and Unlocking Layouts on page 90. 

Copying and Pasting Layout Object Properties
Use the Copy Properties and Paste Properties options to copy and paste properties 
between like objects. This option is useful when you want to modify the properties of 
multiple PiPs. For example, if you want to modify the same property setting for all the PiPs in 
your layout, select the PiP from which you want to copy properties, use the Copy PiP 
Properties option to copy those properties, and then paste the properties to other PiPs in 
the layout using the Paste PiP Properties option. 

To access Layout Designer’s Copy Properties and Paste Properties options, select and 
then right-click on a PiP. 

Your layout must be in an unlocked state to copy or paste properties. 
See Locking and Unlocking Layouts on page 90. 

To copy the properties from a selected object and paste them to 
another, like object in the layout:

1 Right-click the object from which you want to copy properties.

2 From the context menu, select Copy Properties.

3 Right-click the like object to which you want to paste the copied properties.

4 Choose one of the following functions:

 To paste all of the copied PiP properties, select Paste Properties.

 To choose which properties to paste, select Paste Selected Properties. 

A Paste Category dialog appears. 

5 Choose the categories of properties you want to paste by selecting one or more of the 
following options: 

 Size

 Border

 Others

Selecting All will select all three options. 

6 Click OK. 
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Cloning
Layout

Objects

The cloning tool creates a control similar to the currently selected control, with the 
differences being unique number and name, video source, dynamic source PiP number, and 
UMD address, which are all incremented 

1 Select the layout object to be cloned. 

2 Click Clone a Component on the application toolbar. 

The new object’s position in the layout canvas is determined by your auto placement 
preference setting. See Determining Auto Placement on page 50 for more information. 

Resizing and Moving Layout Objects Using a Mouse

Your layout must be in an unlocked state to resize or move objects. See Locking and 
Unlocking Layouts on page 90. 

You can use your mouse to resize and move selected objects in a layout. You can resize 
objects by clicking, and then dragging the resizing handles that are located around the 
outer edge of the object. To move an object, select it, and then hold down the mouse 
button while dragging the object to a different location in the layout. To make fine 
positional adjustments, after selecting an object in the layout, press the arrow keys on your 
keyboard to move the selected object. 

Figure 7-3  Resizing Layout Objects Using a Mouse

If the Aspect Ratio property is set to Custom, when you resize a PiP, its width and height 
resizing are not constrained to the proportions of a set aspect ratio. 

When you move an object into alignment with another object in a layout, red lines appear 
temporarily on the canvas so you can see when they are perfectly aligned. 

Figure 7-4  Temporary Alignment Guides 

Object resize handles
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Working 
With 
Groups of 
Objects 

It is sometimes useful to select a group of like objects and alter them all the same way -- for 
example, resize all PiPs within a group of windows. 

To select more than one object, hold down the CTRL key on your keyboard while clicking 
the objects in the layout. To remove an object from the selection group, click on it again 
with the CTRL key held down. 

Setting Like Objects’ Properties
1 Right-click a group of objects, which can include one or more windows and select Set 

properties. 

A submenu lists all the object types that are selected, including the non-border items in the 
windows. The sub-menu can contain PiPs, Tallies, Labels, Clocks (analog or digital), Info 
panels, etc.

2 Select one of the items in the sub-menu to open the properties pane for that type of object. 

You can now make changes to all the selected like objects simultaneously. 

Remove Like Objects from Control for a group of windows 
1 If a selection contains a window and at least one other object, right click and select 

Remove Window Component. 

A submenu lists all the object types that are selected, including the non-border items in the 
windows. The sub-menu can contain PiPs, Tallies, Labels, Clocks (analog or digital), Info 
panels, etc.

2 Select one of the items in the sub-menu to delete all instances of that type of object within 
the selection, for example all PiPs within the selection. 

3 To resize the window to match the size of its contents, right-click and select Consolidate 
Window. 

You cannot remove the first item in a window. 

Aligning and Distributing Objects in a Layout
To align or distribute objects in a layout, you can use the Align and Distribute commands, 
which are located in the application menu or as right-click options when two or more items 
are selected. You can use the Align and Distribute commands to arrange objects in all 
types of layouts. 

Your layout must be in an unlocked state to align or distribute objects. See Locking and 
Unlocking Layouts on page 90. 

To access these commands, you must select multiple objects in your layout. To select 
multiple objects, hold down the CTRL key while selecting individual objects with your 
mouse. To deselect multiple objects, click on an empty space in the window. The following 
figure illustrates a layout with multiple selected PiPs.
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Figure 7-5  Multiple Selected PiPs

Table 7-1 lists the Align commands you can use to arrange objects in a layout.

Table 7-1  Align Commands

Menu Name Toolbar Icon Description

Left Aligns two or more selected objects 
along the left axis of the first object 
selected 

Right Aligns two or more selected objects 
along the right axis of the first object 
selected 

Top Aligns two or more selected objects 
along the top axis of the first object 
selected 

Bottom Aligns two or more selected objects 
along the bottom axis of the first 
object selected

Center Vertical Aligns two or more selected objects 
along a vertical axis that runs through 
the center of the canvas

Middle 
Horizontal

Aligns two or more selected objects 
along a horizontal axis that runs 
through the middle of the canvas

Multiple selected PiPs identified by the 
dashed lines 
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Table 7-2 lists the Distribute commands you can use to arrange objects in a layout.

Creating 
Layout 
Windows

Windows allow you to create containers for layout object compositions or arrangements. 
Each window can be copied and pasted as a single object. A window can be created from a 
selection of PiPs, labels, info panels, borders, clocks, audio meters, up/down counters, and 
tally indicators. After you create a window, you can add it to the Library panel, so it is ready 
to be dragged onto other layouts. 

When you select a window in a layout, you can view and modify all the alarms for all the 
objects within that window on the Alarms tab of the Properties pane. 

You can make the window a scrolling region and set it to crawl (scroll in the horizontal 
direction) or roll (scroll in the vertical direction). Configuring windows with scrolling 
properties allows you to display more video inputs that are connected to your multiviewer 
system than it would otherwise have capacity for.

You can use the Window Properties tab to modify window properties as well as to 
configure window rolling and crawling settings. Similar to layout objects, windows can be 
moved and resized in the layout canvas using a mouse. For more information see, Copying 
and Pasting Layout Object Properties on page 105.

Your layout must be in an unlocked state to create or break windows, or to modify their 
contents, position, or size. See Locking and Unlocking Layouts on page 90. 

Table 7-2  Distributing Commands

Menu Name Toolbar Icon Description

Widths Distributes the width distance 
between two or more selected 
objects

Heights Distributes the height distance 
between two or more selected 
objects
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The following figure illustrates window specific options and operations.

Figure 7-6  Windows Options and Operations

Create a window by selecting the layout objects that you want to include, and 
then use the context-menu’s Create a Window command. You can add your 
new window to the Library panel. See Creating New Windows on page 111

Break apart a selected window. For information, see Breaking Apart a 
Window on page 111.

Drag a window from the Library panel and drop it on to the layout canvas. For 
information see, The animations are not displayed on the Layout Designer 
canvas, and can only be viewed once the layout is published to a display. on 
page 121.

Add PiPs and other layout objects for use as a window in your layout. Working 
With Groups of Objects on page 107.

Modify window properties and configure window settings using the Window 
Properties tab. Modifying Window Properties Using the Properties Pane on 
page 112.
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Creating New
Windows

You can create a window from two or more selected layout objects in any combination, 
including other windows, to form a new window. When layout objects become part of a 
window, they maintain their position, order, and size. The window background and border 
are the lowest layer among the objects contained in the window. This means that layout 
objects that are part of the window cannot be positioned behind the window background. 

The properties of individual Layout objects can be modified when they are contained within 
a window. However, you cannot resize or position objects beyond the borders of the 
window. 

To create a window:

1 To select multiple layout objects you want to add to the new window, hold down the CTRL 
key while selecting individual objects with your mouse. 

Figure 7-7  Window Objects

Selected objects are indicated by the magenta dashed line. The new window border is 
indicated by the green dashed line. 

2 Right-click the objects, and then select Create a Window from the context menu. 

After you create a new window, you can add it to the Windows tab of the Library panel by 
selecting Add Window to Library. 

The layout objects are superimposed over the window background, and surrounded by a 
layout border. You can name the window and modify some window properties using the 
Window Properties tab. For more information, see Modifying Window Properties 
Using the Properties Pane on page 112.

To view your new window on output display devices, you must publish the current layout to 
the multiviewer hardware. For information, see Displaying and Publishing Layouts on 
page 94.

Breaking
Apart a
Window

When a window is broken apart, the objects contained in the window maintain their order 
in the canvas. 

Border of new window indicated 
by the green dashed line

Selected layout objects indicated by 
the magenta dashed line
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To break a window apart:

1 Select the window you want to break apart.

2 Right-click, and then choose Break Window from the context window. 

Consolidating a Window
If you have removed objects or changed their positions within a window, right click on the 
window and choose Consolidate Window to recreate the window. 

If more than one window is selected and you select Consolidate Windows, this option 
consolidates all windows within the selection. 

Modifying Window Properties Using the Properties Pane
You can use the Windows Properties tab to modify window properties such as window 
size and position. Window border size and color properties are modified using the Borders 
tab. 

To view your modifications on output display devices, you must publish the current layout 
to the multiviewer hardware. For information, see Displaying and Publishing Layouts on 
page 94.

Viewing Window Properties

To access the Windows Properties tab:

1 In the canvas, select the window you want to modify.

2 If the Properties pane is not open below the layout canvas, select View > Properties.

Naming Windows
The name you give to a window identifies it when you add the window to the Library panel.

To name your new window:

1 In the Windows Properties tab, under Details, type a name into the Name field.

Modifying the Contents of a Window
To select the individual components in your window, the window must be unlocked. 

To unlock the contents of the window:

1 Do either of the following: 

 In the Windows Properties tab, under Details, clear the Lock Objects in Window 
field. 

 Right-click on the window in the canvas and unselect Lock Window. 

You can now change the properties of individual items within the window, including size, 
position, and other attributes. 
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To lock the contents of the window:

1 Do either of the following: 

 In the Windows Properties tab, under Details, select the Lock Objects in Window 
field. 

 Right-click on the window in the canvas and select Lock Window. 

You can now click anywhere in the window, including any object contained within it, to 
move, resize, or adjust the attributes of the entire window. 

Modifying a Window’s Background
Windows are created with a user-defined default background color. You can select a color 
or a pre-defined graphic image as the background to your window.

To modify a window’s background:

1 Under Appearance, select either Color or a predefined background image from the 
drop-down list.

2 If you selected Color from the Set Background list, click the  icon to open the 
Select a Color dialog box. 

3 Select or enter a color value. 

Your selected color is previewed below Selected Color. 

4 If required, use the Opacity slider to adjust the color’s opacity value.

5 Click OK.

Resizing and Moving Windows Using the Windows Properties 
Pane
Use the Windows tab on the Properties panel to resize and move windows. When you 
resize or move a window, the properties of the layout objects contained in the window are 
not modified. For example, if you resize a window, the layout objects remain anchored in 
their original position. 

To resize a window:

1 Under Position & Dimensions, type or select values for the width and height in the Width 
and Height fields.

To move a window:

1 Under Position & Dimensions, type or select values for the window’s horizontal position in 
the Left field and vertical position in the Top field. 

The Left control positions the window horizontally using the left edge of the layout canvas 
as the point of reference. A value of 0 places the window along the left edge of the layout 
canvas. The Top control positions the window vertically using the top the of the layout 
canvas as the point of reference. A value of 0 places the window along the top edge of the 
layout canvas
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Creating Scrolling Regions 
A scrolling region is a special window that allows you to display more sources than your 
multiviewer hardware will normally show. Unlike other windows, a scrolling region cannot 
be broken. Nor can you create a window around it. Scrolling regions can be added to the 
window library. 

Creating a Scrolling Region
To create a scrolling window, do one of the following: 

 Right click on a window in the Layout pane, and from the context menu that appears, 
choose Create a Scrolling Region. 

 Choose Scrolling Region from the Regions section of the Window panel. 

A scrolling region appears initially as a green line around the window. 

The Windows tab is replaced by a Scrolling Regions tab in the Properties pane. Click on 
the scrolling region's background for the Scrolling Region pane to be available.

Figure 7-8  Scrolling Regions Tab in the Properties Pane

To replace a scrolling region with a new one, drag the new scrolling region on top of the old 
one. A text message flashes to indicate it has approached its boundary. The size of scrolling 
region is adjusted according to the new area. 

You can also drag a window from the window library on top of a scrolling region to replace 
the scrolling region. 

A scrolling region can only contain one PiP or window. When you publish the layout to a 
multiviewer, the scrolling region will fill with PiPs or windows, based on the movement you 
choose. See Assigning a Motion Type to a Scrolling Region on page 115. 

Changing Details for a Scrolling Region 
The following options and information is provided in the Details section of the Scrolling 
Regions Properties pane. 

 Name: Identifier for the region when configuring other objects to connect to it. 
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 Lock Objects in Scrolling Region: Locks the scrolling region so elements in it cannot 
be changed or moved. Alternately you can right click on a scrolling region and select 
Lock Parent Window or Lock Scrolling Region. 

When created, scrolling regions are initially unlocked so you can revise the window 
control inside the scrolling region. For best results, when you are done configuring a 
scrolling region, lock it so it is not altered by accident. 

 Scrolling Region ID: This is the ID, unique within this layout, that is automatically 
assigned to this scrolling region when the scrolling region is created. You cannot 
change the scrolling region ID, but may use it when with various rules connected with 
the scrolling region. 

Assigning Sources to a Scrolling Region
A scrolling region needs a range of PiPs assigned to it. No PiPs in a scrolling region can be 
VNC type. 

Selecting Router Sources
Router sources are not available for HView IP. 

Selecting IP Sources
Beside Start, choose the first IP address you would like use, and beside End, choose the last 
IP address you would like to use. 

Figure 7-9  IP Source Settings for a Scrolling Region

To access the IP Configuration Manager from the pane, click either of the Add buttons. 
(See IP Configuration Manager on page 70.) 

Assigning a Motion Type to a Scrolling Region 
You can alter a scrolling region's motion in the following ways: 

Motion: Determines the direction of movement for the series of sources. 

 Crawl: A sequence of sources progresses from right to left across the window. 

 Roll: A sequence of sources progresses from the bottom to the top of the window.

 Flip: One PiP appears on the screen. It rotates on its center horizontal axis, and each 
time the image returns, it contains a different source. 



Chapter 7
Working with Layout Objects

116

Copyright ©2011, Harris Corporation

 Circle: Three PiPs are on the screen at a time. One source appears in the center and the 
foreground, with the other two are behind and to the left and the right. The PiPs 
change position using video scaling so that the foreground PiP moves to the right 
background position, the left background position moves to the foreground, and a new 
source replaces the left background PiP. 

Speed: Ranges from 1 (slowest) to 10 (fastest). 

Enable mouse/agent control: Allows or disables mouse wheel control of the sources 
within the scrolling region from the Multiviewer itself after the layout is published to the 
multiviewer. When enabled, the scrolling region will only move with mouse control. 

Enable PiP Parking: When this is checked, a PiP that exhibits an alarm situation appears 
always “on top” of the scrolling region. If more than one PiP has alarms, then the PiP on top 
cycles through the PiPs with triggered alarm conditions. 

Modifying a Scrolling Region’s Background
Scrolling Regions are created with a user-defined default background color. You can select a 
color or a pre-defined graphic image as the background to your scrolling region.

To modify a scrolling region’s background:

1 Under Appearance, select either Color or a predefined background image from the 
drop-down list.

2 If you selected Color from the Set Background list, click the  icon to open the 
Select a Color dialog box. 

3 Select or enter a color value. 

Your selected color is previewed below Selected Color. 

4 If required, use the Opacity slider to adjust the color’s opacity value.

5 Click OK.

Resizing and Moving Scrolling Regions 
You can use the Scrolling Regions tab on the Properties panel to resize and move scrolling 
regions. When you resize or move a scrolling region, the properties of the layout objects 
contained in the scrolling region are not modified. For example, if you resize a scrolling 
region, the layout objects remain anchored in their original position. 

Resizing is not allowed when the scrolling region is locked. 

To resize a scrolling region:

1 Under Position & Dimensions, type or select values for the width and height in the Width 
and Height fields.

To move a scrolling region:

1 Under Position & Dimensions, type or select values for the scrolling region’s horizontal 
position in the Left field and vertical position in the Top field. 
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The Left control positions the scrolling region horizontally using the left edge of the layout 
canvas as the point of reference. A value of 0 places the scrolling region along the left edge 
of the layout canvas. The Top control positions the scrolling region vertically using the top 
the of the layout canvas as the point of reference. A value of 0 places the scrolling region 
along the top edge of the layout canvas. 

You can also reposition a scrolling region by dragging it using the mouse, or by clicking the 
arrow keys on your keyboard (when the scrolling window is selected). 

You can also resize a scrolling region by dragging its corners and sides. See Resizing and 
Moving Layout Objects Using a Mouse on page 106. 

Adding a Scrolling Region to the Library 
If you intend to use your scrolling region to other layouts, you can add it to the library. 

To add a scrolling region to the library pane: 

1 Right-click on the scrolling region in the layout pane.

2 From the context menu that appears, choose Add Scrolling Region to Library. 

The scrolling region is added to the Windows section of the library. 

Modifying Border Properties
Borders display a user-defined graphic area around some layout objects, such as PiPs, 
windows, and labels. Like other layout objects, individual properties determine how the 
borders appear around supported layout objects. Border properties can only be modified 
using the Borders tab of the Properties pane. You cannot use your mouse to modify object 
borders directly in the canvas. 

Your layout must be in an unlocked state to change a border’s properties. See Locking 
and Unlocking Layouts on page 90. 

Borders normally provide a graphic area around PiPs and windows. However, when a border 
is applied to a PiP, and that PiP is in an alarm state, the border can be used to signal an 
alarm condition. For example, you can create customized borders for Black Video and 
Frozen Video alarm conditions. See Alarms and Info Panels on page 157 for more 
information. 

Default values for Border property settings are defined in the Layout Designer 
Preferences dialog box (see Setting Your Layout Designer Preferences on page 47).

Selecting a Border for Modification Within a Window
Multiple objects within a window can have border properties. In order to modify the border 
properties of a PiP or other object within a window, you must first select that object. By 
default, when you select a window and then select the Borders properties tab, you modify 
the border of the window itself. 

To modify the border of an object within a window: 

1 Right-click on the window. 



Chapter 7
Working with Layout Objects

118

Copyright ©2011, Harris Corporation

2 Select Borders > [Component] Border where [Component] is the item with a border that 
you want to modify. 

3 Make modifications on the Borders properties tab. 

Within the Borders submenu, you can select the window itself and any sub-windows it may 
contain, as well as PiPs and labels. 

Applying Borders Using the Properties Pane
To apply a border style from the Properties pane, you must first select a layout object that 
supports borders. This includes PiPs, info panels, and windows. 

1 From the Properties pane, click the Borders tab to display the selected layout object’s 
border properties.

2 Click an item in the Border Styles field, and then click Apply. 

Modifying Borders Using the Properties Pane
To modify a border style, click Edit Style. The tools are the same as those used in creating a 
border style. See Creating New Border Styles on page 119 for more information. 

1 From the Properties pane, click the Borders tab to display the selected layout object’s 
border properties.

Figure 7-10  Modifying Border Properties

2 To set the width, do one of the following:

 To set a uniform border width around the layout object, under Border, select Uniform, 
and then type or select a border weight in pixels.

 To set different values for the top, bottom, left, and right border weights, clear 
Uniform, and then type or select border weight values in the Top, Bottom, Left, and 
Right boxes.

3 To select a new border color: 

a Click Edit Border Colors to open the Border Colors dialog box. 

b On the Normal tab, click beside Primary Color to set the color of the border before an 
alarm or tally is triggered. 

c Click OK. 

4 From the Style drop down box, select from the following outline styles and effects:

 Normal - Border outline has color characteristics only

 Rounded - Border outline has four rounded corners, instead of square corners

Click to see the selected border 
animated in the layout. 
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 Beveled - Border outline has a beveled edge effect

 Texture - Border fill is textured. You can select from three texture styles

You can also select combinations of outline styles and effects (Rounded Texture 1). 

For information on filling out the Color Selector dialog box, see Setting Default 
Window Properties on page 55. 

Creating New
Border Styles

Using the Properties pane, you can create new border styles which can be applied to layout 
objects such as PiPs, windows, and labels. After you create a border style, it appears in the 
Borders Properties tab under Border Styles. The border you create or modify is displayed 
in the Border Styles dialog box under Preview.

Setting new border style details:

1 In the current layout, select an object that has an associated border.

2 Under Border Styles, select New.

The Border Styles dialog box appears.

Figure 7-11  Border Styles Dialog Box

3 Under Details, type a name for your new label style in the Name field. 

This name is used to identify the style in Border Styles section of the Borders Properties 
tab.

4 From the Style drop down box, select from the following outline styles and effects:

 Normal - Border outline has color characteristics only

 Rounded - Border outline has four rounded corners, instead of square corners

 Beveled - Border outline has a beveled edge effect

 Texture - Border fill is textured. You can select from three texture styles

You can also select combinations of outline styles and effects (Rounded Texture 1). 

Setting Border Size
Do one of the following: 

 To set a uniform border width, under Size, select Uniform, and then type or select a 
border weight in pixels in the Size box.
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Figure 7-12  Setting Border Size

 To set different values for the top, bottom, left, and right border weights, clear 
Uniform, and then type or select border weight values in the T, B, L, and R boxes.

Setting the Border State Source 
In the Border State Source area, there are three options: 

For UMD/Tally options, make the following selections: 

 Tally Number–the number of the tally within the UMD address that is monitored.

 Program Number–Enter the correct number in this field if you are using Ross Protocol. 
If you are using another protocol, the data in this field will be ignored. 

Setting Border Colors
You can set primary and secondary colors, and add animation and lighting effects to the 
border. 

1 On the Border Properties pane, click Edit Border Colors.

The Border Colors dialog box opens. 

Table 7-3  Border State Source Options 

Border State 
Source Option Configuration Options

UMD/Tally System 
(Fixed UMD Addr) 

Select the UMD address that will be the input source for the 
border. 

UMD/Tally System 
(Under Monitor 
Display) 

Select the PiP Number that will be the input source for the border. 

Alarm Rule

Select this option if you want the border to be the target for an 
alarm, and then follow these steps to define the alarm source: 

1. With the border selected in the layout, select the Alarms tab in 
the Properties pane. 

2. Following the instructions in Defining Alarms for a Layout 
Object on page 161, configure the Detectors and Actions 
pages of the Rules dialog box. 

On the Actions page, choose Set Tally Alarm State, and 
complete the Action Parameters section for that action. 
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Figure 7-13  Setting Border State Properties

2 Select the tab that identifies the state that you want to edit.

For a static border, select Normal.

3 To create or modify a border for a tally or alarm, you can select colors that identify the 
border’s primary and secondary states. Layout Designer provides Custom, Web, and 
System color palettes. To select your new border color, make the following selections:

 Click beside Primary Color to set the color of the border before an alarm or tally is 
triggered. You can choose colors from a menu. 

 Click beside Secondary Color to set the color of the border after an alarm or tally is 
triggered.

4 To add a spotlight effect to your border, select Add Spotlight, and then choose the angle 
from which the light appears from the Light Position menu. 

The spotlight effect is only available when the border style is Beveled or Rounded Beveled. 

5 To apply animation effects to the border state, select one of the following from the 
Animation drop-down list:

 Color Change—Applies a primary to secondary color change to the border

 Moving Light—A moving light travels around the border perimeter.

 Flashing/Transition—The lighting flashes and changes to different colors.

The animations are not displayed on the Layout Designer canvas, and can only be viewed 
once the layout is published to a display. 
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8 Working with PiPs

About Picture-In-Pictures (PiPs)
PiPs display the input video from a single input channel. You can input video channels to PiPs 
for display on multiviewer output display devices. Each PiP has a number of properties that 
determine how it is displayed in the layout. PiP properties are independently set; each PiP in 
a layout can have a different set of PiP properties. All properties associated with a PiP can be 
modified using the Properties pane. You can also select a PiP in the layout and use your 
mouse to resize and move a PiP in a layout as well as format groups of PiPs using the align 
and distribute commands. 

Layouts made from the Layout Creation Wizard are preconfigured with a predetermined 
number of PiPs and predefined PiP properties. 

For information about adding PiPs from the Layout Object library, see Adding Layout 
Objects to a Layout on page 103.

You can modify all PiPs, regardless of how they were created. 

Your layout must be in an unlocked state to add, move, or delete objects. You can adjust 
properties of objects on a locked layout. See Locking and Unlocking Layouts on page 90. 

The following figure illustrates the various PiP operations.
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Figure 8-1  PiP Operations

Insert a PiP into a layout using the tool palette. See Adding PiPs to a Layout on 
page 125.

Move and resize PiPs using your mouse. See Resizing and Moving Layout 
Objects Using a Mouse on page 106.

Insert a PiP into a layout using the Insert > PiP command. See Adding PiPs to a 
Layout on page 125.

Add PiPs to the Library panel. See Adding Objects to the Library Panel on 
page 61.

Copy and paste PiP properties from one PiP to one or more other PiPs. See 
Copying and Pasting Layout Object Properties on page 105.

Drag PiPs from the Layout Designer Library and drop them onto a layout. See 
Adding PiPs to a Layout on page 125.

View PiP source information by clicking on the icon in the middle of the PiP. 

Modify PiP properties using the PiP Properties pane. See Modifying PiPs Using 
the Properties Pane on page 125.
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Adding 
PiPs to a 
Layout

You can use the canvas Tool palette and the application menus to add PiPs. You can also 
drag PiPs from the Library panel, and then drop them onto the canvas. For information 
about using the Layout Designer library, see Adding Layout Objects to a Layout on 
page 103. 

PiPs added to the layout canvas have default properties. See Setting Default Layout 
Properties on page 50.

To add a PiP to your layout:

1 Select Insert > PiP.

Modifying PiPs Using the Properties Pane
Layout Designer provides a numbers of way to modify the appearance, size, and position of 
a PiP in a layout. You can use the PiP properties tab to modify a selected PiP by adjusting PiP 
property values such as width and height, and by selecting or changing the input channel 
you want the PiP to display in a layout. After completing the required modifications, you 
can copy the properties from the modified PiP, and then paste them to other PiPs in the 
same layout (see Copying and Pasting Layout Object Properties on page 105). 

To access the Properties pane:

1 Select View > Properties.

Figure 8-2  PiP Properties Pane

See the following sections for additional PiP related modifications:

 Applying Borders Using the Properties Pane on page 118

 Creating New Border Styles on page 119

 Copying and Pasting Layout Object Properties on page 105

 Resizing and Moving Layout Objects Using a Mouse on page 106

 Aligning and Distributing Objects in a Layout on page 107

This is used by NUCLEUS control 
panels to switch between video 
sources on a PiP. 
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Modifying
PiP Size and
Aspect Ratio

PiP width and height sizes do not include border size. The minimum PiP size for 4:3 and 
custom aspect ratios is 113×85 pixels. The minimum PiP size for 16:9 aspect ratio is 114×64 
pixels. Maximum PiP size depends on the video standard of the input channel. When PiPs 
are resized, the width and height proportions are constrained by the aspect ratio. When you 
select a custom aspect ratio, the width and height sizes are not constrained.

You can set the default PiP width value in the Default Preferences tab of the Layout 
Designer Preferences dialog box. For more information, see Setting Default Layout 
Properties on page 50.

To modify PiP size and aspect ratio using the Properties pane:

1 In the layout, select the PiP you want to modify, and then select the PiPs tab from the 
Properties pane.

2 Under Video/Graphics Dimensions, select the aspect ratio that you want to use from the 
Aspect Ratio list. 

Figure 8-3  Setting PiP Size and Aspect Ratio

3 To set the PiP width and height, type or select in the Width and Height boxes. 

If you selected 4:3 or 16:9 as your aspect ratio, the aspect ratio is maintained when you 
select a value for width and height.

4 (Optional) Add markers to your PiP. 

Figure 8-4  Markers on a PiP in Layout Designer

Under Cropping & Markers, you can choose the following options: 

 Aspect Ratio Markers—An indicator of correct aspect ratio on the PiP to let you know 
whether the video is properly scaled when a source that is one aspect ratio is put on a 
PiP that has a different aspect ratio. The aspect ratio marker displays the area of a 4:3 
coded frame on a 16:9 frame, or a 16:9 coded frame within a 4:3 frame. 

Click Enable to activate a marker on the PiP. To determine the color of the marker, click 
Color, make a selection, and then click OK.

 Safe Area—adds a Title Marker indicator on the PiP to indicate the safe area for titles 
to be displayed (80% of the picture area). 

Click Title Marker to activate a marker on the PiP. To determine the color of the 
marker, click Color, make a selection, and then click OK. 

Cropping marker: 
Image will be cropped 
to within this area and 
rescaled on the 
multiviewer

Marker indicators: 
Display which markers 
will appear on the PiP 
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 Active Format Description—adds an indicator that displays the AFD description 
present in the incoming video. There are two options: 

 AFD - HD and SD video 

 WSS - SD 625 video only (with this option, choose the line to read WSS data from 
in the video stream) 

To determine the color of the marker, click Color, make a selection, and then click OK. 

From the drop-down menu, there are two options: 

 Display mode— markers on the multiviewer PiP indicate the active picture area 
indicated by the AFD code or WSS code on the input.

 Convert mode—scales the video on the input source as indicated by the AFD code 
or WSS code on the input. 

The Total Width and Total Height indicators describe the size of the PiP including the border. 
See Modifying Border Properties on page 117 for more information. 

Setting PiP
Cropping

Values

You can use Layout Designer’s cropping tool to crop the top, bottom, left, and right edges 
of a selected PiP. All cropping values are in pixels. When cropping a PiP, the cropping area 
you set is indicated by a red dotted line. 

Figure 8-5  PiP Cropping Area

Be aware of the following: 

 Switching video input standards on a PiP may affect how the current cropping values 
are applied to the input video. 

 When publishing default layouts stored on the multiviewer hardware, ensure that the 
cropping area (indicated by the red dotted lines on the PiP in the window) are properly 
set.

To crop a selected PiP:

1 Under Cropping & Markers, select Cropping. 

2 Do one of the following:

 To set a uniform cropping area around the PiP, under Cropping, type or select a 
cropping width in the Pixels box, and then select the Uniform check box.

 To set different values for the top, bottom, left, and right cropping, clear the Uniform 
check box, and then type or select a cropping width in the Top, Bottom, Left, and 
Right boxes.

PiP border

Cropping area
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Selecting a
PiP’s Input

Source

Use the PiP Properties tab to modify the input source of selected PiPs. 

 Router—(Not available on HView IP)

 VNC server—The PC connected to a VNC PiP can be controlled using multiviewer 
on-screen controls. When you choose a VNC server as the source for a PiP, many of the 
PiP controls in the PiP Properties pane are disabled (for example, Cropping & Markers, 
Scope options, and CCS-P Dynamic Name Reference). See Selecting a VNC Source on 
page 128. 

 IP source—Select an input from the current IP source list. See Selecting an IP 
Source on page 129. 

Selecting a VNC Source 
1 Under Source, click VNC. 

2 Enter the IP address or host name, port number, and the password for the VNC server.

Figure 8-6  Selecting VNC Input Source

3 Click Test to validate the IP address.

 Red—The IP address is invalid.

 Grey—The IP address is valid. 

When choosing VNC PiPs, keep in mind the following: 

 If one or more VNC PiPs have an inaccessible or invalid IP address, the multiviewer will 
wait for that/those PiPs to time out before loading the rest of the VNC PiPs. 

 Some VNC servers terminate the connection after a period of inactivity. 

 Some VNC servers lose connection when a user access control pops up, or when the 
computer is locked. 

 The more frequently a VNC server’s desktop updates, the worse the appearance will be. 
A plain web browser will usually look better than a video clip. 

Figure 8-7  VNC PiP (Icon is Not Clickable) 

For best results, use UltraVNC, or another VNC server that uses server-side scaling. HView IP 
multiviewers do not support NT Logon authentication or VNC encryption. 

For information on controlling VNC PiPs, see Controlling a VNC PiP on page 192. 
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Selecting an IP Source 
1 Under Source, click IP. 

 

Figure 8-8  Selecting IP Source

2 Choose an IP source using either the URL or the an Alias from the drop-down menus. 

The URL, Alias, and Index fields update to display the information for the selected URL. 

If the item is not on the list, click IP Manager. See IP Configuration Manager on 
page 70. 

Figure 8-9  IP PiP (Icon is Not Clickable) 

Moving a PiP Using the Properties Pane
You can use the PiP Properties tab to resize/reposition PiP(s) in a layout. Using the Top 
Position and Left Position controls, you can position a PiP by setting the number of pixels 
from the top edge and left edge of the layout.

To move a PiP using the Properties pane:

1 In the layout, select the PiP you want to modify, and then select the PIPs tab from the 
Properties pane.

2 Under Position & Size, in the Left and Top boxes, type or select a new left and top 
position for the selected PiP. 

You can also use your mouse to modify PiP width, height, left position, and top position. For 
information, see Resizing and Moving Layout Objects Using a Mouse on page 106.

Test and Measurement
Test and Measurement can be used to validate the video signal or to help troubleshoot 
problems.
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After you publish a layout, you can access the Test and Measurement options by 
right-clicking within the appropriate PiP, and choosing Display Scope on the menu that 
appears. (For more information about on-screen controls, see Chapter 11, On-Screen 
Controls on page 189.) 

The options are:

 None

 Waveform

 Waveform Parade

 Line

 Line Parade

 Vector

 Quad Display

When you choose an option, the selected PiP changes to that Test and Measurement mode. 
You can run Test and Measurement on only one PiP at a time per multiviewer. If you select 
another PiP for testing, the previous PiP reverts back to its original mode. Alternatively, you 
can test different sources on the same PiP by changing the source value of the PiP. 

You can display the results in monochrome or color by right-clicking within the PiP, and then 
choosing Color Source. 

 Monochrome displays the results in black and white.

 From Video displays the results in the color of the pixel that is being sampled. If there 
are a lot of black or dark pixels in a signal, the results may be difficult to see in color 
mode.

Test and Measurement Display Modes
The following describes the Test and Measurement modes that are available under Display 
Scope. For information about changing how each mode is displayed, see Configuring the 
Test and Measurement Display Modes on page 133.

None: The Test and Measurement feature is not active.

Waveform: Displays a horizontal sweep of the Y luminance channel.
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Figure 8-10  Waveform Mode in Monochrome

Waveform Parade: Displays a horizontal sweep of the luminance and color-difference 
channels next to one another in YCbCr format.

Figure 8-11  Waveform Parade Mode in Color

Line: Displays the Y luminance component of the selected line of video.

CrY luminance Cb
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Figure 8-12  Line Mode

Line Parade: Displays the luminance and color-difference channels of the selected line of 
video next to one another in YCbCr format.

Figure 8-13  Line Parade Mode

Vector: This option is used for calibrating the chroma levels with 75% color bars.

Y luminance Cb Cr
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Figure 8-14  Vector Mode

Quad Display: Displays four Test and Measurement screens at one time. The default 
configuration is waveform and vector on the top, video display and line on the bottom.

Figure 8-15  Quad Display Mode

Configuring the Test and Measurement Display Modes
In Layout Designer, define how the different Test and Measurement display modes will 
appear on a PiP-by-PiP basis, or globally. Table 8-1 describes the options that can be 
defined, depending on which mode you selected.
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Defining Display Modes for a PiP
1 Select a PiP.

2 Select the PiPs tab of the Properties Panel.

3 In the Scope Configuration area, select a display mode from the drop-down list, and then 
click Scope Configure.

The Scope Configuration dialog box appears. Certain options are available, depending on 
which display mode you selected. See Table 8-1 on page 134.

4 Change all of the appropriate options for that display mode, and then click OK.

5 Repeat steps 3 and 4 for each mode.

Defining Display Modes Globally
When you define the options globally, you set the default values for all PiPs. However, you 
can redefine the options for individual PiPs when you create a new layout.

1 Select a PiP.

2 Select Edit > Preferences.

The Layout Designer Preferences dialog box appears.

3 Select the Default Properties tab.

4 In the PiP area, select a display mode from the Scope drop-down list, and then click 
Configure.

The Scope Configuration dialog box appears. Certain options are available, depending on 
which display mode you selected. See Table 8-1 on page 134.

Table 8-1  Test and Measurement Display Mode Options

Option Description

Color Set the default color display to From Video (color) or 
Monochrome (black and white).
If the you find that there are too many dark colors to see the 
display clearly when you view the results on the output, you 
can right-click within the PiP and select Color Source > 
Monochrome.
Note: If you change the color output when you are in Quad Display mode, all of 
the quadrants reset to that color output regardless of what default values were 
defined in Layout Designer.

Line Select which line of the active video to display for each video 
format. For interlacing formats, select a line in the Odd or Even 
range.

Pixel Range Define the range of pixels to display within a line.

Setup scope per 
quad region

For Quad Display mode, define what is displayed in each 
quadrant. The blue rectangle in each sample indicates which 
quadrant you are defining. When you click on a sample, the 
border appears yellow.
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5 Change all of the appropriate options for that display mode, and then click OK.

6 Repeat steps 4 and 5 for each mode.
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9 On-Screen Data Tools

About 
On-Screen 
Data Tools

Layout Designer provides on-screen tools that you can add to layouts to provide data, 
feedback, and other information. You can create customized audio meters, tally indicators, 
labels, and clocks for each layout.

Use Layout Designer’s on-screen data tools to monitor your system input signals and set up 
automatic responses to alarm conditions and operational events. The following figure 
illustrates Layout Designer’s on-screen data tools in a layout. 

Figure 9-1  Layout Displaying On-Screen Monitoring Tools
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Creating 
Audio 
Meters

You can associate up to 16 individual audio channels (or 8 channel pairs) to each PiP for 
audio metering purposes. Audio meters for each of these assigned channels can be 
positioned anywhere in the canvas, including superimposed on their associated PiPs. You 
can associate one group of audio meters to a PIP with IP source. The number of channels 
displayed depends on the type of audio service to be monitored (i.e., stereo or Dolby 5.1) 

Your layout must be in an unlocked state to add, move, or delete objects. You can adjust 
properties of objects on a locked layout. See Locking and Unlocking Layouts on page 90. 

Audio meters are associated with PiPs by mapping the audio source channels to a source 
PiP. You can map audio to PiPs, and change other audio meter-related properties using the 
Audio Meters tab of the Properties pane.

Creating audio meters for layouts can be divided into these tasks: 

 Mapping audio meters

 Changing the appearance of audio meters

 Changing the size and position of the audio meters.

The following illustrates the controls available from the Audio Meter tab of the Properties 
pane that are used to perform these tasks.

Figure 9-2  Audio Meter Properties

Tally indicators display the monitoring status from UMD protocol, GPI 
inputs, or alarms/rules. You can apply various colors and behaviors to each 
tally indicator individually. See Creating Tally Indicators on page 141.

Audio meters display the audio levels from embedded input sources. You 
can assign up to 16 audio meters to each PiP in a layout. See Creating 
Audio Meters on page 138.

Labels can display static or dynamic information, or display text using alarms/
rules. See About Labels on page 144.

Clocks can be either analog or digital, and can display various time zones. 
See About Layout Clocks on page 148.

Up/down counters are unidirectional. See About Up/Down Counters on 
page 152. 

1
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You can:

 Resize and move audio meters using your mouse. See Formatting Layout Objects in 
the Canvas on page 105. 

 Add audio meters to a window. For more information, see Creating Layout 
Windows on page 109.

Adding
Audio Meters

to a Layout

Audio meters that are added to a layout using the Tool palette appear as the default audio 
meter type.

To add an audio meter:

1 Select Insert > Audio Meter or Insert > 5.1 Audio Meter.

Mapping
Audio Meters

Audio mapping is the process of selecting the audio source and audio channels that you 
want to see metered on the selected PiP. Use the Audio Meters tab of the Properties pane 
to map audio channels to source PiPs. 

To map audio meters:

1 Select the audio meter that you want to map.

2 Select the Audio Meter tab on the Properties pane.

3 In the Source list, select a source that you initially associate with the selected audio meter. 

4 In the Start At Channel field, select the first audio channel of the audio source that you 
want to meter. 

You can configure info panels to indicate the audio channels that are being monitored. For 
more information, see Configuring Audio Monitoring on page 187. 

Setting Audio Meter Appearance Properties
After you have mapped the audio channels that you want to meter, set the audio meter 
appearance properties.

Audio Meter Number - Auto-assigns each audio meter an unique 
number 

DolbyE - (Unavailable with HView IP) 

Setting audio meter size and position - Use these controls to set the 
width and height of your meter and set the meters position in the layout. 
See Setting Audio Meter Size and Position on page 141.

Mapping audio meters - Use these controls to assign audio source 
channels to meters as associated meters to source PiPs. See Mapping 
Audio Meters on page 139.

Setting audio meter appearance properties - Use these controls to set 
the meter scale, color transition points, and number of channels from the 
audio source you want to meter. You can also set background and text 
color. See Setting Audio Meter Appearance Properties on page 139.

1
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Selecting Meter Scale Properties
Choose whether you want to display a scale on your audio meters and select on which side 
of the meter you want to position the scale. 

To set meter scale properties:

1 Select the Audio Meter tab on the Properties pane.

2 To show or hide the meter scales, select or clear Show Scales. 

3 If you selected Show Scales, select either Left or Right as the position of the meter’s 
scales. (This setting is not available on 5.1 audio meters.)

4 To select the number of channels you want to meter, enter a value from the Number of 
channels list. (This setting is not available on 5.1 audio meters.) 

5 To show or hide the phase meter, select or clear Show Phase Meter.

Regardless of the type of meter, phase meters appear in the lower portion of the area taken 
up by the audio meters. 

When a phase meter is enabled, the meter fully to the right side in the green zone indicates 
a phase difference of 0 degrees. The meter fully to the left side of the red zone indicates a 
phase difference of 180 degrees. A properly phased stereo pair produces a phase meter that 
moves within the green zone, and a reversed channel produces a pointer that moves within 
the red zone. 

6 To modify the opacity of the audio meter, beside Meter Bar Opacity, type or select a 
percent opacity value for the selected meter(s).

7 Do either of the following:

 To select the label text color, click Text Color. 

 To select the background color, click BG Color.

The Select Color dialog box appears.

8 Select a color value. 

9 Use the Opacity slider to adjust the color’s opacity value.

10 Click OK to save your color changes.

Setting Meter Transition Points
Each audio meter type has default red-yellow and yellow-green transition points. These 
transition points can be modified to suit your audio sources. For example, you can 
customize the transition point, in percentage of the overall meter height, of where the 
yellow portion of the meter turns to red.

To set meter color transition points:

1 Select the Audio Meter tab on the Properties pane.

2 On the Color Transition Point drop-down list, select the metering transition point style 
that you want to use.

Each transition point style in the list corresponds to a standard audio meter type.

3 Use the sliders to do either of the following: 

 Use the Green-Yellow slider to adjust the transition point, in percentage of the overall 
meter height, where the green portion of the meter turns to yellow. 
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 Use the Yellow-Red slider to adjust the transition point, in percentage of the overall 
meter height, where the yellow portion of the meter turns to red. Typically, the 
red-yellow transition corresponds with 0 dB on analog audio scales.

Setting Audio Meter Size and Position
There are four control settings that you can use to specify the size and position of the audio 
meters:

 Width

 Height

 Left Position

 Top Position

To set the audio meter size and position:

1 Select the Audio Meter tab on the Properties pane.

2 In the Size & Position area, enter the value for height in the Height field. 

The width cannot be changed. 

3 To move the selected audio meters, enter the left and top position values (in pixels) in the 
Left Position and Top Position fields. 

The Left Position value is the number of pixels from the left edge of the layout. The Top 
Position value is the number of pixels from the top edge of the layout.

You can also use your mouse to resize and move audio meters in the layout canvas. For 
more information, see Formatting Layout Objects in the Canvas on page 105. 

Creating Tally Indicators
Add on-screen tally indicators to your layout to indicate alarm conditions or other 
operational instances such as rule conditions. Use the Tally tab of the Properties pane to 
change a tally’s shape, color, and behavior during an alarm state so that you can make each 
tally’s appearance unique and easy to identify.

Your layout must be in an unlocked state to add, move, or delete objects. You can adjust 
properties of objects on a locked layout. See Locking and Unlocking Layouts on page 90. 

Adding Tally
Indicators to

a Layout

Tally indicators that are added to a layout appear in the default tally style. Once you have 
added a tally, you can change its appearance.

To add a tally indicator to a your layout:

1 Select Insert > Tally. 

Modifying Tally Indicator Properties
Each tally that you add to your layout has a set of individual properties that determine its 
appearance, its behavior, and the alarm or processing rule it indicates in the layout. 
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To view a tally’s properties, in the layout canvas, select the tally indicator that you want to 
modify, and then select the Tally tab of the Properties pane.

Figure 9-3  Tally Properties Pane

Naming the Tally Indicator
You can give your new tally indicator a unique name that identifies it in the layout when it is 
associated with GPIO devices. 

To name a tally:

1 Select a tally indicator in the layout.

2 Select the Tally tab on the Properties pane.

3 In the Properties area, type a name for the tally indicator in the Name field.

Selecting a Tally Indicator Shape
You can change the shape of a tally indicator at any time by choosing a new shape from the 
Tally Style list. 

To select a new tally indicator shape:

1 Select a tally indicator in the layout.

2 Select the Tally tab on the Properties pane.

3 In the Properties area, select a new shape from the Tally Style list.

Resizing and Moving a Tally Indicator
Use the Position & Values controls to resize and move your tally. 

To modify tally size and position:

1 Select a tally indicator in the layout.

2 Select the Tally tab on the Properties pane.

3 In the Position & Value, do either of the following:

 To resize the selected tally indicator, enter the width and height values (in pixels) in the 
Width and Height fields.

 To move the selected tally, enter the left and top position values (in pixels) in the Left 
Position and Top Position fields. 

The Left Position value is the number of pixels from the left edge of the layout. The 
Top Position value is the number of pixels from the top edge of the layout.
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You can also use your mouse to resize and move tally indicators in the layout canvas. For 
more information, see Formatting Layout Objects in the Canvas on page 105. 

Setting Tally States
You can assign different colors, behaviors, and alarm conditions to each tally indicator. 
There is one Normal state, three Alarm states (Normal, Alarm Low, Alarm Medium, and 
Alarm High), and the Tally state. You create the following settings for each state: 

To set a tally indicator state:

1 Select a tally indicator in the layout.

2 Select the Tally tab on the Properties pane.

3 In the States area, click Edit Tally Colors. 

The Layout Editor - Tally States dialog box appears.

Figure 9-4  Tally States Dialog Box

4 For each state that you want to create for the selected tally indicator, do the following: 

a From the Primary Color list, select a color for the tally indicator’s initial state.

b From the Secondary Color list, select a color or the tally indicator’s secondary state.

c From the Animation list, select a behavior for the tally.

Setting the Tally State Source 
In the Tally State Source area, there are three options: 

Primary color

The primary color represents the tally color in its primary/initial 
state. You can set the primary color to Off, Green, Yellow, 
Amber, or Red. The primary color of the Low level alarm is the 
tally color On state from an external UMD tally protocol. 

Secondary color
The secondary color represents the tally color in its secondary 
state, when it is flashing in animation mode. You can select 
from Off, Green, Yellow, Amber, and Red for secondary color.

Animation
Apply animations to create the tally behavior. You can select 
None (solid color indicator) or Flashing. 
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About 
Labels

Labels can be used to display text on your layout.Labels can be added to a layout using the 
Tool palette or by using the Insert > Label command from the application menu. 

Your layout must be in an unlocked state to add, move, or delete objects. You can adjust 
properties of objects on a locked layout. See Locking and Unlocking Layouts on page 90. 

Labels can be static, dynamic, or alarms/rules based, depending on the label’s text source. 

Scrolling properties can be added to both types of labels. On the Label tab of the Properties 
pane, you can activate and define the scrolling speed of the label text. Label text is set to 
scroll from right to left and within the defined label area, which is set using the label width 
and height properties. You can have multiple labels on a layout, each with unique 
properties. 

Table 9-1  Tally State Source Options 

Tally State Source 
Option Configuration Options

UMD/Tally System 
(Fixed UMD Addr) 

Select the UMD address that will be the 
input source for the tally. 

 When you use a either of the 
UMD/Tally System options, you 
must set the following items: 

 Tally Number–the number of 
the tally within the UMD address 
that is monitored 

 Program Number–Enter the 
correct number in this field if you 
are using Ross Protocol. If you are 
using another protocol, the data 
in this field will be ignored. 

UMD/Tally System 
(Under Monitor Display)

Select the PiP Number that will be the 
input source for the tally. 

Alarm Rule

Select this option if you want the tally indicator to be the target for an alarm, and 
then follow these steps to define the alarm source: 

1. With the tally selected in the layout, select the Alarms tab in the Properties 
pane. 

2. Following the instructions in Defining Alarms for a Layout Object on 
page 161, configure the Detectors and Actions pages of the Rules dialog 
box. 

On the Actions page, choose Set Tally Alarm State, and complete the 
Action Parameters section for that action. 
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Labels are modified on the Labels properties pane. 

Figure 9-5  Labels Properties Pane 

Each label has a unique identifier for the layout, its Label ID. The label ID cannot be 
modified. All other controls on the Labels properties pane can be edited. 

When you modify label properties, the changes only apply to the selected label(s). If you 
want to make the same property changes to multiple labels, you can use the Copy and 
Paste commands from the Layout Designer context menu. For more information, see 
Copying and Pasting Layout Object Properties on page 105.

Setting the
Label Text

Source

Figure 9-6  Label Text Source Options

If your label is a dynamic label, do not type text in the label area. 

Table 9-2  Label Text Source Options 

Label Text 
Source Configuration 

Static Text When a label’s source is static, default text appears in the label area. 
To edit static label text: 

1. In the layout canvas, double-click the label you want to modify.

2. Hold down your left mouse button, and then select the default (or 
previously entered) label text.

3. Type your new label text into the label area.

Alarm Rule If your label is connected to an alarm or rule, it will be triggered at a 
specific event. 

Program Name If your label is connected to an IP source, it derives its name from the 
metadata associated with that sources. 
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Modifying Label Appearance Properties
Label appearance properties can be applied to static and dynamic labels. You can select 
multiple labels, and then apply the same appearance properties changes to the selected 
labels.

To modify label text properties:

1 In the layout canvas, select label(s) you want to modify. 

To select multiple labels, hold down the CTRL key as you select each label.

2 On the Properties pane, click the Labels tab. 

3 Under Appearance, select a font for your label text from the Font drop-down list.

Figure 9-7  Modifying Label Text Properties

4 Beside the  icon, select a font size from the drop-down list. 

Database Source 
Name

 With router sources (not available with HView IP), the label 
updates the source from the router database that is associated 
with the specified PiP number or Audio Source Number (as 
chosen from the drop-down menu). If a switch on the router 
causes a change in the PiP input source, the label associated with 
the PiP source will follow. You can track one of the following 
router source names Logical, Source, Long Name, or Alias. 

 With IP sources, select Static to display the URL Or Alias to display 
the Alias of a IP source. The Logical and Long Name options will 
not display a label. 

UMD/Tally System 
(Fixed UMD) 
(UMD addr) 

Select a UMD address for the label. 

UMD/Tally System 
(Source UMD***) 
(PiP Num) 

Select the PiP number of the input source for the label. 

External Update 
(External Number) 

Not available for HView IP. 

RSS Update 
Interval (Min.) 

Uses an RSS feed as the source for the label text. Enter the URL to 
receive data from, and the frequency with which you would like the 
label to check for updates. 

Scoreboard Choose Basketball or Football, and then option from the 
drop-down menu. Options are described in Using the Scoreboard 
Option on page 183. 

Table 9-2  Label Text Source Options (Continued)

Label Text 
Source Configuration 
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5 To select the label text color, click the  icon to open the Select a Color dialog box. 

6 To select a color, do one of the following:

 Use the slider to select a color. 

 Enter the color values you want to use in one of the ScRGB, sRGB, or Hexadecimal 
Notation fields.

Your selected color is previewed below Selected Color. If required, use the Opacity slider 
to adjust the color’s opacity value. 

For more information on completing the Color Selector dialog box, see Setting Default 
Window Properties on page 55. 

7 Beside Justify, select the justification style for your label text from the drop-down list.

8 (Optional) Click Fit to Text to set the label size to the total width of the text contained in 
the label area. 

9 To select the label background color, click the  icon to open the Select a Color 
dialog box. For more information on completing the Color Selector dialog box, see Setting 
Default Window Properties on page 55.

Modifying Label Size and Position Properties
You can select multiple labels, and apply the same size and position properties to the 
selected labels. You can also use your mouse to move and re-size labels in the layout canvas. 
For more information, see Resizing and Moving Layout Objects Using a Mouse on 
page 106.

To modify the label size and position properties 

1 Under Size & Position, select or type values for label width and height in the Width and 
Height fields. 

Figure 9-8  Modifying Label Size and Position Properties

The displayed Total Width and Total Height values include the label width and height as 
well as the label’s border width.

2 To set the label position, select or type values in the Left and Top fields. 

The Left value is the number of pixels from the left edge of the canvas, and Top is the value 
is the number of pixels from the top edge of the canvas. 

You can also drag and move the label on the canvas. The position indicators will update as 
you do this. 
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Activating and Modifying Scrolling Properties
You can activate scrolling properties on static and dynamic labels. You can set the speed the 
label text scrolls from left to right in the area defined by the label Width property. You can 
select multiple labels, and then apply the same scrolling properties to the selected labels.

To enable and set label scrolling properties:

1 Under Scrolling Content, to enabling scrolling of label text, select Allow Scrolling.

Figure 9-9  Setting Label Scrolling Properties

2 Beside Speed select or type a speed value (in seconds) for scrolling speed. 

A value of 1 provides the slowest and 10 the fastest scrolling speed.

3 If you want the label text to pause during scrolling, select the Pause check box, and then 
select or type the duration of the pause (in seconds). 

The pause will occur before the scroll repeats itself. 

About 
Layout 
Clocks

You can add clocks to a layout as layout objects, and then define how the time and date 
information is displayed. Clocks are driven by  an internal software time source. There are 
several styles and formats of digital and analog clocks. There is no restriction on the number 
of clocks that you can add to a layout, but clocks have minimum size properties (135×135 
pixels for analog and 160×40 for digital). 

Your layout must be in an unlocked state to add, move, or delete objects. You can adjust 
properties of objects on a locked layout. See Locking and Unlocking Layouts on page 90. 

Clock properties, such as time zone settings, size, and position, are modified on the Clock 
tab of the Properties pane. You can also use your mouse to resize and move clocks in the 
layout canvas. For more information, see Formatting Layout Objects in the Canvas on 
page 105. 

Adding
Clocks to a

Layout

To add a clock to your layout:

1 Do one of the following:

 To add an analog clock, from the Tool palette, click the  icon.

 To add a digital clock, from the Tool palette, click the  icon.

Use the Analog Clock and Digital Clock tabs of the Properties pane to change the clock 
style, resize and move the clock, and set clock time properties. For more information see 
Modifying Clock Properties on page 149. 
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Modifying
Clock

Properties

Each clock in a layout has a set of individual properties that determine the appearance, size 
and position, and time properties such as its time reference source and time zone settings. 
You can display clocks that show time from different time zones in the same layout. Some 
clock properties, such as Time and Offset and Size & Position properties, are set the 
same way for both analog and digital clocks. 

To view a clock’s properties, select the clock you want to modify, and then click the Analog 
Clock or Digital Clock tab of the Properties pane. 

Setting Analog Clock Format
After you have added an analog clock to a layout, you can change the clock’s appearance 
and motion type by selecting a new clock style from the Format section of the Analog 
Clock properties tab.

Table 9-3 displays the different clock style types that you can choose from the Format list.

Table 9-3  Analog Clock Formats 

Clock Format Style Clock Format Style

Format 1 
(default format)

Format 6

Format 2 Format 7

Format 3 Format 8

Format 4 Format 9

Format 5 Format 10 
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To set the selected clock’s format:

1 Under Format, select a clock style. 

2 Under Type, select Analog or Hybrid. 

Hybrid adds a digital clock on the analog clock’s face. 

3 To change the clock’s motion setting, from the Motion list, select one of the following: 

 Sweep—Select this option for a sweep clock hand motion.

 Quartz—Select this option for a clock hand motion that pulses in one-second intervals. 

 Rolex—Select this option for a smooth clock hand motion

 Harris—Select this option for a sweep-stop (in one second intervals) clock hand motion

Setting Digital Clock Format
1 Under Format, select a clock layout from the list.

Figure 9-10  Digital Clock Options 

2 To customize your selected clock format, make the following selections:

 12 or 24 - Sets the clock display to 12 hour format

 AM/PM - Indicates PM or AM in the clock display (does not apply to 24-hour clocks)

 Show Seconds - Displays the second count in the clock display

 Show Date - Displays the date in the clock display (select a date format from the 
drop-down list)

 Show Week - Displays the days of the week in the clock display

Customizing Digital Clock Appearance Properties
You can change a digital clock’s text font and color. Analog clock appearances cannot be 
customized. 

To customize the appearance of your digital clock:

1 Under Time Font, select a font that will be used for the time (mostly number) text. 

2 Under Date Font, select a font that will be used for the date (mostly alphabet, usually 
smaller) text. 

3 Choose the colors for each of the following areas on the digital clock: 

 Time Color - The numeric time text in the clock display

 Date Color - The rest of the text on the screen, excluding the day of the week if you 
have chosen the Show Week display
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 Active Date - The current day if you have chosen the Show Week display

 Background - The area inside the border of the digital clock display

Setting Clock Time Reference Source and Time Zone
You can use either an internal or an external time reference source, such as NTP, to drive 
your on-screen clocks. The controls and method used to set the time reference source is the 
same for analog and digital clocks. Each clock in a layout can be configured with a different 
time reference source. 

Figure 9-11  Time and Reference Portion of Clock Property Pane 

To set the clock time reference source:

1 Do either of the following: 

 Configure NTP - See Configuring Network Time Protocol (NTP) on page 68. 

 Under Time and Offset, select one of the following:

 Internal - Select this option to use the multiviewer’s internal time as a reference 
source for the selected clock. 

Select an appropriate time zone from the Time Zone Offset drop-down list. 

To configure Network Time Protocol, see Configuring Network Time Protocol 
(NTP) on page 68. 

 External LTC - (Not available for HView IP) See HView IP Hardware on page 5 for 
more information on setting up the type of external LTC format WITH HView IP.

 VITC - (Not available for HView IP)

Resizing and Moving Clocks
The controls for resizing and moving analog and digital clocks are the same. 

To resize and move the selected clock:

1 Under Size & Position, type or select values for the width and height in the Width and 
Height fields.

2 To move the selected clock, type or select left and top position values (in pixels) in the Left 
Position and Top Position fields. 

The Left Position value is the number of pixels from the left edge of the layout. The Top 
Position value is the number of pixels from the top edge of the layout.

You can also use your mouse to resize and move clocks in the layout canvas. For more 
information, see Formatting Layout Objects in the Canvas on page 105. 
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About Up/
Down 
Counters

The up/down counter displays time on your Layout, with accuracy down to a second. You 
can use a counter as an alarm detector to trigger other events when it completes its count 
down or count up, or when the counter hits a blink or alert point (see Defining Alarms for 
a Layout Object on page 161 for more information). When the end time is reached on 
that particular counter, an event is triggered. The counter can be the recipient of an alarm 
action, which can reset, start, or stop the counter. 

During normal operation the timer behaves as follows:

1 The counter starts, counting up or down with green font.

2 When it reaches a pre-defined alert time, the counter’s font turns red. 

3 When it reaches a pre-defined blink time, the font remains red but then the red down arrow 
(or up arrow for a count down timer) turns off and on at .5s intervals for the remainder of 
the count time. 

4 When the counter reaches a pre-defined end time (time has expired), the timer remains at 
the last time value (00:00:00 for a down timer) with a red font until it is reset or a new timer 
session is started.

Adding
Counters to a

Layout

To add a Counter to your layout:

1 Do one of the following:

 From the Tool palette, click the  icon.

 From the main menu, select Insert > Up/Down Counter. 

Use the Up/Down Counter tab of the Properties pane to change the properties. For more 
information see Modifying Counter Properties on page 152. 

Modifying
Counter

Properties

Each counter in a layout has a set of individual properties that determine the appearance, 
size, position, and time properties. Each counter has a unique counter number. You can 
configure four different times per counter. 

Figure 9-12  Up/Down Counter Properties Pane

Naming the Counter
A counter’s unique name identifies it in the layout. This is the name the counter is identified 
by when creating alarm detectors and actions. 
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To name a counter:

1 Select a counter in the layout.

2 Select the Counter tab on the Properties pane.

3 In the Properties area, type a name for the counter in the Name field.

Modifying Counter Size and Position Properties
You can select multiple counters, and apply the same size and position properties to the 
selected counters. You can also use your mouse to move and re-size counters in the layout 
canvas. For more information, see Resizing and Moving Layout Objects Using a 
Mouse on page 106.

To modify the counter size and position properties 

1 Under Size, Position & Opacity, select or type values for counter width and height in the 
Width and Height fields. 

Figure 9-13  Modifying Counter Size, Position, and Opacity Properties

The displayed Total Width and Total Height values include the counter width and height 
as well as the counter’s border width.

2 To set the counter position, select or type values in the Left and Top fields. 

The Left value is the number of pixels from the left edge of the canvas, and Top is the value 
is the number of pixels from the top edge of the canvas. 

You can also drag and move the counter on the canvas. The position indicators will update 
as you do this. 

3 Drag the Opacity slider to the right to make the counter more transparent, or left to make 
the counter more solid. 

Choosing a Counter Style
Click an option in the Styles section of the Up/Down Counter Properties pane to choose a 
counter appearance. 

Configuring Counter Functionality
1 Select the counter’s source. 

 Internal - calibrates the counter rate from the multiviewer’s internal time. 

 External LTC - (Not available for HView IP) 

 External Serial—calibrates the counter rate from the serial input. 

2 Select a counter direction. 

 Up (incremental) - the counter increases in value as it counts. 
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 Down (decremental) - The counter decreases in value as it counts. 

The counter indicates its direction in the layout with an up arrow or a down arrow. 

3 Configure times as follows: 

 Beside Start Time, enter the initial value that is displayed by the counter.

 Beside Stop Time, enter a final value to be displayed by the counter. 

 When used as a detector to trigger a rule, the stop time will trigger the rule to fire. 
After firing the time is displayed as red. 

 Beside Alert Time, enter the time when the text on the counter will change from green 
to red (prior to the countdown completing). 

 Beside Blink Time, enter the time when the direction indicator will begin to blink. 

The maximum number of hours is 99, and the maximum number of minutes and seconds 
are 59. 

Manually
Controlling a

Counter

When a layout is uploaded to a HView IP multiviewer, you can operate the counter from 
Layout Designer, an onscreen menu that is accessible via the mouse through onscreen menu 
interactions. 

To control the counter from Layout Designer 

1 If Layout Designer does not have control of the multiviewer, click Enable Control. 

2 Select a counter in the layout.

3 Select the Counter tab on the Properties pane.

4 Use the following controls: 

Start - updates the counter to proceed with the linear countdown 

Stop - stops and reports the current countdown time until further notice 

Reset - re-initializes the counter using the original start, stop, blink, and alert times. Any 
rules that were active in the layout will still trigger the counter the same way as before. 

In the Rules engine, the counter can act as an alarm by configuring a rule to fire on a Stop 
Counter event, when the counter reaches its end time. See Defining Alarms for a Layout 
Object on page 161. The counter can act as a target through the Reset Counter, Start 
Counter, and Stop Counter actions. See Setting Alarm Actions on page 166. 

Controlling a Counter Using SNMP or CCS (Navigator or NUCLEUS) 
The time parameter is global and updates every published timer. Neither CCS nor SNMP is 
aware of any of the published timers. The only link is through virtual triggers set up with 
alarms in the layout.

To start a timer 

1 Set the Initial Counter Time parameter. 

The time does not update the counter until a start is triggered. When you set the duration, 
there is no visual feedback on the display.   It retains the original setting of the published 
layout.

2 Set the trigger that starts the specific counter. 

When you start the countdown timer, the display updates to the value set using SNMP or 
CCS and starts to decrement or increment. 
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If the time is not set to zero, any time a start occurs, the counter uses the time as set by CCS 
Navigator, NUCLEUS, or SNMP.
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10 Alarms and Info Panels

About 
Monitoring 
Tools

Use Layout Designer’s on-screen monitoring tools to monitor your system input signals and 
set up automatic responses to alarm conditions and operational events. The following figure 
illustrates Layout Designer’s on-screen monitoring tools in a layout. 

Figure 10-1  Layout Displaying On-Screen Monitoring Tools
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Other alarm monitoring options include: 

 E-mails 

 Log entries 

 Text messages 

 Changes to the PiP, such as making it full-screen or switching it to display a waveform 

Alarms can be assigned to an item within a layout, to a layout, or globally, to the 
multiviewer device itself. 

Using the
Rules Menu

As part of the Layout Designer application toolbar, the Rules menu provides the following 
options: 

 Global Alarms -Opens the Global Alarms Editor so you can review and configure 
alarms that are device-specific and will stay active when triggered even when the layout 
changes. See Configuring Global Alarms on page 172. 

 Global Events - Opens the Events Editor so you can review and configure events that 
trigger actions and are device-specific, and will stay active when triggered even when 
the layout changes. See Configuring Layout Events and Global Events on 
page 175. 

 Enable/Disable Global Event - Lists a sub-menu of all global events, so that you can 
select a specific event to enable or disable. 

 Enable/Disable All Global Events - Provides a list of two options that affect all 
defined global events: Enable or Disable. 

 Layout Events - Opens the Events Editor so you can review and configure events for 
a specific layout. 

 Clear Layout Alarms - Deletes all alarms for a specific layout. 

 Component [Component’s name] Alarms - Opens the Rules Editor so you can 
review and configure alarms assigned to the selected item. Defining Alarms for a 
Layout Object on page 161. 

 Clear Component [Component’s name] Alarms - Deletes all alarms assigned to the 
selected item. 

Global and Layout alarms and events are only available when Layout Designer is connected 
to an HView IP Multiviewer. 

Tally indicators can display alarm conditions if configured to do so. See 
Creating Tally Indicators on page 141.

Borders (on PiPs and windows) can display three different alarm states and a 
tally state, in addition to their normal state. See Modifying Border 
Properties on page 117.

Dynamic labels can be configured to display specific text based on various 
alarm conditions. For more information, see About Layout Clocks on 
page 148.

Info Panels can include alarms. For more information, see Creating Info 
Panels on page 177.

Up/Down Counters can trigger and be the target of alarms. For more 
information, see About Up/Down Counters on page 152.

1
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Using the Alarms Property Pane
If you can assign alarm detectors to an object in a layout, when you select that object and 
then go to the alarms tab of the Properties panel, you can view the alarms assigned to that 
object. Each alarm consists of two parts: 

 Detectors - Conditions that trigger the alarm 

 Actions - Notifications that an alarm condition exists 

Alarms are defined on the Alarms tab of the Properties pane. 

Figure 10-2  Alarms Properties

There are default alarms that you can activate and modify. Each alarm condition has 
detectors. When the input signals meet or exceed threshold values of the detector, the 
alarm actions are triggered.

Each alarm is described below in Table 10-1.

 

1 2 43

Alarms lists each sub-item that make up the selected object (including PiPs, 
counters, info panels, etc.). Sub-entries list the alarms applied to each 
specific object. See Defining Alarms for a Layout Object on page 161. 

Data field updates when you select an item in the Alarms field, so you can 
edit thresholds and conditions for the selected alarm or alarm detector. See 
Setting Alarm Detector Threshold Values on page 164. 

Actions List displays the actions that will occur when the selected alarm is 
triggered. 

 Roll the mouse over an action to view tooltips showing details of action 
parameters. 

 Right click for Edit/Add Action, Remove Action, and Remove All 
Actions options. 

For more information, see Setting Alarm Actions on page 166. 

Available Alarm Templates allows you to manage your alarm templates 
and apply them to the selected layout object. See Alarm Templates on 
page 168. 

Table 10-1  Alarm Detectors 

Detector Description

Video 

Format Change (Not available for HView IP)

SD EDH Error (Not available for HView IP)

HD CRC Error (Not available for HView IP)

1

2

3

4
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Loss of Video Indicates that the multiviewer hardware can no 
longer detect a video signal from the video channel

Video Freeze Indicates that the input video image is frozen (static) 
according to user-defined frozen picture delay 
(duration), percent of frozen video in the frame, and 
amount difference between pixels percent tolerance 

Video Black Indicates that the input video image is considered a 
black picture according to user-defined percentage 
non-black picture, delay (duration), and black level 
threshold values

Audio

Audio Channel Missing Indicates that the audio channel is not present in the 
signal

Audio Channel Peak Indicates that the input audio level of the audio 
channel is at or above the set upper threshold dB 
values for the user-defined period of time

Audio Channel Low Indicates that the input audio level of the audio 
channel is at or below the set lower threshold dB 
values for the user-defined period of time 

Audio Channel Silence Indicates that the input audio level of the audio 
channel is at or below the set silence threshold dB 
value for the user-defined period of time

Audio Group (1–4) Missing (Not available for HView IP) 

Audio Format Change (Not available for HView IP) 

Dolby E Program Change (Not available for HView IP) 

Timelines

Counter Alert Indicates that the specified counter has achieved its 
predefined alert time

Counter Blink Indicates that the specified counter has achieved its 
predefined blink time 

Counter End Indicates that the specified counter has achieved its 
end time (this is when the counter stops) 

Miscellaneous

GPI Indicates that a GPI input has been triggered

Specific Crosspoint (Not available for HView IP)

Specific Source (Not available for HView IP)

SNMP Virtual GPI Indicates that a GPI trigger has been received 
through SNMP 

Table 10-1  Alarm Detectors (Continued)

Detector Description
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For information about setting alarm threshold values, see Setting Alarm Detector 
Threshold Values on page 164. 

For information about setting video alarms, see Defining Alarms for a Layout Object on 
page 161. 

Any changes you make to an alarm setup will not appear on the multiviewer until the layout 
is published.

Defining Alarms for a Layout Object
1 Select the appropriate layout object. 

Objects that can take alarms include: 

 Info panels

 PiPs

 Tallies

 Windows

 Up/Down Counters

2 In the toolbar, click Rules, and then click [Component] Alarms (where [Component] is the 
selected object). 

Global

Any Alarm Triggered Indicates that any alarm connected to any other 
alarm has been triggered

Any Audio Alarm Triggered Indicates that any of the alarms in the Audio section 
of the list (above) have been triggered 

Any Video Alarm Triggered Indicates that any of the alarms in the Video section 
of the list (above) have been triggered

Table 10-1  Alarm Detectors (Continued)

Detector Description



Chapter 10
Alarms and Info Panels

162

Copyright ©2011, Harris Corporation

The Rules Editor dialog box opens with the Select Detectors panel displayed. 

Figure 10-3  Selecting Alarm Detectors on the Rules Dialog Box

3 In the Alarm Name field, enter a meaningful name that describes the alarm condition.

4 Select an operator, either And or Or, and then click Add. 

 When And is selected, all conditions must be met to trigger an alarm. 

 When Or is selected, only one of the conditions must be met to trigger the alarm. 

The alarm appears in the alarms table. 

5 In the Detectors list, place a check beside each alarm detector you want to have on this 
layout object. 

The drop-down menu at the top of the Detectors list has three viewing options. All 
expanded view shows all available alarms. All collapsed view shows only the folders 
that the alarms are nested in. Selected view shows only the alarms that have been 
selected. You cannot view unselected alarms in this view, so you can remove alarms but not 
add them to the rule. 

Each detector is added with default thresholds and settings. Click on the text of a detector 
to view its threshold values. 

6 To adjust the threshold values for a detector, do one of the following: 

 Click in the value column and then type the new value for the threshold. 

 Drag the slider right and left to increase and decrease the threshold value. 

 Click the incremental step buttons to increase or decrease the threshold value. 

See Setting Alarm Detector Threshold Values on page 164 for more information. 

7 Click Select Actions. 

Delete selected 
alarm from list
Click to configure 
alarm actions

Configure threshold 
settings for selected 
detector
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The Rules Editor dialog box displays its Select Actions panel. 

Figure 10-4  Select Actions Panel of Rules Editor Dialog Box

8 Click on an alarm in the Alarms column. 

9 From the Actions list, choose one or more actions from the left panel and click > to move it 
to the right panel. 

If a target is not available for the alarm action (for example, if you have chosen Counter 
Reset as your action and there is not a counter in the layout), you will see an error message. 

To remove an item from the Select Actions list, click <. 

You can move the selected item up in the list by clicking Up, or down in the list by clicking 
Down. Alarm actions will be executed in the order they appear on the list. 

When an item is highlighted in the Selected Actions list, you can configure it by 
completing the Action Parameters specific to that action. 

10 Click OK to close the Rules Editor dialog box. 

The Alarms field of the Alarms properties tab lists the alarms you have created. You can 
view the individual detectors that make up an alarm by clicking +, or hide them by clicking 
-. 

Click on an alarm in the Alarms field to view and/or edit that alarm’s name and operator in 
the space directly to the right of the Alarms list, and to view a list of actions for that alarm 
in the Actions field. 

Click a detector in the Alarms field to adjust the thresholds and settings for that detector. 

Selected 
actions

Click to 
return to the 
Detectors 
section of the 
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Setting Alarm Detector Threshold Values
Alarm threshold values determine the point at which an input is in error and an alarm is 
triggered. On the Alarms tab of the Properties pane, you can set the threshold values for 
each detector used by the multiviewer to determine when an alarm condition exists. 

The following describes each threshold value. The threshold value varies for each detector. 

Table 10-2  Alarm Threshold Values 

Threshold 
value Definition Range Default

Source Source number or PiP ID of the 
monitored source signal 

Range is 0–512 if Source number was 
selected; text otherwise 

(string) 

HD Source The HD CC source Service (1-7)
CC (1-4) 
T (1-4) 

SD Source The SD CC source CC (1-4) 
T (1-4) 

Service Option The SD CC, V-Chip, VITC, WSS, 
AFD, or Teletext line 

Line (6-23) 

Channel Audio stream that is monitored for 
this alarm 

Channel 1–Channel 16 1 - 4 enabled

Delay (sec) Duration (in seconds) that the 
threshold(s) on an alarm can be 
met or exceeded in order to 
trigger the alarm condition 

0–60 10

% Frame Frozen Percent of frozen video within a 
video frame that will trigger an 
alarm 

0–100 97

% Frame Black Percentage of the video picture 
that must be black for the picture 
to be considered a black frame

0–100 10

Tolerance (%) Amount of difference between 
pixels at which a picture is 
considered to be frozen 

0–25 10

Tolerance mV Level at which a picture is 
considered a black picture

0–700 10

Level (dBFS) Depending on the alarm, the level 
(peak, low, or silence) at which an 
alarm condition is triggered

-100–0 Peak: -3
Low: -40
Silence: 60
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Expected 
Format

The expected format of the input signal

Video  1080i60

 1080i50

 1080psf24

 720p60

 720p50

 SD525

 SD625

 1080p24

 1080p25

 1080p30

 Any format 
change

1080i60

Audio  Dolby E (Not 
available for 
HView IP) 

 Dolby D

 PCM

 Any format 
change

PCM

WSS  Full Frame 4:3 

 14:9 Center

 14:9 Top

 16:9 Center

 16:9 Top 

  > 16:9

 Full Alt 14:9 

 16:9 
Anamorphic

 Any Format 
Change

Full Frame 4:3

AFD  > 16:9

 Full Frame

 4:3 Center 

 16:9 Protected

 14:9 Center 

 4:3 Alt 14:9

 16:9 Alt 14:9

 16:9 Alt 4:3

 Any Format 
Change

Full Frame 

DolbyE Pairs (Not available for HView IP) 

Audio Pairs Selects the audio pair to be 
monitored

 1/2

 3/4

 5/6

 7/8

 9/10

 11/12

 13/14

 15/16 

1/2

Expected 
Program

(Not available for HView IP)  

Table 10-2  Alarm Threshold Values (Continued)

Threshold 
value Definition Range Default
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Setting
Alarm

Actions

Alarm actions are used in the Rules Editor and the Trigger Configuration dialog box.  

Rating Determines the VChip option that 
is expected 

 G

 PG

 PG-13 

 R

 NC-17

 X

 TV-Y

 TV-Y7

 TV-G 

 TV-PG

 TV-14

 TV-MA

 E

 C

 C8+

 14+

 18+

 8 ans + 

 13 ans +

 16 ans + 

 18 ans + 

Page Determines the Teletext page that 
is expected to be displayed 
Note: the default is for OP-47 
closed captioning. 

 0 to 999 801 

Counter Name Lists all the available counters in 
the layout

 Auto

 <all counters in layout
Auto

Table 10-2  Alarm Threshold Values (Continued)

Threshold 
value Definition Range Default

Table 10-3  Alarm Actions 

Alarm Action Purpose 

Change Layout Loads a layout. 

Change PiP Source Changes the input source of the PiP to the selected 
source. There must be a PiP in the current layout to 
choose this option. 

Change Salvo (Not available for HView IP)

Counter Reset Sets the selected counter back to its start time.

Counter Start Triggers the counter to start.

Counter Stop Stops the counter. 

Fire Global Event Activates a global event. There must be a global event in 
the multiviewer system to choose this action. See 
Configuring Layout Events and Global Events on 
page 175 for more information. 

Fire GPO Activates a GPO. 

Fire Layout Event Activates a layout event (see Configuring Layout 
Events and Global Events on page 175 for more 
information). There must be a layout event in the current 
layout to choose this action. 
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Log Message Adds a predefined message to the system log, which is 
located in the alarm section of the logging server. 
See Enabling Alarm Logging on page 69 to configure 
alarm logging. 

Make PiP Full Screen Expands the selected PiP to full-screen. There must be a 
PiP in the current layout to choose this action. 

Send Email Sends an email with pre-written text to a specific 
recipient. 

Send SMS Txt Msg Sends a text message to a phone. 

Set InfoPanel Alarm 
State

Changes an background color of alarm indicators on an 
info panel. There must be an info panel in the current 
layout to choose this action. 

Set Label Text Changes the text of a label in the layout to 
pre-configured text. There must be an Alarm/Rule 
dynamic label in the current layout (a static label in the 
layout is not sufficient). 

Set PiP Alarm State Changes a PiP’s alarm state. There must be a PiP in the 
current layout to choose this action. 

Set Tally Alarm State Changes a tally’s alarm state. There must be a tally in the 
current layout to choose this action. 

Set Window Alarm 
State

Sets the window border to a pre-defined state. There 
must be a Window in the current layout to choose this 
action. 

Show Message Box Displays a warning or an error on the screen (depending 
on your settings), and puts a pre-defined message in that 
box. 

Show Waveform 
Monitor

Switches the display on the chosen PiP to show a 
waveform. There must be a PiP in the current layout to 
choose this action. 

Table 10-4  Action Parameters 

Parameter Content

10 Digit Phone Number Type the phone number to be dialed to send the text 
message. 

Counter Selects the specific counter to use as a trigger or target 
of the action. 

Dynamic Label ID Choose the ID number of the label to send text. 

GPO Number Type the number of the GPO to activate. 

InfoPanel Choose the info panel that will display the alarm state

Layout name Type the name of the layout to load. 

Logging Priority Determines the urgency of the message; choose from 
Info, Warning, Performance, Error, Critical, or Fatal. 

Message Enter the text of the message to be sent.

Table 10-3  Alarm Actions (Continued)

Alarm Action Purpose 



Chapter 10
Alarms and Info Panels

168

Copyright ©2011, Harris Corporation

Alarm
Templates

Alarm templates are a fast way to apply the same group of alarms and detectors multiple 
times within the same layout, or within multiple layouts, without having to configure it each 
time. Once a template has been applied to a layout object, you can adjust the threshold 
values on that object specifically. 

Creating an Alarm Template
When you create an alarm template, note the following:

 Each object in a layout can have only one template applied to it. 

 A template may consist of many alarms, with many detectors.

Message Body Enter the text of the message to be sent. 

PiP Choose the PiP that will be the recipient of the action to 
from the drop-down menu. All PiPs in the current layout 
are available by name. 

PiP Source Choose the specific source from the drop-down menu. 

If the source is an IP source, you can further configure 
the source using the IP source Manager. See IP 
Configuration Manager on page 70 for more 
information. 

Priority Choose Low, Medium, or High. This affects the display 
color of tallies and info panels, and PiP and window 
alarm borders.

Recipient Address Enter an email address to send alarm notifications to. 

Show PiP Information Displays a PiP information menu on a full-screen PiP. 

Sticky Choose Yes or No. Actions that are sticky must be 
acknowledged before they disappear.

Subject Enter a subject for the email. 

Tally Choose the tally to apply the alarm to. 

Text Enter the content the label will be updated with. 

Trigger Type the number of the trigger to activate. 

Txt Msg Body Enter the text of the message to be sent. 

Type Choose from Warning or Error. When the alarm is 
triggered, the pre-determined type of box will appear on 
the screen

Window Number Choose the window to apply the alarm to. 

Wireless Carrier Choose your carrier from the drop-down menu. 
If your carrier does not appear on the list, you can enter 
a custom carrier. Choose Add custom from the bottom 
of the list. A window opens where you can type in your 
cell phone carrier's email suffix. Click OK. Your cell 
phone carrier appears at the top of the list. 

Table 10-4  Action Parameters (Continued)

Parameter Content
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 Alarms must have unique names. If you give an alarm an existing name, it will overwrite 
the previous condition.

 The source that is defined in an object overrides the source that is defined in an alarm.

 You can set default threshold settings for each detector within the template, and adjust 
those thresholds on an item-by-item basis throughout a layout. Making changes to the 
threshold values for each layout object does not change the threshold values in the 
template itself.

To create an alarm template:

1 Select the Alarms tab of the Properties pane.

2 Under Available Alarm Templates, click New. 

The Alarm Template Editor dialog box appears. 

Figure 10-5  Alarm Template Editor Dialog Box

3 In the Alarm Template Name field, enter a descriptive name for your template.

4 In the Alarm Name field, enter a meaningful name that describes the alarm condition.

5 Select an operator, either And or Or, and then click Add. 

 When And is selected, all conditions must be met to trigger an alarm. 

 When Or is selected, only one of the conditions must be met to trigger the alarm. 

The alarm appears in the alarms table. 

6 In the Detectors list, choose each alarm detector you want to have on this layout object. 
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The drop-down menu at the top of the Detectors list has three viewing options. All 
expanded view shows all available alarms. All collapsed view shows only the folders 
that the alarms are nested in. Selected view shows only the alarms that have been 
selected. You cannot view unselected alarms in this view, so you can remove alarms but not 
add them to the rule. 

Each detector is added with its default thresholds and settings. 

With HView IP, the Change Source To menu should always change the source to IP. Router 
sources are not available with HView IP. 

7 Click on the text of each detector to view its threshold values, and then, to adjust its 
threshold values, select in the value column and type a new value. 

See Setting Alarm Detector Threshold Values on page 164 for more information. 

8 Repeat steps 4–7 to add other alarms to the alarm template. 

9 Click Select Actions. 

The Alarm Template Editor dialog box displays its Select Actions panel. 

Figure 10-6  Select Actions Panel of Rules Editor Dialog Box

10 Click on an alarm in the Alarms column. 

11 From the Actions list, choose one or more actions from the left panel and click > to move it 
to the right panel. 

To remove an item from the Select Actions list, click <. 

You can move the selected item up in the list by clicking Up, or down in the list by clicking 
Down. Alarm actions are executed in the order they appear on the list. 

When an item is highlighted in the Selected Actions list, you can configure it by 
completing the Action Parameters specific to that action. 

Selected 
actions
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12 Click OK to close the Rules Editor dialog box. 

13 Click OK to save the new template. 

The Alarm Template Editor dialog box closes. The new alarm template appears in the 
Available Alarm Templates list. 

Editing Alarm Templates
1 To edit an alarm template, select it in the Available Alarm Templates list, and then click 

Edit. 

The Alarm Template Editor dialog box appears.

2 Do any of the following:

 Change the name of the template.

 Select an existing detector in the Template Alarms list, and then change any attribute 
of that detector. 

 Add or remove detectors. 

 Select an existing action in the Template Actions list, and then change any attribute of 
that action. 

 Add or remove actions on the Actions page. 

3 Click OK to save your changes.

Applying an Alarm Template to a Layout Object
1 Select the layout object to which you want to apply alarm template.

You can select more than one object by holding down the CTRL key on the keyboard and 
clicking on each object that you want to include.

2 Select the Alarms tab on the Properties pane. 

3 Select the appropriate template from the Available Alarm Templates list. 

Click the + to expand each template to view the specific alarm conditions that are included 
in the template. 

4 Do either of the following:

 If you selected one layout object, click Apply to Selected.

 If you selected more than one layout object, click Apply to All. 

If objects already have alarms assigned to them when you apply an alarm template, the 
previously assigned alarm template is replaced. 

You can only apply entire templates to an object; however, you can remove any conditions 
once the template is applied.

5 In the Alarms list, you can:

 Select an alarm to view the specific detectors that are included. In the area to the right 
of the Alarms list, you can change the alarm name and operator between detectors. 

 Select a detector and view or change its threshold values. 

 Add conditions and detectors.

 Remove conditions and detectors (right click and choose Remove or Remove All). 

 View alarm actions. 

 Test alarm actions. 

 Add the alarm to the Available Alarm Templates list (this is a right-click option). 
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For more information about alarms and detectors, see Defining Alarms for a Layout 
Object on page 161.

Testing an
Alarm

After a layout is published, you can test alarms by simulating a failed alarm.

1 Select the alarm that you want to test.

Make sure that you select the alarm and not the detector.

2 Click and hold down the Test Alarm button.

The alarm response appears on the published layout object as long as you hold the Test 
Alarm button down. 

Testing an
Action

After a layout is published, you can test alarm actions.

1 Select the alarm that you want to test.

2 Select the action you want to test. 

Make sure that you select the alarm and not the detector.

3 Click and hold down the Test Action button.

The alarm response appears on the published layout object as long as you hold the Test 
Action button down. 

Configuring Global Alarms
Global alarms allow a GPI or periodic trigger to cause an action that is not specific to any 
particular layout, and therefore stays present even when the multiviewer’s layout is 
changed. Layout Designer must be connected to a multiviewer to configure and view global 
alarms. 

Global alarms are only available when Layout Designer is connected to an HView IP 
Multiviewer. 

To configure global alarms, from the toolbar select Rules > Global Alarms. 
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This dialog box opens: 

Figure 10-7  Global Alarm Detectors Dialog box

At any time, you can disable or enable an alarm, or delete the alarm from the system, using 
the buttons in the bottom left corner of the screen. 

To create an alarm: 

1 Enter a name in the Alarm Name field, and then choose Or or And, and click Add. 

The alarm name appears in the Alarm Name listing. 

2 Choose at least one alarm detector, and define the settings for that detector. 

Table 10-5  Available Detectors for Global Alarms

Detector Configurable Settings

GPI Input number – The input on which the GPI is 
connected 
Delay – Time between the GPI data being received 
and the action being triggered 

SNMP Virtual GPI
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3 Click Select Actions. 

Figure 10-8  Global Alarm Actions Dialog Box

4 Select at least one action to be triggered on this detector. 

Table 10-6  Global Alarm Actions 

Action Description Setting Options 

Change layout Switches the active layout on the 
multiviewer, while keeping any 
other alarms active. 

Layout Name - Select the layout to change to. 

Change Salvo (Not available for HView IP)

Fire GPO Activates a GPO. GPO number - Choose the GPO that is activated 

Log Message Adds a predefined message to the 
system log, which is located in the 
alarm section of the logging 
server. 
See Enabling Alarm Logging on 
page 69 to configure alarm 
logging. 

Message - a predefined message that is sent to the 
system log in the alarm section of the logging server 
Logging Priority - the level of the alarm -- info, 
warning, performance, error, critical, or fatal 
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5 Click OK to save the alarm and close the Global Alarms dialog box. 

By default all global alarms are activated. 

Configuring Layout Events and Global Events
Layout events and global events are not necessarily associated with an alarm action. 

 A layout event is configured per layout. When it is created, it is available to the current 
layout only. 

 A global event is configured per multiviewer. It is available to all layouts on the 
multiviewer. 

Global and layout events are only available when Layout Designer is connected to an HView 
IP  Multiviewer. 

Creating an event: 

1 From the toolbar, choose Rules > Layout Events or Rules > Global Events. 

Send email Sends an Email with pre-written 
text to a specific recipient. 

Recipient Address - email address that will receive a 
pre-defined email at this trigger 
Subject - Title of the mail to be sent
Message Body - contents of the email to be sent

Send SMS Txt Msg Sends a text message to a phone. 10 digit phone number - Phone that will receive 
automated text message at this trigger 
Wireless Carrier - Cell phone carrier’s email address 
suffix 
Txt Msg Body - Contents of the text message to be 
sent 

Show Message Box Displays a warning or an error on 
the screen (depending on your 
settings), and puts a pre-defined 
message in that box. This message 
remains on the screen regardless 
of whether the layout changes. 

Message - Contents of the message that will appear 
on a display at this trigger 
Type - Error or warning 
Display Number - The display that will receive the 
error or warning message 

Table 10-6  Global Alarm Actions (Continued)

Action Description Setting Options 
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An Event Configuration dialog box opens. 

Figure 10-9  Events Configuration Dialog Box

You can also open the Layout Event Configuration dialog box from the Layout property 
pane. 

2 Enter a descriptive title for the event in the Event Name field, and then choose either 
Non-Scheduled or Scheduled.

You can use a Non-scheduled event as an action triggered by an event in an alarm. 

Scheduled events can be configured to fire one time only or on a periodic basis. 

3 Click Add. 

The new event is added as a new row in the Layout Events or Global Events table. 

4 Add the remaining necessary data in the new event’s row in the Layout Events or Global 
Events table. 

Depending on the type of event, the following data may be necessary: 

 If your event is non-scheduled, no more data is necessary in the Layout Events section 
of the screen. 

 If your event is scheduled and one-time, enter a date and time for the event to 
commence in the Layout Events table. 

 If your event is scheduled and periodic, in addition to a start date and start time, enter 
an end date and an end time, and choose the days of the week for the event to take 
place on. 

Scheduled, 
one-time only 
event
Scheduled, 
periodic event
Non-scheduled 
event
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For scheduled events, beside Time Zone Offset, choose the time zone the change will take 
place in. 

5 To add actions that will be triggered by the selected event, click on an action in the left field, 
and then click > to add actions to the event. 

You can remove actions from the list on the right by clicking <. 

If your event is a global event, in addition to the actions listed in Global Alarm Actions on 
page 174, the Cycling Layouts action is available. For this action, select the names of the 
layouts you want to include in the cycle. Select these layouts in the order you want them to 
appear. Selected items in the sequence display a number to indicate their position in the 
sequence. Also select the number of the display the layout will be cycled on. 

If your event is a layout event, the action list contains all the alarms in Alarm Actions on 
page 166, except for the Set InfoPanel Alarm State action. 

6 Complete the Action Parameters section for each action added. 

See Setting Alarm Actions on page 166 for information on all the actions and their 
parameters. 

7 Click OK to save the events and close the Layout Event Configuration dialog box. 

Deleting
Events

Deleting a Single Event 

1 In the Events Configuration screen, select the row in the Layout Events table that 
represents the event you want to delete. 

2 Click Remove an Event. 

Deleting All Events from a Layout

1 In the Events Configuration screen, click Remove all Events. 

Creating 
Info Panels

Add info panels to your layout to display data and/or alarms. Use the Info Panel tab of the 
Properties pane to define the data and the data source that will be provided on the info 
panel. 

Your layout must be in an unlocked state to add, move, or delete info panels. You can 
adjust properties of an info panel in a locked layout. See Locking and Unlocking 
Layouts on page 90. 

Info panels can be added to the Info Panels tab of the Library panel if they are 
free-standing. If an info panel is attached to a PiP or a window and that PiP or window is 
added to the Library panel, the info panel is added as part of that layout object. 

Adding Info
Panels to a

Layout

Info panels that are added from the toolbar to a layout appear initially with no data. Once 
you have added an info panel, you can define the specific data to be included.
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To add an info panel to a your layout:

1 Select Insert > Info Panel. 

If a PiP is selected, the info panel will appear attached to the PiP. If no PiP is selected, 
the panel will float free. if the info panel is an independent layout object (not attached 
to a PiP), you can drag it on top of a PiP. 

A Snap to PiP x message will appear if the info panel can be attached to the PiP. Each 
PiP can have one info panel. The Snap to PiP x message will not appear if a PiP already 
has an info panel attached to it. Nor will it appear if the info panel is not hovered over a 
PiP. 

You can also add an info panel by dragging and dropping from the Info Panels library, or 
by dragging and dropping a window or PiP that contains an info panel from the Windows 
or PiPs library. Info panels added to a layout in this way bring any configuration with them. 

Modifying
Info Panel
Properties

Each info panel has a set of individual properties that define its appearance and behavior, 
and which PiP it applies to in the layout. 

To view an info panel’s properties, select the info panel in the layout canvas, and then select 
the Info Panel tab of the Properties pane.

Figure 10-10  Info Panel Properties 

Naming the Info Panel 
Each info panel has a unique name that identifies it in the layout when it is associated with 
a PiP. 

To name an info panel:

1 Select an info panel indicator in the layout.

2 Select the Info Panel tab on the Properties pane.

3 In the Details area, type a name for the info panel in the Name field.

Resizing and Moving an Info Panel 
The Position & Size area of the Info Panel Properties is for information only. 

To modify info panel size and position: 

1 If the info panel is attached to a PiP or a window, right-click on the info panel and select 
Info Panel > Enable Resizing Info Panel. 
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If the info panel is not attached to a PiP or window, this step is neither available nor 
necessary. 

2 Select and drag the info panel, or a corner or side of the info panel. 

Info panels do not have to cover a portion of the PiP to maintain a relationship with the PiP. 

Note: You can also drag a window or PiP that an info panel is part of. The info panel will 
move with any object it is attached to. 

The Left Position value is the number of pixels from the left edge of the layout. The Top 
Position value is the number of pixels from the top edge of the layout.

If the info panel is free-floating (not connected to a PiP), as you drag it over a PiP a message 
Snap to PiP x will appear. 

Only one info panel can be attached to a PiP. If the PiP already has an info panel attached, 
the Snap to PiP x message will not appear. 

To move an info panel off a PiP:

1 Right-click the PiP that contains an info panel. 

2 Select Info Panel > Move Out. 

3 Click Ok. 

You can now drag the info panel away from the PiP and drop it on another PiP, or treat it as 
an independent layout object. 

To delete an info panel from a layout: 

 If the info panel is attached to a PiP, right-click the PiP and select Info panel > 
Remove. 

 If the info panel is part of a locked window, right click on the window and deselect 
Lock Window. Then right-click on the window again and select Info panel > 
Remove. Then right-click on the window again and select Lock parent window. 

 If the info panel is free-standing, select the info panel and then press the Delete key. 

Setting Info Panel States
You can assign different colors, behaviors, and alarm conditions to the indicators that are 
part of an info panel. The Presence info panel state determines the color of an indicator for 
CC, Teletext, and VChip rating. There are also three alarm states (Alarm Low, Alarm 
Medium, and Alarm High). You can create the following settings for each info panel state: 

To set info panel indicator states:

1 Select an info panel indicator in the layout.

2 Select the Info Panel tab on the Properties pane.

3 In the States area, click Edit Info Panel Colors. 

The Info Panel States dialog box appears.

Primary color The primary color represents the color of the indicator for the 
level of the alarm. 
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Figure 10-11  Info Panel States Dialog Box

4 To select the label text color, click the  icon to open the Select a Color dialog box. 

5 To select a color, do one of the following:

 Use the slider to select a color. 

 Enter the color values you want to use in one of the ScRGB, sRGB, or Hexadecimal 
Notation fields.

Your selected color is previewed below Selected Color. If required, use the Opacity slider 
to adjust the color’s opacity value. 

For more information on completing the Color Selector dialog box, see Setting Default 
Window Properties on page 55. 

6 Click OK.

Setting the Info Panel Source 
In the Info Panel Source area, there are two options: 

 Use Source Select this option if you want the info panel to always display the same 
source. 

 Track Source of PiP Select this option if the info panel is assigned to a PiP, and you 
want it to provide data for the info panel. 

By default, the PiP to which the info panel is snapped (if it is snapped to a PiP) will be 
the tracked source. To change the source PiP, enter a number in the field. 

Note: if you move out an info panel from a PiP and assign it to another PiP, the assigned 
source will automatically be the PiP the info panel is snapped to. 

Setting Info Panel Indicators
In order for an alarm to appear for a PiP state, you need to do two things: 

 Configure an alarm detector for that PiP in the PiP’s Alarms Property page

 Configure a “Set InfoPanel Alarm State” action for that alarm 
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The Info Panel Indicators area contains the following options. 

Table 10-7  Info Panel Indicators 

Indicator Type Description

Format Change Alarm (Not available for HView IP)

EDH Error Alarm (Not available for HView IP)

CRC Error Alarm (Not available for HView IP)

Video Lost Alarm Indicates that the multiviewer hardware can no longer detect a 
video signal from the video channel 

Video Freeze Alarm Indicates that the input video image is frozen (static) according 
to user-defined frozen picture delay (duration), percent of 
frozen video in the frame, and amount difference between 
pixels percent tolerance 

Video Black Alarm Indicates that the input video image is considered a black 
picture according to user-defined percentage non-black 
picture, delay (duration), and black level threshold values 

A. Ch Missing Alarm Indicates that the audio channel is not present in the signal 

A. Ch Peak Alarm Indicates that the input audio level of the audio channel is at or 
above the set upper threshold dB values for the user-defined 
period of time 

A. Ch Low Alarm Indicates that the input audio level of the audio channel is at or 
below the set lower threshold dB values for the user-defined 
period of time 

A. Ch Silence Alarm Indicates that the input audio level of the audio channel is at or 
below the set silence threshold dB value for the user-defined 
period of time 

A. Grp (1–4) Missing Alarm (Not available for HView IP)

Audio Format Alarm (Not available for HView IP)

Dolby E Program Alarm (Not available for HView IP)

CC Missing Alarm Indicates that closed captioning (can be HD or SD) is not 
present in the incoming video stream

CC Update Alarm Indicates that closed captioning is not updating correctly in the 
incoming video stream 

CC Invalid Alarm Indicates that the closed captioning data in the incoming video 
stream is not usable

VChip Missing Alarm Indicates that there is no V-chip data in the incoming video 
stream

VChip Mismatch Alarm Indicates that the V-chip data in the incoming video stream 
does not match the expected rating 

Teletext Missing Alarm Indicates that there is no teletext in the incoming video stream

Teletext Update Alarm Indicates that the teletext data in the incoming video stream is 
frozen

Teletext Invalid Alarm Indicates that the teletext data in the incoming video stream is 
not usable

VITC Missing Alarm Indicates that there is no VITC in the incoming video stream 
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When you add indicators one at a time, they are added in the order you click them, from 
the top left corner on down, first filling the left side of the panel, and then starting again at 
the top right corner. 

If the info panel is attached to a PiP when you add indicators, the indicators will always size 
themselves so that all indicators will fit within the boundaries of the PiP. 

WSS Missing Alarm Indicates that WSS is not present in the incoming video (should 
be present in SD625 only) 

WSS Format Alarm Indicates that the WSS information has changed from the 
selected format 

AFD Missing Alarm Indicates that AFD data is not present in the incoming video

AFD Format Alarm Indicates that the AFD information has changed from the 
selected format 

GPI Alarm Indicates that a GPI input has been triggered

SNMP VGPI Alarm Indicates that a GPI trigger has been received through SNMP 

Any Alarm Alarm Indicates that any tally connected to any other alarm has been 
triggered

Any Video Alarm Indicates that any of the alarms in the Video section of the list 
(above) have been triggered 

Any Audio Alarm Indicates that any of the alarms in the Audio section of the list 
(above) have been triggered 

CC Indicator Indicates that closed captioning is present, indicates whether it 
is 608 or 708 captioning, and indicates, in the case of 708 
closed captioning, the service the closed captioning comes 
from (service 1–7) 

VChip Indicator Indicates the V Chip rating

Teletext Indicator Indicates that Teletext data is present 

Audio Mon Indicator Indicates which audio pair is being monitored. (Needs to be 
enabled in the info panel in order for it to be displayed when 
the audio monitor is enabled.)

Video Format Indicator Indicates the video format currently being input to the PiP. 

Audio Type (not available for 
HView IP) 

Indicator Shows the type of audio. Options include: 

 PCM 

 Dolby D

 Dolby E 

 No audio 

Last Alarm Indicator Shows the name of the last alarm that was triggered. 

Alarm Time Indicator Shows the date (month/day) and time when the last alarm was 
triggered. It updates to show a different alarm if a different 
alarm is triggered, but if the same alarm is triggered more than 
once in sequence, then it shows the first time that alarm was 
triggered. 

Table 10-7  Info Panel Indicators (Continued)

Indicator Type Description
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If the info panel is free-standing, the indicators will appear at the default size, and will fill 
first the left side of the info panel, then the right side. If the info panel is too small to fit all 
the indicators, the extras for which there is no space will pile on top of one another in the 
middle. 

Figure 10-12  Info Panel Attached to a PiP in a Layout

If the info panel is free-standing, you can move indicators around by clicking on them and 
dragging within the borders of the info panel. If the info panel is connected to a PiP, right 
click on the PiP and choose Info Panel > Unlock Info Panel Items. You can now drag 
indicators within the boundaries of the info panel. Clicking outside the boundaries of the 
info panel locks the indicators in their new positions. When an info panel is unlocked, each 
info panel indicator can be resized individually. 

When the layout is published to the multiviewer and an indicator is triggered, that indicator 
will appear on the layout. When no indicator is triggered, no indicators appear on the 
layout. 

Using the
Scoreboard

Option

HView IP  Multiviewers can accept one Daktronics RTD input. 

Before you can use the scoreboard option, you need to configure the multiviewer to receive 
the data. See Setting Up External Devices on page 67. 

To add a scoreboard to your info panel, first choose an option from the drop-down menu at 
the top of the InfoPanel Indicators list. Options include: 

 No Scoreboard—The Indicators list shows no scoreboard options.

 Football—The Indicators list displays all normal options, plus the football scoreboard 
options as described in Table 10-8. 

 Basketball—The Indicators list displays all normal options, plus the basketball 
scoreboard options as described in Table 10-9.

You can only display one type of scoreboard data per info panel.  

Table 10-8  Scoreboard Info Panel Options (Football) 

Scoreboard Data

Game Clock Time Down

Home Team Name To Go

Guest Team Name Home Possession Indicator

Home Team Score Guest Possession Indicator
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Setting Metadata Display Options
To adjust the options of a metadata element, click on that element in the Info Panel 
Metadata area of the Info Panel Properties pane. 

Figure 10-13  Info Panel Metadata Display Options 

You can make the following metadata configurations for each Info Panel.

Guest Team Score Play Clock Time

Quarter Home Time Outs Left

Ball On Guest Time Outs Left 

Table 10-9  Scoreboard Info Panel Options (Basketball) 

Scoreboard Data

Game Clock Time Home Time Outs Left — Full

Game Clock Status Home Time Outs Left — Partial 

Shot Clock Time Home Time Outs Left — Total 

Home Team Score Guest Time Outs Left — Full

Guest Team Score Guest Time Outs Left — Partial 

Home Team Fouls Guest Time Outs Left — Total 

Guest Team Fouls Period 

Table 10-8  Scoreboard Info Panel Options (Football) (Continued)

Scoreboard Data

When the CC row 
is highlit in blue, 

you can edit the 
CC appearance 

Table 10-10  Metadata Appearance Options 

Control Function

Background Color The background color for the selected metadata element 

Text Size  Small

 Medium 

 Large
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Setting Info Panel Metadata Options
In the Info Panel Metadata area, there are several options, as described in Table 10-11. To 
choose an option, click its check box. To configure the metadata information, click the 
option’s text. Options appear below the Info Panel Metadata.

Check Enable Metadata Indicators when you need to adjust the position of metadata 
from its default location on the info panel. If the indicator is unchecked, the location of the 
repositioned indicator is lost since it is removed from the object. When checked, the 
multiviewer shows the indicators without losing the position of the indicators when they 
are enabled again. 

Text Position  Top - Places the metadata at the top of the screen, regardless of 
where it will actually appear when broadcast

 Normal - (CC and Teletext only) Places the metadata as defined 
in the metadata to display it as it appears when broadcast

 Middle - (VITC, DolbyE, WSS, and AFD only) Places the metadata 
in the middle of the screen, regardless of where it will actually 
appear when broadcast

 Bottom - Places the metadata at the bottom of the screen, 
regardless of where it will actually appear when broadcast

Enable Metadata 
Display

When enabled, shows the actual metadata on the info panel 
display

Table 10-10  Metadata Appearance Options (Continued)

Control Function

Table 10-11  Info Panel Metadata Options 

Metadata Option Function Options

CC Displays EIA608 and/or EIA708 
closed captioning

HD Source: Service 1–7, CC 1–4, T 1–4 
SD Level: CC 1–4, T 1–4
SD Service Option: Line 12, 21–22 

Teletext Displays WST or OP 47 teletext Page: 000–999
Service Option: Line 6–22 

VITC Displays vertical interval timecode 
from SD sources and DVITC when 
embedded in the HD source

Type: LTC, VITC 1, VITC 2
Service Option: Line 6–22 

Dolby E (Not available for HView IP)

WSS Displays the embedded WSS 
(Widescreen Signalling) format

Service Option: The line (ranges from 6-23) 
where WSS data should appear on your incoming 
video 

AFD Displays the embedded AFD (active 
format description) format

None 

IP Stream Info Displays the following information: 

 Program number

 Audio service

 Video codec

 Video Format

 Audio codec and PID number

None
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Configuring
AFD and WSS

Monitoring

The following figure explains how HView IP  multiviewers display the various AFD and WSS 
options. WSS is relevant for SD625 only. 

Figure 10-14  AFD and WSS Display Options for 16:9 and 4:3 
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16:9 Protected 
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4:3 Alt 14:9
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>16:9
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16:9 Alt 14:9 
None

None
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Configuring Audio Monitoring

The audio monitor needs to be enabled in the info panel in order for it to be displayed 
when the audio monitor is in use.

Figure 10-15  Audio Monitoring on Info Panel

AUD monitor A1 is monitoring 
audio inputs 1&2. 
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11 On-Screen Controls

On-Screen 
Menus

Once you have published your layouts to the multiviewer, each multiviewer provides you 
with the ability to access on-screen menus.

You can use a mouse connected to your multiviewer to access certain features using control 
menus. For example, you can make a PiP go full screen, clear an alarm condition, or view PiP 
information. Alternatively, you can access the same control menus remotely from a 
computer that is running Layout Designer.

You must have a mouse connected to your multiviewer to be able to use the on-screen 
menus. Alternatively, you can activate the remote mouse control from Layout Designer (for 
more information see Remote Mouse Control on page 192).

Use your mouse to right-click on an object or the background in the layout. A menu appears 
with different items, depending on where you have clicked. Table 11-1 lists the various 
options that might appear.

When you reach the end of a menu, it will restart again at the beginning. 
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Table 11-1  On-Screen Menu 

Item
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Description

Select Video Source X Lists of all the possible PiP sources. This allows you to assign a 
different source to the selected PiP. 

Full Screen X Causes the PiP to expand to the size of the screen. To turn off 
the full screen view, right-click the PiP, and then choose 
Revert to Layout.

PiP Information X Lists attributes for the selected PiP, including

 Source 

 URL

 Stream width (pixels)

 Stream height (pixels) 

 Stream aspect ratio 

 Video Format 

 On-screen width (pixels) 

 On-screen height (pixels) 

This information can be useful for troubleshooting purposes.

Monitor Audio X Choose an audio service associated with the IP source to 
monitor. 

Disconnect VNC X PiP image reverts to a “no signal” picture (VNC PiPs only)

Connect VNC X Attempts to reconnect a PiP to a VNC server (VNC PiPs only)

Send CTRL+ALT+DEL X Opens the Windows Security dialog box on the VNC server, 
so you can lock the computer, restart, etc. (VNC PiPs only)

Display Scope X When Test and Measurement is available, this item displays a 
sub-menu that lists all the different modes that available for 
Test and Measurement. When you choose one, the PiP 
changes to display that option. If another PiP is currently 
displaying a scope, that PiP will revert to its previous mode. 
For more information, see Test and Measurement on 
page 129.

Color Source X This item is appears on the on-screen display menu when 
Test and Measurement has been activated. Choose 
Monochrome to display the results in black and white, or 
From Video to display the results in the actual colors from 
the video.

Select Audio Source X Scroll and select from list of available audio sources

Audio Information X Displays source number and name, audio format type, and 
the audio channel that is being mapped to the audio meter
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Reset Alarms X X Clear an alarm state. (You can also clear alarms on the Layout 
property pane in Layout Designer. See Making 
Layout-Specific Settings on page 97.) 

Enable Detectors X X When you choose this item, all of the alarm conditions that 
you defined for that PiP appear. You can select or clear 
(deselect) any conditions that appear in the list. If you did not 
define any alarm conditions for the selected PiP, none is 
listed.
For more information about alarm conditions, see Defining 
Alarms for a Layout Object on page 161.

Enable Alarms X X When you choose this item, all of the alarm detectors that 
you defined for that PiP appear. You can select or clear 
(deselect) any detectors that appear in the list. If you did not 
define any alarm detectors for the selected PiP, none is listed.
For more information about alarm detectors, see About 
Monitoring Tools on page 157.

Recall Layout X X X X Lists any layout that was published previously and allows you 
to select one to display.

A
d

v
a

n
ce

d

Lock Display X Disables the display from accidental change of the layout. 
Recall Layout is not available when the display is locked. 

Clear Messages X X X Acknowledges messages displayed by alarm rule message 
box. (You can also clear messages on the Layout property 
pane in Layout Designer. See Making Layout-Specific 
Settings on page 97.) 

Reset layout X X X X Disconnects all PiP sources for all displays and requires the 
user to recall all layouts

Reset and Recall 
Layouts

X X X Disconnects all PiP sources for all displays and recalls all 
layouts automatically 

Run Performance 
Tests

Diagnostic tool to run a performance test for debugging 
purposes. The results of the test are saved to a file named 
PerformanceLog.txt in the folder c:\Program Files\Harris\Harris 
Multiviewer. 

Send Serial Break Diagnostic tool to send a break command when using Sony 
Tally protocol. 

Enable Metadata 
Debug

Diagnostic tool to capture metadata for debugging purposes. 

Exit Multiviewer X X X X Exits to the Multiviewer Control Panel.

Table 11-1  On-Screen Menu (Continued)

Item
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Remote
Mouse

Control

If you do not have a mouse connected do your multiviewer, but you want to access the 
on-screen menus, you can activate remote mouse control from the computer that is 
running Layout Designer. (For more information about on-screen menus, see On-Screen 
Menus on page 189.)

When this feature is activated, the mouse appears on the output display currently selected 
in Layout Designer. You cannot use the other features of Layout Designer until you 
deactivate the remote mouse control. 

To activate remote mouse control:

1 In Layout Designer, click Enable Control.

Figure 11-1  Location of the Enable Control Button

The mouse appears on the corresponding multiviewer. The other features of Layout 
Designer are unavailable.

To deactivate remote mouse control:

1 On the keyboard, press ALT + F7.

Controlling a
VNC PiP

For information on creating VNC PiPs, see Selecting a PiP’s Input Source on page 128.

To take control of a VNC PiP: 

1 Left-click inside the PiP. 

To control a VNC clip from the multiviewer, your keyboard must be US English 101 key. 
Some special key sequences may not work. 

To release control of a VNC PiP: 

1 Do one of the following: 

 Hold down the left mouse button and then double-click the right mouse button. 

 On the keyboard, Press ALT+F7. 

Controlling a
Counter

To control a counter using on-screen controls on the HView IP multiviewer, follow these 
steps: 

1 Right-click on a counter. 

2 Use the following controls: 

Start - updates the counter to proceed with the linear countdown 

Stop - stops and reports the current countdown time until further notice 
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Reset - re-initializes the counter using the original start, stop, blink, and alert times. Any 
rules that were active in the layout will still trigger the counter the same way as before. 

To control the counter from Layout Designer, see Manually Controlling a Counter on 
page 154.

Using the Multiviewer Control Panel
Administrator users of the multiviewer may need to use the Multiviewer Control Panel to 
perform maintenance operations. To access the Multiviewer Control Panel, you must exit 
the multiviewer from the On-Screen menu.

Accessing the Multiviewer Control Panel
1 Select Exit Multiviewer from the On-Screen menu, and then click Yes to confirm.

A dialog box similar to the following appears. 

Figure 11-2  Multiviewer Control Panel 

2 Click Enable to enter Maintenance mode. 

The Disable becomes Enable, and all the buttons in the Actions section of the screen will 
be unavailable. 
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With Maintenance mode enabled, the following actions will be available: 

Configuring Start/Stop Options 
Once you have the Multiviewer application open, you can control options for the 
Multiviewer OnScreen Application. The same dialog box has a button to restart the 
onscreen application, as well. 

1 On the Multiviewer Control Panel, click Enable. 

2 Click Start Multiviewer.

The Configuration dialog box appears.

Table 11-2. Multiviewer Control Panel Options 

Button Function

Maintenance Mode  Enable—Sets the Control Panel to maintenance mode

 Disable—Sets the Control Panel to normal operation mode 
(from maintenance mode)

Status Indicate green when Multiviewer Monitor and Multiviewer 
are functioning, red when they are not. 

Stop/Start Multiviewer Opens a dialog box that contains startup options, and also 
contains buttons to relaunch the Multiviewer On-Screen 
Application; see Configuring Start/Stop Options on 
page 194

Device Manager Loads the Windows Device Manager application (this is the 
same device manager that you could launch by selecting Start > 
Control Panel > System > Hardware > Device manager). 
Administrators might use this screen to manually configure 
devices. 

Explorer Starts the standard Windows file system explorer application, 
opened to the Harris Multiviewer folder where HView IP stores 
layouts, etc. 

NVIDIA Control Panel Starts the NVIDIA application to configure the NVIDIA graphics 
drivers settings, including color temperature, screen alignment, 
etc. See your NVIDIA documentation for information on the 
various panels and wizards involved in this tool. 

Command Prompt Starts the command prompt application, from which you can 
ping other devices on the network to troubleshoot 
communications issues, etc. 

Set Time/Date Opens a standard Windows Date and Time Properties dialog 
box (also accessible by right-clicking on the time and date that 
are normally present in the bottom right corner of a PC). 

Acquire New Display (Not applicable to HView IP) 

Logs Opens Internet Explorer and displays the Harris Logging Server; 
see Using Multiviewer Logs on page 196

Shutdown System Shuts down the PC and does not restart 

Restart System Shuts down and restarts the PC 
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Figure 11-3  Configuration Dialog Box

3 Click Launch Multiviewer to start the Multiviewer application and its On-Screen menu. 

Click Apply to save your System Startup settings, Revert to reset the content of the 
Configuration dialog box, or Cancel to cancel launching the Multiviewer application.

Table 11-3  Configuration Dialog Box Options 

Option Function

Load last layout on 
startup

When this is checked and the multiviewer starts up, it will reload 
the layout that was displayed when you last exited

Save source 
changes to layout

When this is checked, after you change inputs to the PiPs (for 
example using CCS controls or NUCLEUS), these changes are saved 
to the layout, and are reloaded if the layout is loaded again. 
When this is not checked and you make changes to the layout, 
when the layout is reloaded, it will revert to its original inputs. 

Force Display 
Adapter Settings 

This option should always be checked during normal operation. 
When it is not checked, the display settings may not be respected 
by the display device. 

Show Advanced PiP 
Information

(Not applicable to HView IP)

Show CPU Meter Shows the percentage of the CPU power that is currently in use; 
this option is normally not checked

Output to Window Outputs the layout configuration to a window (as defined by the 
Height and Width fields) on your screen; this option is normally not 
checked 

LTC Input Format (Not applicable to HView IP)
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Restarting the Multiviewer Control Panel
If you accidentally closed the Multiviewer Control Panel, you can reopen it. 

1 Simultaneously press the CTRL, ALT, and DEL keys on your keyboard. 

The Windows Security dialog box opens. 

2 Select Task Manager.

3 The Windows Task Manager dialog box opens. 

4 From the application menu, select File > New Task (Run)…

A Create New Task dialog box opens. 

5 Click Browse, and navigate to C: > Program Files > Harris > Harris Multiviewer. 

6 Double-click on XenaShell.exe, and then click OK.

The Multiviewer Control Panel appears. 

Unlocking the Multiviewer Display
If you accidentally locked the Multiviewer display, you can unlock it.

1 In the Unlock Computer dialog box, enter the following settings:

 User Name: Administrator 

 Password: (your Multiviewer Administrator user password) 

By default, this password is set to Centrio. Note that these fields are case sensitive. 

2 Click OK. 

Changing the password is not recommended. If you change the password, you will be 
prompted to enter it every time the multiviewer is restarted. 

Using
Multiviewer

Logs

When you click the Logs button on the Multiviewer Control app, Internet Explorer opens 
and displays a screen similar to the following: 
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Figure 11-4  Logging Server (as Viewed in Internet Explorer 8) 

Separate logs are created for the following items: 

 Multiviewer—Logs hardware faults. 

 Multiviewer Monitor—Logs display and software faults. 

 ccspinterface.ccssnmp—Logs alarms and traps sent to CCS and SNMP devices. 

Table 11-4  Logging Server Options 

Option Function

S
e

tt
in

g
s Quota Management This screen indicates the current and maximum size of 

the log file, and offers the opportunity to change the 
maximum size. When a log reaches its maximum size, a 
new log file is created on the server. 

To
o

ls
 

Save Logs Place a check beside each log type you want to save, 
enter a location to save the logs to, and then click Save 
Logs. By default, logs are saved locally to c:\LogFiles on 
the multiviewer. THe log file name is Logs.harrislog. A 
Harris Log explorer software is used to view these logs.

Export Logs to Text Place a check beside each log type you want to export, 
enter a location to save the logs to, and then click 
Export Logs. Logs are exported as TXT files for 
debugging purposes. 

Download all Logs Downloads all the logs from all application profiles. 

Delete Logs Place a check beside each log type you want to delete, 
and then click delete Logs. 
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Multiviewer Each of these three screens offers a list of log files saved 
for that item. 
The Assert Verbosity menu contains several levels:

 Assert

 Fatal

 Critical

 Error

 Performance

 Warning (default) 

 Info 

 Debug 

The verbosity setting determines the number of alarms 
you will receive and therefore the size of the log file. 
You can also filter on these options within the Log file 
viewer. 

Multiviewer Monitor 

ccspinterface.ccssnmp

Processes 

Table 11-4  Logging Server Options 

Option Function
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A Frequently Asked Questions

How Do I Access the Components Within my PiP?
If you cannot edit or alter the components within a PiP, this is usually because the 
components are locked. 

To unlock the window, do one of the following: 

 Right-click on the window and clear Lock Window.

 In the Windows tab of the Properties pane, clear Lock Objects in Window.

Can I Store and Recall PiP Properties? 
If you spend a lot of time creating a PiP, you can use it for other PiP windows.

1 After you have created a window, right-click on the window, and then select Add Window 
to Library. 

It will appear at the bottom of the Library panel under the Windows section. 

2 Rename a window in the Library by double-clicking on the label under its preview image. 

3 To populate more of these windows onto your layout, simply drag and drop them onto the 
layout page. 

4 Set the input source by clicking on the “I” icon in the middle of the window.

Why Can’t I Close All the Layouts?
You cannot close the first layout that opens when Layout Designer starts; it always stays 
open in Layout Designer. 

What is the Behavior of the Undo Feature?
You cannot undo the following functions: 

 Saving a layout
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 Publishing a layout

 Downloading a layout

 Closing a layout

 Deleting a layout

 Unlocking a window

 Locking and restoring factory default for PiPs, windows, borders, and border styles

All other functions can be undone. 
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B Specifications

Specifications and designs are subject to change without notice

Inputs

DVI Output
Resolutions

Table B-1 lists the output display resolutions supported by the HView IP’s DVI outputs.

1For these resolutions, the multiviewer hardware supports both 50 Hz and 60 Hz output.

Item Specification

Input  Stream inputs via Gigabit Ethernet 

 Control inputs via Ethernet 

Video Compression Formats  MPEG-2/H.262

 MPEG-4/H.264 AVC

Item Specification

Output 2 digital displays (DVI or display port) 

Table B-1  Supported Output Resolutions 

DVI Output Resolution

When Redundant DVI, spanned DVI, Dual DVI, or Spanned Vertical 
DVI is chosen

 1024 × 768 

 1024 × 800

 1152 × 864

 1280 × 720

 1280 × 768 

 1280 × 800

 1280 × 960

 1280 ×1024 

 1344 × 840

 1440 × 1050

 1440 × 900

 1440 × 1080

 1600 × 900

 1600 × 1024 

 1600 × 1200 

 1680 × 1050 

 1792 × 1344

 1856 × 1392

 1920 × 1080

 1920 × 1200 

 1400 × 1050
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Audio Compression Formats 
 MPEG-1 Layer 2 (Musicam) audio 

 Dolby AC-3 audio 

 AAC and HE-ACC audio 

Power Consumption
The power consumption of the HView IP is 400 W, maximum. 
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Index

A
Adding multiviewers in Layout Designer 63
Advanced Configuration 66–68

configuring output display devices 66
software upgrade 25
tally and UMD 67

AFD
alarm thresholds 164
display options 186
info panel indicators 182
marker on PiP 58, 127
metadata options 185
parameters 23

Alarms 18–24
creating templates 168
detector descriptions 159
editing templates 171
global 172–175
PiP 20
reset 191
states indicated on borders 121
summary 19
system 19
threshold values, description 164

Alarms, email notifications 52
Align options 34
Align tool 108
Aligning PiPs in a layout 107–109
Analog clock button 33, 38
Animated borders 121
Application menu 29, 30, 35
Application status bar 29, 30
Application toolbar 29, 30
Aspect ratio

default 57
marker on PiP 58, 126
PiP 126

Audio
on-screen information 190
source select 190

Audio alarm detectors 160
Audio meter button 33
Audio meters 38

adding to a layout 139
appearance properties 139
creating 138–141
elements in a window 109–113
left/right 140
mapping 139
number of channels 140
on-screen context menu options 190–191
position 141
scale 139
show scales 140
transition points 140

Audio phase 140
Auto hide 46
Auto lock window contents (default setting) 56
Autoconnect to multiviewer 48

B
Background, default 55, 57
Blank layout 89

adding objects 103
button 31, 36

Borders
colors, primary and secondary 121
default style settings 49
default width 55, 57, 59
effects configuration 119
elements in a window 109–113
properties 117–121
states, configuring 120

Break window tool 32, 44
Buttons

application toolbar 36–38
blank layout 31, 36
copy 31, 37
cut 32, 37
delete 31, 37
new layout 31
open 36
paste 37
publish 31
redo 31, 37
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undo 37
zoom 37

layout editing palette 38–39
5.1 audio meter 139
analog clock 148
audio meter 139
digital clock 148
insert audio meter 138
insert clock 148
insert info panel 177
insert label 144
insert PiP 125
insert tally 141
insert up/down counter 152
object select tool 105
pan 47

Multiviewer library 40–41
connect to device 41
delete device 41
disconnect device 41
edit device 41
lock/unlock 41
new 41
sort 41

C
Cable connections 10
CCS Navigator 17–24
Clocks 33

12-hour 150
24-hour 150
adding to layouts 148–151
analog motion 150
color 150
elements in a window 109–113
font 150
hybrid 150
inserting 38, 104
position 151
reference source 151
resizing 151
time zone 151

Clone object tool 37, 106
Closed captioning

alarm thresholds 164
info panel indicators 182
metadata options 185
parameters 22

Color border, PiP 118
Communication failures 19
Configuration 13–14
Configuration dialog box 36
Configuring multiviewers

Setup tab 63
Connect to device button 41
Connections

output display devices 10
testing 13

Context menus 30
canvas 43–45
controlling a counter 192
Multiviewers panel 41
on-screen controls 190–191

Control 17–196
Control panel, Multiviewer 193
Convert mode, AFD/WSS 58, 127
Copy button 31, 37
Copy properties 34, 105
Counters 152–155

elements in a window 109–113
insert counter button 34
on-screen controls 192

Create a Window context menu item 111
Creating

new layouts 83–90
new layouts using a blank layout 90
using Layout Creation Wizard 84–89

Cropping PiPs 127
Cropping, default settings for 57
Customizing

layouts 96–97
Cut button 32, 37

D
Defaults

IP source properties 52–54
Layout Designer settings 49
parameter settings 19
PiP properties 50–52
properties for windows 55
returning panels to 32

Delete button 31, 37
Delete device button 41
Description 1
Deselect option 32
Detectors. See Alarms.
Device Configuration dialog box 64
Device connection 63
Digital clock button 33, 38
Disconnect device button 41
Disconnected message 40
Discovery 64

in Layout Designer 65
Navigator 17

Display devices 64
connecting 10

Display mode 10, 63–78
AFD/WSS 58

Display mode, AFD/WSS 127
Display port, locations 8
Display resolutions 201
Displaying layouts 94–96
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Distribute objects tool 109
Distribute options in layout 35
Distributing PiPs in a layout 107–109
Dolby E

alarm thresholds 165
audio meters 139
metadata options 185
parameter 23

Down counter, configuring 154
Download IP source 76
Drag object 103
Dual display 66–68
DVI devices, connecting 10
DVI output

configuration 66–68
connecting display devices 10

E
eBox connections 10–12
Edit device button 41
Edit menu 31–32
email alarm notifications 52, 167
Ethernet connections 8
Events

global 175–177
layout 175–177

External device configuration 67
External LTC

clock reference 151
counter reference 153

F
Factory recall 49
File menu 31
Fit to screen 33, 49
Flashing border 121
Float Library and Properties panes 46
Float windows 46
Font, label 146
Format menu 34, 36
Frequently asked questions 199

G
General preferences, setting 48–49
Global alarm detectors 161
Global alarms 172–175
GPI

alarm detector 160
info panel indicator 182

H
Hardware

boot-up 12
connections 8
installation 5

optional 10
shut down 12

HD-SDI output display resolutions 201
Height, default (PiP) 57
Hide Library and Properties panes 46
Hide options 46

I
Independent mode 10
Info panels 82, 177–186

add to library 34, 42, 61
adding to layout 177
alarm actions 167
alarm target 161, 167
as part of a window 109
assigning states 179
audio monitoring 139
border styles 118
button in tool palette 39
context menu options 45
elements in a window 109–113
in layout 103
indicators 180–183
properties 107
tool icon 34

Input source
binding to UMD address 68
PiP 128

Insert menu 33
Insert object to layout 104
Insert objects toolbar 38
Installing Layout Designer 27, 27–28
Internal clock reference 151
IP address 64

configuration 67
IP configuration manager 70
IP source

adding 72
download 76
setting default properties 52–54
update 69
upload 75, 77

J
JLCooper eBOX configuration 67

K
Keyboard

connecting 8
using 192

L
Label Button 33
Labels
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elements in a window 109–113
font 146
inserting 38, 104
modifying properties 144
on-screen context menu options 190–191
position 147, 153
scrolling properties 148
scrolling speed 148
size 147, 153
text color 147, 180
track PiP source 146
UMD text 146

Launch multiviewer 195
Layout

canvas 29, 30, 39
close all 199
publish 36
recall 191

Layout Creation Wizard 84–89
opening 31, 36

Layout Designer 14–29
application menus 30
customizing workspace 45
installation 27
preferences 47
toolbars 36

Layout objects 82, 101–103
adding to a blank layout 103
defining order of 45
definition 101
properties 103

Layout properties 96–97
modifying 96
viewing 96

Layouts 96–97
adding object 101–104
creating new 83–90
creation work flows 83–90
displaying and publishing 94–96
properties 96–97
saving as layout files 91
specifying margins for printing 31
typical layout 82, 101–103

Libraries 29, 30, 60–61
adding new objects 61
adding objects from 103
adding objects to canvas from 104
default settings 49
library button 32
multiviewers 41
setting view options 46

Local Area Network configuration 13
Lock display 191
Lock objects in window 56
Log files 196

M
Margins, specifying for printing 31
Maximum number of inputs, default 57
Memory requirements 27
Menus 30–36

application 36
context 43–45
Edit 31–32
File 31
Format 34, 36
Insert 33
Multiviewers panel 40
View 32

Metadata
display options 184
enable indicators 185
info panel options 185

Microsoft .Net framework 27
Microsoft Windows Vista 27
Microsoft Windows XP 27
Minimum system requirements 27
Monitor audio, on-screen options 190
Monitor, SXGA 27
Monitoring and control software 17
Mouse

activating remote control 192
connecting 8
manipulation of objects 106

Moving light border 121
Multiple output monitors 10
Multiviewers

configuration dialog box 63
control panel 193–198
device connection 63
displaying and publishing layouts 94–96
launch configuration dialog 32, 41
library 41
panel 40–41
rebooting 41
restarting 41
shutting down 41
supported hardware 27

Multiviewers panel 29, 30, 40–42
toolbar 40

N
Navigator 17–24

controlling counters 154
publishing layouts 2

Network time protocol 68
Network Time Protocol (NTP) 68
NTP configuration 68
NUCLEUS 17, 17–24

publishing layouts 2
switching video sources 125



Copyright ©2011, Harris Corporation

HView IP
User Guide

207

O
Object properties 103

copying and pasting 44, 105
setting as a group 107

Objects
deselect 32
group properties 107
removing like objects from a group 107
select all 32

On-screen control 189–198
activating remote mouse control 192
on-screen menus 189

Opening a layout 31, 36
Operating system 27
Order context menu options 45
Output display

devices 66–68
modes 10
resolutions 201

default 57

P
Packing list 5
Pan button 38
Panels

Library 42
multiviewers 40–41
properties 42

Parameters 18–24
PiP control 20–22

Paste button 37
Paste properties 34, 105
Phase meters 140
PiPs

adding to library 45, 61
alarms 18, 20
aligning and distributing 107–109
aspect ratio 126
cropping 127
elements in a window 109–113
formatting in a layout 105–109
input source, selecting 128
insert PiP button 33
inserting 38, 104
IP source 129

adding 72
configuration 70, 77
default properties 52

library 42
modifying 125–129
on-screen context menu options 190–191
parameters 18, 20
positioning 129
properties 103–129

copying and pasting 105
default 57

modifying 125–129
setting default 50–52
storing and recalling 199

resizing and moving 129
size 126
source selection 128–129
unlocking 199
VNC source 128
VNC. See VNC PiPs.

Position, labels 147, 153
Positioning PiPs in canvas 129
Power supply, connecting 8
Preferences

factory recall 49
general 48–49
returning panes to defaults 32
software 47–60
window, opening 32

Print margins, specifying 31
Processor requirements 27
Product description 1
Properties 103

borders 117–121
default IP source 52–54
default PiP 50–52
info panels 178
layout 96–97
pane 42–43
paste 34
PiP 103–129
selected 34

Properties pane 29, 30, 42, 42–43
setting view options 46

Properties, copy 34
Publish button 31
Publishing layouts 94–96

from layout files 95
from multiviewer hardware 94

Q
Quad display 66–68

R
RAM requirements 27
Read-only parameters 19
Reboot multiviewer 41
Recall layout 191
Redo button 31, 37

setting levels 48
Redundant mode 10
Relaunch multiviewer 195
Remote mouse control 192
Resizing and moving PiPs 129
Resizing layout objects 106
Resolution, monitor 27
Restart multiviewer 41
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RSS feed 146

S
Safe area (marker on PiP) 58, 126
Saving 91

layouts as layout files 91
overwrite preferences 49, 50

Scopes
configuration 130–135
display 190

Scrolling properties on labels 148
SDI configuration 66–68
SDI output display resolutions 201
Select all option 32
Selected properties, paste 34
Selection tool 38
Setup tab 63
Shortcut keys 30
Show phase meter 140
Size, labels 147, 153
SNMP

control of counters 154
monitor and control 14–17
virtual GPI trigger 160

Software 27
installation 27–28
Layout Designer 14–29
Multiviewer control panel 193
Navigator 17
preferences 47–60

Spanning mode 10
Speakers, connecting 8
Spotlight effect 121
Supported hardware 27
Supported operating system 27
Synchronizing time 68
System alarms 19
System parameters and alarms 18, 19
System requirements 27

T
Tally indicators

assigning states 143
creating 141–144
elements in a window 109–113
insert button 33, 38
modifying 141, 178
moving 142
naming 142
on-screen context menu options 190–191
resizing 142
setting the source 120, 143, 180
shape 142

Teletext
alarm thresholds 164
info panel indicators 182

metadata options 185
parameters 22

Test and Measurement
color source select 190
configuring

global settings 134
individual PiPs 134

description 130–133
display mode options 134

Test multiviewer connection 64
Testing connections 13
Threshold values description 164
Time synchronization 68
Time zone 151
Tools palette 38, 149, 152

adding objects from 104
Tools pane 29, 30
Trademarks and copyrights ii
Transition border 121
Triggers

for counters 166
with counters 154

U
UMD address

binding to input source 68
labels 146

Undo button 31, 37
behavior 199

Undo levels, setting 48
Uninstalling Layout Designer 28
Up/down counters 152–155
Upload IP source 75
USB connectors 7, 8

V
V-chip

alarm thresholds 164
info panel indicators 182
parameters 23
rating indicator 166

Vectorscopes
configuration 130–135
display 190

Version information 68
Video alarm detectors 159
Video source

selecting 190
View menu 32
View options 46
Virtual GPI

alarm detector 160
info panel indicator 182

VITC
alarm thresholds 164
info panel indicators 182
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metadata options 185
VNC PiPs 57, 86

on-screen controls 192
selecting a source 128, 129

W
Warranty information ii
Waveforms

configuration 130–135
display 190

Width, default (PiP) 57
Window library 42
Windows 109–113

adding to library 45, 61, 111
background color/graphic 113, 116
break 110, 111
breaking 32
bring to front 32
create 32, 44, 110, 111
defaults 55
drag 110
lock 32, 44

lock objects 112
modifying properties 110, 112
naming 112
positioning 113
resizing 113
unlock objects 112

Windows Vista 27
Windows XP 27
Wizard, layout creation 31, 36, 83
Workspace 29–61

customizing 45–46
WSS

alarm thresholds 164
display options 186
info panel indicators 182
marker on PiP 58, 127
metadata options 185
parameters 22

Z
Zoom button 33, 37, 47
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